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PREFACE 
This document, together with the “Implementation of a Flood Early Warning System in Narok Town, Kenya”, 
are written as part of the course CEGM3000 Multidisciplinary Project in the MSc programmes Civil 
Engineering and Environmental Engineering of TU Delft. We want to express our gratitude to our 
supervisors Prof. Dr. Ir. Nick van de Giesen and Dr. Ir. Frank Annor.  

The main objective of this multi-disciplinary project is to "design a flood early warning system to reduce 
the impact and damage of flash floods in Narok town, Kenya”. The obtained methodology and findings are 
used to write a manual for the design and implementation of flood early warning systems in similar small 
urban areas in Africa. This manual aims to be easily readable and is written in a step-by-step manner. The 
target audience is anyone who is concerned about the impact of (flash) floods of rivers in small urban areas 
in Africa, for example municipalities, county governments, water authorities, or meteorological 
departments.  

The first step of the manual describes an elaborate study of the flooding problem, by taking multiple 
sources into account. In this step, the value of a Flood Early Warning System will be assessed. 
Subsequently, the boundaries of the model will be determined and a further spatial analysis will be done 
in step 2. Step 3 describes the field measurements that need to be done to gather the necessary data of 
the river reach that will be modelled. In step 4, this data is processed, by help of a python package which 
is attached to this document. Step 5 includes multiple possible modelling methods to process the data 
further and conclude on a critical discharge that is reached upstream in case of a flood, as well as the time 
this water will take to flow down. In step 6, all aspects of the implementation and function of the Flood 
Early Warning System are discussed. In order to keep the manual concise and readable, some steps are 
accompanied by various appendices for further elaboration.  

This project was carried out in collaboration with TEMBO, an organization focused on closing the 
environmental data gap in Africa. TEMBO aims to do this by creating affordable sensor networks that are 
supported by climate services built around them. Currently, their services include Flood Early Warning 
Systems, Water Reservoir Management, and Agricultural Information. TEMBO works closely with TAHMO 
and TU Delft. (TEMBO, 2024) 

We had the pleasure of working with the Kenyan Meteorological Department (KMD), particularly Josiah 
Kahuthu; the Water Resources Authority of Kenya, with special thanks to Anne Wamuyu; and Maasai Mara 
University in Narok, Kenya, with appreciation to Dr. Samson Mabwoga and Simon Raphael. We’re very 
grateful to these individuals and organizations for their valuable contributions. 

 

 

TIM VAN BINSBERGEN, EVIRA EMAN, LARS HEIJBOER 

EMMANUEL WEIZENBACH & LISETTE DE VALK 

OCTOBER 2024, NAROK TOWN, KENYA 
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KEY INSIGHTS 
Recurring flood events, coupled with uncertain impact and inconsistent disaster response, negatively 
affect social stability and economic growth in the region (United Nations Office for Disaster Risk 
Reduction, 2024). Flood Early Warning Systems (FEWS) are seen as a way to improve this situation. This 
document describes a method to design and implement Flood Early Warning Systems (FEWS) for rivers in 
small urban towns in Africa. It is drafted as a manual to install a river gauge based system, which provides 
a relatively short lead warning time of about one to two hours with an accurate warning prediction. Narok 
Town is used as a case study. Here it was found that such a system would limit extensive damage-reducing 
actions, but does allow affected individuals to take timely steps to ensure their safety. 

In literature most of the emphasis is put on the actual communication of the warning from the sensor to 
the responsible party and from this responsible party to the people. This might imply that finding an exact 
threshold value is deemed to be less important than the actual transmission of the warning. However, this 
method heavily focusses on finding an exact warning time and an accurate threshold value for a gauge 
based FEWS. Other options for FEWS mentioned in literature use weather data to predict floods. This is 
also a tool in the FEWS toolkit of TEMBO (TEMBO Africa, 2024). We decided to not focus on this for this 
design method, but it could be a promising option.  

The manual follows and describes the step by step approach executed in designing a gauge based FEWS 
for Narok Town. It indicates the time required to reproduce each step. Starting with the initial problem 
investigation and the analysis of the river system, which is expected to take 1-2 weeks. The following step 
was mapping the river. Depending on the reach, this again takes 1-2 weeks. After processing the obtained 
data (1 week), a HEC-RAS model is to be build to investigate possible behaviour of a flash flood. This takes 
approximately 2 weeks. Following from the expected behaviour, the placement of a gauge can be 
determined. As this was out of scope for the manual, no timeframe for this step can be given. However, the 
total timeframe already adds up to 4 to 6 weeks. 

 

PROBLEMS FACED 

In designing and building the manual major challenges were faced. Mainly in the execution of field 
measurements and in the modelling of the river and its response. 

The challenges faced during the field measurements had firstly to do with the GPS system. The used 
method was PPK measurements, which lead to inconsistent elevation values. As a result of this, individual 
measurements could not be related to each other. The other difficulty was the inability to measure the 
boundary conditions for the  HEC-RAS model, which are a crucial element in the modelling process.  

The challenges faced during modelling arose from the unavailability and unobtainability of required data. 
Among other things, the Manning roughness coefficient was determined by means of calibration of the 
model, but resulted in an unrealistic value. Subsequently, data on the boundary conditions and proper 
validation appeared to be hard to obtain or estimate. This lead to results that could not be properly 
validated and therefore were hard to interpret. There is also no profound understanding of how many cross 
sectional measurements are actually required as input for the model. To our understanding, not a lot are 
required. All considered, it cannot be determined if the model produces trustworthy values.  
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RECOMMENDATION 

Following from the required investments in time & effort, which result in the currently faced restrictions 
and uncertainties, the question arises whether the proposed method is suitable for designing FEWS for 
smaller urban areas in Africa, like Narok Town. It is thought that a simpler approach can achieve similar 
results. Therefore, a dismantled approach is recommended which leaves out some time-consuming steps 
and is expected to result in result in results that are better interpretable.  

In this dismantled version, one should start with the problem investigation and the analysis of the river 
reach and its boundaries. The mapping of the river can be reduced to two cross sections: at the place of 
the sensor and at the bottleneck. The model is also deemed to be unnecessary and could be substituted 
by applying mass conservation, and the behaviour of flash floods from literature. The Manning and Leopold 
& Maddock method form an alternative for this. With this, an estimate for a threshold value and warning 
time can be obtained, for which we expect the outcome to have a similar or better accuracy than the results 
obtained using HEC-RAS modelling.  In this dismantled version, one would attach less value to knowing 
the exact warning time but takes a conservative value for this. Our shared opinion is that this dismantled 
version could be a valuable and efficient addition to the FEWS design toolkit of, for example, TEMBO. 

CONCLUSION 

In conclusion, this manual delivers a method that guides as a good step-up for the actual implementation 
of a FEWS. Although it is not perfect, it can be used as a starting point for a user to build further upon. We 
would like to see this as a living document that can be appended by future users. Additionally, the 
appendices give clear instructions on how to install and use certain components of this method, namely 
the installation and use of the PPK GPS system, the processing of this data and the installation and use of 
HEC-RAS. These can potentially be used in other applications where these components are utilised. 
However, this method requires quite redundant work, in the form of fieldwork and modelling effort, which 
is, in our opinion, not worth the output. We therefore advise to use a dismantled version of the method 
proposed in this manual.  
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INTRODUCTION 
This document entails a manual for the implementation of a Flood Early Warning System (FEWS) for riverine 
floods. This manual is targeted at small towns in Africa, with populations of fewer than 700.000 
inhabitants, that experience riverine floods in town. Specifically, the case of flash floods is considered. A 
flash flood is a sudden local flood, typically due to heavy rain, which begins within 3 to 6 hours, after the 
rain event. This restriction in time, gives little time for warning. Additionally, flash floods can have a really 
high wave celerity, and therefore can surprise flood prone areas. Flash floods are restricted to basins of a 
few hundred square kilometres or less. Steep terrain and high runoff coefficients of the land use are often 
contributing to the existence of flash floods. A flash flood can also be caused by dam or levee failure, or a 
sudden release of water in a previously stopped passage (i.e. by debris or ice). (United Nations Office for 
Disaster Risk Reduction, 2024) 

Occurrence of floods have large impact on society. Reducing exposure to flash flood is considered to be 
key to any mitigation measure. Approximately 85% of all flooding cases worldwide are accounted for by 
flash floods, which also have the highest mortality rate among different classes of flooding. Yearly, on 
average more than 5000 lives are lost to flash flooding, which even ranks them among the world’s deadliest 
natural hazards. Besides the risk of lost life, floods also have significant social, environmental and 
economic impacts. (United Nations Office for Disaster Risk Reduction, 2024) These impacts can setback 
progression and development of the area significantly, e.g. economic growth, infrastructure, social 
stability. Besides reducing the risk of floods, flood early warning systems are considered crucial for the 
reduction of impact.  A reliable warning system will make an area more resilient and will give a population 
the chance to reduce damage and save lives.  

As described in the preface, this manual is written for TEMBO. TEMBO develops different Flood Early 
Warning Systems, for different areas in Africa. The method of the system depends on the need for a warning 
system, possible damage, available data, and financial limits. An overview of the possible components of 
a FEWS, as designed by TEMBO, is given in Figure 1. 

Figure 1: Proposed FEWS design by TEMBO (TEMBO Africa, 2024) 

The Flood Early Warning System (FEWS) described in this manual relies on a gauge placed in the river 
(‘Level Near’ in Figure 1), located a certain distance upstream from the town. The idea is that a flood can 
be predicted by monitoring rapid changes in the river’s discharge upstream, until a specific discharge 
threshold is reached. Once this threshold is crossed, a warning is triggered. This type of FEWS provides a 
warning, though with only a few hours' notice. 
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This manual includes an investigation of the area, flooding problem and water system, a methodology to 
design a FEWS, and recommendations on the implementation of a Flood Early Warning System. The 
document will guide the reader through the process in a step-by-step manner.  

The different steps are described in the flow diagram underneath in Figure 2, guiding the reader through 
the document. Per step, the main deliverables are included.  

 

Figure 2: Flow diagram outlining the steps of the manual 
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1. INVESTIGATE THE FLOODING 
PROBLEM 
A comprehensive and effective design needs an inclusive and elaborate problem study. This should 
include what the flood prone area actually is, what the local water system looks like, what the main 
bottleneck of the water system is, what stakeholders are involved, and what research has already been 
done.  

The initial study is divided into a couple of steps, that are described below. If a step entails an elaborate 
step-by-step instruction, this will be included as an appendix. For this chapter, the order is not important, 
the different studies can be done simultaneously, or in a different order. The chapter is concluded with a 
list of questions, that should be answered by the combination of all studies that are done.  

1.1 FIRST ENVIRONMENTAL ANALYSIS 

The study begins by outlining the reasons for the need for a Flood Early Warning System. To assess the 
necessity of precautionary measures, it's important to document past flooding events, along with the 
associated damage and casualties. You might already be familiar with this information, or it can be 
gathered from old (online) newspapers or by speaking with local residents. Additionally, it's crucial to 
identify the possible causes of the floods. Is the river running through the town the main source of the 
flooding? What is the approximate extent of the flooded area? And is there an obvious bottleneck that can 
already be identified? 

If you are not known in the area, it is strongly recommended to walk through town to get an idea on the 
order of size of the river, drainage channels in the streets, and the presence of structures in the water way 
such as bridges. The main water system can be further analysed by looking at Google Maps, Open Street 
Map, or other maps of the area.  

1.2 LOCAL AUTHORITIES  

Local authorities often have a lot of knowledge on past floods, and what precautional actions have already 
been undertaken. Local authorities can be municipalities, counties, police departments, meteorological 
departments, water authorities, disaster response authorities, or universities. Authorities could be in 
possession of reports on flood events, maps of the area, and information on (failed) measures already 
taken. However, take in mind the possibility of lacking documentation or a lack of willingness to share, so 
collect what is available. Connections with local authorities will be needed throughout the project, 
especially for the implementation of the system.  

1.3 LOCAL COMMUNITY 

Ask local residents about their experience with floodings. Often residents already have a way of predicting 
and handling the flood, as the population has probably been living with the floods for some time. In this 
process one of the key challenges in these kind of projects in data scarce areas will be touched: knowledge 
is widely present, but the vast majority of it is not documented. However, by asking around and conducting 
small interviews, a lot of essential information can be gathered. Possible questions include the dates of 
past flood events, the extent of damage, present warnings, and the bottlenecks that are considered.  
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1.4 LITERATURE STUDY 

In some areas, research on floods might have already been done, for example identifying causes of 
flooding (like deforestation or changing land use), identifying flood prone areas and bottlenecks of the 
water system, etcetera. Information can be written down in the form of research articles or theses. 
Literature can be found on the internet, and via local authorities and educational organisations, as 
identified in step 1.2.  

1.5 MEDIA SOURCES 

Search for news articles, videos and any other information you can find on the internet. This will give entail 
on the flood prone areas, the data of past floods, and an idea on the order of magnitude of the water flow.  

1.6 CONCLUSION 

After this step, you should have a concise overview of the problem. One should be able to answer at least 
the following questions: 

 Where do the floodings occur? 
 What is the impact of the floodings? 
 What is the frequency of the floodings? 
 What are the conditions in which floodings occur? (e.g. heavy rains?) 
 Are there any external factors that can influence the occurrence of floods, e.g. side channels or 

the presence of dams and levees? 
 What are the main stakeholders concerning water management and rainfall predictions? 
 Have any measures been taken to prevent the floods and what is their effectiveness? 
 Do local residents already have a sort of warning system in place (e.g. through WhatsApp) and how 

does this function? 

By answering these questions, the need for a new Flood Early Warning System based on a water level gauge 
in the river should be determined. Will it contribute to the reduction in flood damage? If so, proceed with 
the steps in this manual, which will guide you through a proposed methodology for the design and 
implementation.  
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2. BOUNDARIES OF THE RIVER REACH 
AND SPATIAL ANALYSIS 
The Flood Early Warning System will be designed based on a river reach, that is limited by the flood point 
in town at the downstream end, and the water level gauge at the upstream end. This river reach will be 
mapped and modelled, which is described in Chapters 3, 4, and 5. The boundaries are determined in this 
step.  

2.1 IDENTIFICATION OF THE FLOOD POINT 

In Chapter 1, the flood prone area in town is specified. The location and size of this area probably has to do 
with a low elevation and poor drainage systems. However, a riverine flood will have a certain flood point, 
where the water will overtop the river banks. The cause of the flood will probably lie at a point a bit 
downstream of the flood point, where the water flow gets limited and therefore accumulated or slowed 
down. This is considered to be the bottleneck of the system. This disruption of the water flow will cause a 
backwater curve resulting in an increase of water levels in the upstream direction, causing the flood point 
to overflow for high river discharges.  

The bottleneck is almost always a man-made structure in the river stream. A natural stream naturally has 
a consistent capacity over the length of the river and gets eroded by high discharge events. This gets 
interrupted by structures such as culverts or bridges. The capacity of these structures are the limitations 
of the drainage capacity of the river. The bottleneck needs to be identified to determine the lower boundary 
of the river reach.  

 Possibly, research has already been done determining the bottleneck and thus the main local 
cause of floods. This should have been found in step 1.4.  

 Local authorities might be aware of the bottleneck of the water system in town. This should have 
been found in step 1.2.  

 If the possibilities above did not work out, you need to identify the bottleneck yourself. As stated 
above, it can be assumed that the bottleneck will be a man-made structure in the river flow. In 
the flood prone area, look for such structures. If more possibilities occur, the capacities of the 
structures need to be measured. A simple approach is to measure the water flow area. The 
structure with the smallest water flow capacity can be assumed to be the bottleneck.  

When the bottleneck has been identified, the critical water flow at this point needs to be determined. This 
will be the critical boundary condition for the model to decide on the occurrence of flooding. This critical 
condition can be either a discharge level, or a water elevation level (for example the bottom of the bridge 
deck).  

2.2 IDENTIFICATION OF THE GAUGE PLACEMENT 

Secondly, the location of the water flow gauge needs to be determined, identifying the upper boundary of 
the river reach. This location will be determined based on the desired warning time. The warning time is a 
crucial element of the FEWS design, as this will greatly influence the extend of effectiveness of the warning 
system. 
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2.2.1 WARNING TIME 

The magnitude of the warning time is a trade-off between lead time and certainty. A longer warning time, 
gives the residents more time to prepare themselves for the flood. However, a longer lead time also comes 
with a lower certainty that the flood will actually occur, and lower certainty of the speed and size of the 
(flash) flood. This is a delicate balance that should be well considered.  

How to determine the warning time? This will depend on various factors, such as the land use, present 
facilities and (type of) residents. Based on the type of users and residents, a warning time should be 
determined. Your source of information for this would be the local people themselves. They know this the 
best. A suggested methodology in gathering reliable and valuable information is described below.  

1. Identify affected people and determine a set of stakeholder types. For example, residents, shop 
owners, farmers, visitors, etc.  

2. Approach the determined stakeholders and inquire their position towards required warning time. 
Example questions are:  

 What are the actions you would undertake if a flood warning is given?  
 If you would have 30 minutes before a flood comes, what would you do? And what actions 

would you undertake for 60 or 120 minutes? Or a day? 
 What would you consider the minimal warning time, that is still valuable?  

3. Combine the answers that are given. Decide on a minimal warning time that would suit most of 
the affected people.  

Additionally, time needed for processing of the warning should be considered. A source of information for 
these systems and regulations would be the local authorities. An estimate for this processing time is 
approximately 15 minutes. The actual implementation and processing method will be decided in step 6 of 
this manual.  

2.2.2 FLOW VELOCITY OF A (FLASH) FLOOD 

For a flash flood, the flow velocity can get quite high. In literature, multiple ranges for the wave celerity for 
a flash flood in a natural open channel can be found. According to Meyer et al. (2019), the wave celerity lies 
between 0.25 and 10 [m/s] for floods in river reaches all around the world. For East-Africa, this range is 
sharpened by Allen et al. (2018) to a range between 0.05 and 4 [m/s]. The higher end of this range can be 
used as a conservative assumption for a required distance for a specific warning time. For example, if one 
hour warning time is required as the minimal, and the water will flow with +/- 4 [m/s], the warning system 
needs to be installed at least 14.4 [km] upstream of the flood point.  

2.2.3 CONCLUSION 

The determined warning time, together with a conservative use of the flow velocity range given in Paragraph 
2.2.2, a distance can be calculated between the downstream end of the river reach and the proposed 
upstream end. Probably, a range will be suitable for this first estimation. Within this range, a suitable 
location needs to be chosen for the placement of a water level gauge. Account for the following criteria: 

 The location needs to be reachable. The location needs to be reached for measurement, for 
placement of the gauge, and for the functioning and maintenance of the system.  

 The gauge needs to be placed near the river. For the placement, existing infrastructure might be 
valuable. Especially structures crossing the water stream, like bridges or water pipes, could be 
good locations. The installation method will be further elaborated in Chapter 6.  

 The sensor might need cellular service to be able to communicate the measurements. When 
selecting a location, check the service availability. 
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Look for a location that is considered the most appropriate, considering the distance from the downstream 
boundary and the criteria mentioned above. Take this as the upstream boundary of the river reach. 

2.3 SPATIAL ANALYSIS OF THE RIVER REACH AND CORRESPONDING CATCHMENT 

The water system will be mapped using QGIS, a spatial information analysis and visualisation tool which 
is open source and widely used for similar purposes. The spatial analysis of the water system and 
catchment will be done based on elevation data. This data can for example be retrieved from the Shuttle 
Radar Topography Mission (SRTM) of NASA. (NASA's Earth Observing Centre, 2024)  

The goal of this step is to produce a digital elevation map and corresponding project file that will be used 
later on in the modelling phase (Chapter 5). The digital elevation map is also used to get a sense on the size 
of the watershed of the river. The size of the watershed gives information on the order of magnitude of 
discharge in the river and on contributing areas in terms of rainfall (measurements).  

The determined river reach might also include junctions with side streams that contribute to the river flow. 
These contributors need to be included in the calculations. They can be identified using maps, such as 
Google Maps or Open Street Map, or using the delineated streams in QGIS. Per contributing side stream 
the area of the sub catchment also needs to be determined, as will be described in Paragraph 3.1.1.  

To obtain these objectives, a step-by-step instruction is given in Appendix A. Additional to the instructions 
to reach the goals of this step, some information is given on the general use of QGIS, namely saving a 
project and creating print layouts. First conduct the instructions given in Appendix A, before going to 
Chapter 3.   
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3. MAP THE RIVER 
To start with step 3, the following information needs to be known:  

 The main river that causes flooding.  
 An optimal warning time, including following the protocols.  
 An estimation of the required location of the FEWS, measured in distance from the flood point.  

For the model that will be designed, the part of the river between the FEWS and the flood point needs to be 
mapped. This will be done via cross sections of the river bed, that need to be measured. The required 
information includes: GPS data of the cross-section (X-, Y- and Z-coordinates of the river bed), average 
velocity, the bank-full water level, and the slope. How to obtain this data is described in the following steps.   

3.1 EXPLORATION OF CROSS-SECTIONS 

The steps below explain how one should approach  the measuring of the cross-sections. 

1. Determine how far upstream you want to measure. This  can be done based on the wave celerity 
and the warning time as discussed in paragraph 2.2. 

2. The number of cross sections that one should measure strongly depends on the accessibility of 
the river. The chosen approach in this project was to check on Google Earth how much locations 
along the river seemed accessible. For example, this case study has 10 cross-sections for a 
distance of approximately 14 kilometres. The exact number of cross-sections needed will be 
decided with a sensitivity analysis of the model and or the Manning calculations. 

3. Keep in mind the needed measurements. The list below provides an overview of what should be 
measured and what it can be used for. 
 Cross-Section of bankfull state  
 Velocity Profile 
 Waterlevel 
 Slope 

4. Explore the river before going with all measurement equipment. Explore whether the cross-
sections determined in step 2 are actually accessible and whether it is to save to enter the river at 
that place. 

5. Make a planning based on the number of cross-sections and the measurements that need to be 
conducted. A cross-sectional measurement will take approximately 3 hours. Whereas the time 
needed for measuring  water levels can differ based on where the base is located. 

3.2 INCORPORATION OF JUNCTIONS  

In case there are side streams that flow into the river reach that is determined in step 2, a method needs 
to established how this extra water flow will be integrated. This will be done by determining a discharge 
ratio, that will be applied to the flash flood discharge at the top boundary of the river reach. The additional 
discharges, according to the ratio, can be added as additional water flow at the point of the junction in the 
river reach. Two different methods are described here. Both will lead to a discharge ratio, which can be 
compared to each other and an average can be taken. If for any reason, not both methods will be executed, 
one of the will suffice as well. 

 The discharge ratio between the main river and the connected side stream has to be determined 
before making the model. Two cross-sections need to be measured: one just upstream of the 
junction and the other immediately downstream. At both cross-sections, measurements of the 
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velocity profile and water level must be conducted. These measurements will allow for the 
calculation of the discharge both upstream and downstream of the junction using a 
straightforward formula: 𝑄𝑄 = 𝑣𝑣 ∗ 𝐴𝐴. By determining the proportion of the discharge in the main 
channel downstream of the junction that originates from the main channel upstream, the 
contribution from the tributary can be inferred automatically. This method assumes that the 
discharge ratio between the two streams is equal both for low and high discharges.  

 Another check for the discharge ratio between the main river and the connected side stream, is 
to look at the area of the watersheds. In Appendix A, Paragraph Delineate Streams and 
Catchments, the areas of different sub catchments are calculated. This is also described in 
Paragraph 2.3 of the main file. In QGIS you are able to define a sub catchment for any point. For 
this point, choose the junction that is in the river reach that you are looking at. By following the 
steps in Appendix A, you should calculate the area of the different sub catchments. By comparing 
the ratio of these areas, between the main catchment and the sub catchment of the side stream, 
an assumption can be made for the discharge ratio. Here, the main assumption is that rainfall will 
be equally distributed over the total area, and the runoff coefficient is also equal. However, for 
small catchments, these assumptions are rather probable. The discharge ratio that is determined 
can be applied in the model, in Chapter 5. 

3.3 GPS SYSTEM AND BACKGROUND 

In the world of surveying and mapping, GPS systems are found at the foundation. Within the Western world 
advanced systems are the norm, costing upwards to many thousands of euros. To keep the 
implementation of the Flood Early Warning system as cost effective as possible, cheaper alternatives had 
to be utilised. The systems of Ardusimple provided the perfect set-up for the intended use, as they are 
cheap, precise and rely on open source hard- and software. As some more advanced functionality was 
required, it was chosen to use the SimpleRTK2B Pro receiver. 

The system is based on a Base and Rover setup. The Base station is a fixed position receiving and recording 
positional information from the satellites. As the Base is positioned stable over a longer period of time, it 
is able to determine its position with centimetre level precision. The Rover is the device that is used to 
record the points of interest, and thus moves. Similar to the Base, the Rover also receives and records its 
positional data received by the satellites. It is important to always record a point of interest for an extended 
period of time, this to make sure that the correct position is logged. An impression of the Ardusimple 
receivers is given in Figure 3. 

  
Figure 3: Ardusimple product impression 



P a g e  | 16 
 

  
 

Using post processing software, also developed by Ardusimple, the recorded positional data from the 
Rover and Base station are compared. Any distortions, for example caused by clouds, can be accounted 
for because of the fixed location of the Base station. Using this, the true location of the Rover can be 
calculated. This surveying method is called “Post Processing Kinematic (PPK)” and has the advantage that 
the Base and Rover do not need a direct line of sight as is required in the more common “Real Time 
Kinematic (RTK)” set-up. 

The installation of both the hard- and software of Ardusimple is complex and requires a lot of steps that 
need to be followed precisely. This is therefore discussed in Appendix B. The appendix contains further 
introduction into the Ardusimple systems, the installation of all required software, and the preparation of 
the hardware. Completion of the installation is required before one can start to prepare for a measurement 
day discussed in section 3.4. 

3.4 PREPARING A MEASUREMENT DAY 

The execution of fieldwork is an important but time consuming task. Proper preparation of the fieldwork is 
therefore of the essence. The preceding paragraphs discussed determining which cross sections to take 
and the installation of a budget GNSS receiver. Using this, this step discusses important considerations to 
take into account when preparing actual field measurement days. Step by step instructions are found in 
Appendix C. 

The first step is in gaining the necessary permissions from relevant governmental bodies. Using the gained 
permissions, one can draft a explanatory letter to aid in field communication. This letter could, for 
example, contain the contact information of the governmental institutions which provided the permissions 
to execute the measurements. 

Working from the obtained permissions, the fieldwork planning should be reconsidered and finalised. 
Other materials required for execution of the fieldwork measurements should also be collected. Examples 
of these materials are ropes, pegs, a tripod and a water velocity meter. As each situation requires a 
different measurement approach, the equipment can vary. 

Important is also to gain experience with the instruments at hand and their functioning. It is therefore 
advised to perform mock measurements and process their data. By executing this mock measurement 
twice, one can check for irregularities 

With all the required equipment set, one is ready for the final preparations of a fieldwork day. During these 
preparations it is important to consider the terrain and environment one will be working in. Maybe a off-
road vehicle is required. These terrains also demand a clear communication of your whereabouts during 
the day. In case anything happens, one should be able to rely on precaution measures taken in advance. 
Having somebody that is known to the area is also a must during the preparation and execution of the 
fieldwork. 

3.5 EXECUTION OF A MEASUREMENT 

Requiring the completion of all preceding steps, one is now able to perform field measurements. For 
guidance an elaborated step by step manual is provided in Appendix D. This paragraph provides an 
overview of the steps that need to be executed per location. 

3.5.1 DETERMINE A SUITABLE CROSS SECTION AND ITS BANKFULL STATE 

Upon arrival it is important to get into contact with the local land owners. By explaining why you are here 
and the measurements you are planning to perform, you create understanding for the unusual sight of 
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someone performing measurements in the river. Also make sure to inquire about the bankfull state of the 
river. Often floodmarks provide this information as well, but it is always nice to check this with the locals. 

3.5.2 CROSS SECTION MEASUREMENT 

After familiarizing yourself with the locals and the area, the first measurement can be executed: the cross 
section. As the quality of the GPS measurements is influenced by local obstructions as buildings, trees, or 
anything else. The location should have a as clear view of the sky as possible. 

The cross section is measured from bank full state to bank full state perpendicular to the flow direction of 
the river. Measurement intervals of half a meter are used with a knotted rope as guidance. It is important 
to always note the location of the measurement, its characteristics and the mobile reception. On the same 
page also note which measurements were executed and the order.  

3.5.3 WATER ELEVATION MEASUREMENT 

Using both banks of the river, one can find locations for the water elevation measurement. The rover is 
placed vertically and stable for at least 10 minutes. Preferably this is done on the same place where the 
cross sectional measurement has taken place. This water elevation measurement is done for both the 
determination of the slope of the river, as well as model validation. Again it is very important to note down 
in which order the measurements were executed. 

3.5.4 LENGTH PROFILE 

Both up and downstream of the cross section, approximately 100 [m], other water height measurements 
are performed. This time only a single measurement on one of the banks is required. This measurement 
allows to check the slope of the cross sections against the slope of the entire river. The results of this 
measurement, together with the bank full state, are used in the determination of the Manning coefficient. 

3.5.5 VELOCITY PROFILE 

Using a water velocity meter, a velocity profile of the cross section is built. The same cross section as the 
cross section measurement in 3.5.2 should be used. The interval of half a meter can also be applied in this 
case. The velocity measurement is executed at predetermined depths, creating a grid. While one person is 
executing the measurement, the other is noting the results down. Several results can be communicated: 
false, zero, or a velocity. Using the total measured area and the speeds per area, the total average water 
velocity can be determined as well as the discharge. Both are used in the model validation. After 
completion of the velocity measurement one can wrap up all materials.  

3.5.6 SLOPE OF THE RIVER 

Determining the slope of the river using GPS measurements is usually not required. The slope can be 
determined using the data from the elevation of the cross sections along the river. This is done 
automatically by the Python script. But if some errors in the elevation data of the cross sections have 
occurred, this step results in a general idea of the slope. And thus in where to place the cross sectional 
profiles. 

The main idea of the slope determination is based on two general assumptions. Firstly, the fact that the 
water level is more or less parallel to the river bed. And secondly, that the discharge remains the same over 
the course of a day, provided that it has not rained. 

Using this, a last extra measurement day is prescribed. During this measurement day, one will visit the 
most upstream and downstream locations, if time allows also locations in between. By measuring the 
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water height at each of these locations, a slope can be determined. Important is to leave the Base at a 
secure location and logging its fixed position over the entire day. The error it was making before (between 
several measurement days) will now be equal for all measurements, thus placing them at the right height 
relative to each other. 

3.6 CONCLUSION 

In conclusion, after successful completion of this step one obtained all the required datapoints for post 
processing and the model building and validation. One has obtained: 

 A structured plan mapping the river by making cross sections; 
 Installed the Ardusimple GNSS receiver; 
 Familiarised with the system setup; 
 A strategy on how to deal with inflowing side rivers; 
 Permissions to execute the fieldwork; 
 All data resulting from the fieldwork.  
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4. PROCESS DATA 
During the field measurements the SD-card was used to log the positional data relative to the satellites. 
The conversion from this relative position to files, that serve as input for the HEC-RAS model, takes several 
steps which are discussed below. To start with this step, the following needs to be installed and 
completed: 

 Fieldwork measurements, discussed in Chapter 3. 
 RTK post processing software, installation discussed in Appendix E. 
 Python processing is further explained in Appendix F. 

4.1 RTK SOFTWARE PROCESSING 

The RTK post-processing software, an open source and continuously updated tool, has been chosen for 
its reliability, speed and cost-effectiveness (free) in interpreting satellite data. 

4.1.1 FILE STRUCTURE 

The first step in post processing is structuring the retrieved data. Each measurement performed by the 
Rover is saved in a separate .txt file on the SD-card. As they are numbered in the order of the measurement 
execution, one is able link the file to the measurement. Rename the files into descriptive and recognisable 
file names. Also make sure to change the “.txt” into “.ubx” extension and that they are saved to a preferred 
location. An example: 

 LOG00017.TXT  →   Cross_section_3_Profile.ubx 
 LOG00018.TXT →   Cross_section_3_Water_Height_1.ubx 
 LOG00019.TXT →   Cross_section_3_Water_Height_2.ubx 
 LOG00020.TXT →   Cross_section_3_Upstream.ubx 
 LOG00021.TXT →   Cross_section_3_Downstream.ubx 
 LOG00022.TXT →   Cross_section_4_Profile.ubx 
 Etc. 

Depending on how the base station was used, static at the home station, or dynamic by setting it up at 
each measurement location, the amount of log files are different. For a static home based base, a single 
log file is generated. Make sure to save this recognisable as the base file, also with “.ubx” extension. For 
the dynamic base placement, each location has its own log file. Make sure to save each location 
recognisable, also as a base, with a “.ubx” extension. An example: 

 LOG00003.TXT →   Base_section_3.ubx 

4.1.2 RTK SOFTWARE PROCESSING 

The raw “.ubx” data log files are now ready to be converted into “.obs” and “.nav” files. For this conversion 
the “RTKconv.exe” file is used. The “.obs” files identifies the satellites observed and the signal strength per 
timestep. The  “.nav” files contain the positional information about the identified satellites. Both files are 
required to calculate a precise location which is stored in a “.pos” file. The calculations required to create 
a “.pos” file are executed by the “RTKpost.exe” file. Appendix E contains a step by step instruction on how 
“RTKconv.exe” and “RTKpost.exe” are used. 
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4.1.3 SAVE THE DATA IN THE EXCEL TEMPLATE 

Many different file types were created using the RTK software, among others: “.pos”, “.nav”, “.obs”, 
“.pos.stat”, and “_events.pos”. The “.pos” files are the one used for further processing. The file names 
should be noted down in the Excel template and the files itself should be saved in the INPUT folder of the 
Data Processor package. This is further explained in Appendix F and the Excel template “input.xlsx” itself.  

4.2 PYTHON PROCESSING 

This manual comes with a Data Processor package. This is a folder structure, containing Python scripts 
that can process the data that is provided. All the required information for working with this package can 
be found in Appendix F in combination with the Data Processor package itself, which provides a brief 
instruction in the “README.txt” file.  

4.2.1 OPENING PYTHON FILE 

The Data Processor package contains three Python files: “RUN_THIS_NOTEBOOK.ipynb”, 
“SLOPE_DETERMINATION.ipynb” and “INDIVIDUAL_CROSS_SECTION.ipynb”. The first is the main Python 
file and the latter is only used if an individual cross section needs some more attention.  

The user is recommended to use the Anaconda Navigator to access Jupyter Lab and the Python files, as 
the Python scripts are designed for that specific environment. In Appendix F, it is explained step-by-step 
how to work with the Data Processor package and how to use Anaconda Navigator to open the Python files. 

FOLDER STRUCTURE 

The Data Processor package works with a specific folder structure which is crucial to its functioning. It is 
important to gain some understanding regarding this folder structure and to not change this structure, as 
the Python scripts won’t function without it. In short, the folder structure is set up as follows: 

Data Processor Package 
├── BACKGROUND_PYTHON_SCRIPTS 

│   ├── FUNCTIONS 

│   │   ├── Import_functions.py 

│   │   ├── Interactive_plot.py 

│   │   └── my_functions.py 

│   ├── Data_trim_tool.ipynb 

│   ├── GNSS_import.ipynb 

├── INPUT 

│   └── input.xlsx 

├── OUTPUT 

├── RUN_THIS_NOTEBOOK.ipynb 

├── INDIVIDUAL_CROSS_SECTION.ipynb 

└── README.txt 
 

The package will work based on this folder structure. In essence, the Python scripts take information 
(filenames and files) from the INPUT folder, process it with Python and export the results to the OUTPUT 
folder. This means that the user only has to copy information to the INPUT folder and copy results from the 
OUTPUT folder.  
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4.2.2 USING THE PYTHON FILE 

The Python scripts are set up in such a way that they barely need manual programming labour. Once the 
“input.xlsx” file is properly filled in, the Python scripts “RUN_THIS_NOTEBOOK.ipynb” and 
“SLOPE_DETERMINATION.ipynb” can run without needing additional input. Only the 
“INDIVIDUAL_CROSS_SECTION.ipynb” needs some user specified input. The exact use of the Python 
scripts is explained in Appendix F. 

WHAT TO DO WHEN A WEIRD RESULT IS OBTAINED 

If one of the cross sections has a weird result, then use the “INDIVIDUAL_CROSS_SECTION.ipynb” file to 
modify this cross section. This file allows you to trim the dataset, so that possible calibration processes at 
the beginning or unexpected movements at the end of the measurements can be filtered out. Additionally, 
this code enables you to alter the code for a single cross section, without affecting the others. 

Additionally, the Python scripts are tested on several sets of data. If the script gives an error, there are a 
few steps you can take: 

 Check if all needed python packages are installed. The notebook “RUN_THIS_NOTEBOOK.ipynb” 
guides you in this.  

 Check if you have uploaded the data correctly. Check: 
 If all the files you mention in the “input.xlsx” file are actually in the “INPUT” folder; 
 If you’ve spelled the names of the files correctly in the “input.xlsx” file.  

 Check if you’ve uploaded the correct file format (.pos, .csv or .xlsx). 
 Make sure that you haven’t altered the folder structure.  
 Check if you used ‘.’ (dot) as the decimal sign in Excel. If this is a ‘,’ (comma), the Python file 

doesn’t work properly.  

4.3 CONCLUSION 

In conclusion, the user needs two types of software to process the data, namely: 

 RTK processing software 
 Anaconda Navigator with Jupyter Notebook 

Additionally, the Data Processor Package, which is included with this manual, is needed.  

After the raw data of the GPS system has been converted to “.nav” and “.obs” files with “rtkconv.exe”, the 
positional data can be retrieved using “rtkpost.exe”. This positional data (“.pos” files) is used as input for 
the Data Processor Package. The package converts the input into usable output, which consists out of 
“.csv” files of the cross sections, an Excel file with hydraulic parameters of all cross sections, velocity 
profiles and local slopes. This output can be used as input for the HEC-RAS model and the evaluation of 
the Manning equation.   
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5. BUILD MODEL 
A one-dimensional hydraulic model can be developed to identify the critical discharge upstream of the 
river that leads to flooding at a defined flood point. With the determination of this critical discharge, the 
travel time required for the water to reach the flood point can be calculated. If this time is adequate, a 
sensor can be placed at the upstream boundary of the model to provide timely warnings. However, if the 
calculated travel time is insufficient, the sensor's optimal location must be determined through an iterative 
process, which involves expanding the model in upstream direction. The model is based on field 
measurements to replicate the reality as accurately as possible. 

To determine the critical discharge, a flash flood has to be modelled, which can be quite challenging 
depending on the software used. A flash flood is a time-dependent process, hence requiring software 
capable of simulating unsteady flow. A flash flood is characterized by a rapid rise in water level, 
necessitating a relatively short simulation time. Additionally, the time steps within the simulation should 
be short, to accurately capture the dynamics of the flash flood. Measurements of the water level rise 
should ideally be conducted to define the upstream boundary condition; however, this can be quite 
challenging due to the high velocity head of the water. Furthermore, the software should be able to model 
this high velocity head.  

For this manual, the model is created with HEC-RAS software, a simulation programme developed by the 
United States Army Corps of Engineers. The software is open-source and can be downloaded on various 
websites. As of the time of writing, the newest version is HEC-RAS 6.6. A more elaborate theoretical 
background of the model is given in Appendices G and H. 

To be able to draw conclusions from the model, it should be validated that it represents the physical 
processes of the river. The results should be consistent with real-time field measurements. This can be a 
very difficult task due to limited and inaccurate field measurements, complexity of the physical processes 
of the river, and uncertainties of the model parameters, like Manning's coefficient.  

Both model verification and validation are yet to be completed for this manual, as more field 
measurements and knowledge of the HEC-RAS software is essential to achieve a good result. However, 
this part of the manual will give guidance on how to approach this, explains the steps that have already 
been taken and tries to identify the causes of the issues that were encountered. For different approaches, 
the quality of the result is assessed, in order to give handles in the modelling decisions you might make.  

The manual is written in such a way that it mostly functions as a guideline, while new approaches are 
undertaken. Therefore it is recommended to first read this chapter. Per step, the corresponding paragraphs 
of Appendix G are mentioned. To follow the steps to create the best functioning model, as is created within 
this manual, from scratch, go to Paragraphs 1, 2, 3, 4, 5, 6, 7, and 8 of Appendix G.  

5.1 ALTERNATIVE MANUAL COMPUTATIONS 

For data-scarce areas, often simpler methods than models are recommended in order to give an 
estimation of parameters that are to be determined.  Discharges can be calculated based on Manning’s 
formula, and this can be combined with a method by Leopold & Maddock. By combining these two 
methods, one should be able to calculate the discharge in a channel based on either a measured width, 
depth, or flow velocity. This can be used to convert a water level gauge upstream to a discharge. Similarly, 
based on a (high) discharge, a flow velocity can be determined. This methodology is described in Appendix 
I.  
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However, since the method did not appear to be valuable in the case study in Narok Town, it is not further 
implemented in this document. The results are given in the document “Implementation of a Flood Early 
Warning System in Narok Town, Kenya”. (Venutelli, 2005) (Luna B. Leopold, 1953) (Williams, 1978) 

5.2 MODELLING A FLASH FLOOD 

The recommended approach for building a model that can simulate a flash flood consists of three steps:  

1. Creating the complete geometry of the part of the river that has to be modelled 
2. Creating a steady flow model to calibrate Manning’s coefficient 
3. Defining an unsteady model to simulate the flash flood 

5.2.1 GEOMETRY 

To be able to simulate a flash flood, the geometry of the river should be defined as detailed as possible. 
The level of detail depends on the amount of data available. The geometry, width and elevation of the river, 
is based on field measurements of the cross-sections at different representative locations, as explained 
in Chapter 3. Keep in mind that you need to model the section of the river that extends from the expected 
location of the sensor to the bottleneck of the system, as is determined in Chapter 2. 

The course of the river can be modelled by using the built-in function of RAS Mapper, which allows you to 
add a background layer created with web imagery. RAS Mapper is a graphical interface within HEC-RAS. To 
do this, a terrain and a projection file must be added. This manual makes use of OpenStreet Maps. After 
adding the background layer, the course of the river can be drawn either in RAS Mapper or in HEC-RAS. 
Keep in mind that the program responds slowly when loading OpenStreet Maps in HEC-RAS. The required 
files are created by following the steps in Appendix A, which is explained in Chapter 2.3.  

5.2.2 STEADY FLOW 

After completing the geometry, the steady flow data can be specified. The following input is required to run 
a steady flow model: 

 FLOW REGIME 

The flow regime can be mixed, supercritical or subcritical. The objective of the steady flow model is to 
calibrate Manning’s coefficient, which can be achieved by using  the validation measurements as input for 
the flow data. To collect these measurements, the river must be safe to stand in, implying that the water 
likely has a low velocity head. Therefore, it is reasonable to assume that the flow regime is subcritical. This 
assumption can be verified by applying the average velocity and depth of the cross-sections, obtained in 
chapter 4, to the Froude number formula. If Froude’s number is less than 1, the flow is subcritical; if greater 
than 1, it is supercritical. 

 BOUNDARY CONDITIONS 

HEC-RAS requires boundary conditions as starting values for the program to begin calculations. In a 
subcritical flow regime, only a downstream boundary condition is necessary. A known water surface 
elevation or normal depth are recommended, as these can be derived from the field measurements. 
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 PEAK FLOW DATA 

Since this is a steady flow model, the discharge remains constant over time. Therefore, the model requires 
a specified discharge as input. However, the discharge can vary along the river, for example, where 
tributaries enter. This is modelled by adding flow change locations where the new discharge can be 
specified. The discharge derived from the field measurements is used as input for the peak flow data. 
Chapter 3.1.1 describes how the discharge of the tributaries is determined. 

The objective of the steady flow model is to calibrate Manning’s coefficient. Manning’s roughness 
coefficient 𝑛𝑛  is used in Manning’s equation to calculate flow in open channels. It represents the roughness 
or friction of the channel bed and thus the energy loss.  This calibration process will be iterative, involving 
adjustments of  Manning’s coefficient until the model output aligns with the observed validation 
measurements. As a first estimate, the Manning roughness coefficient can be based on literature.1  Keep 
in mind that Manning’s coefficient depends highly on the provided water level and velocities. If these 
measurements are inaccurate, Manning’s coefficient will also be inaccurate. 

5.2.3 UNSTEADY FLOW 

The main difference between the steady flow model and the unsteady flow model is that the latter is time-
dependent. It does not require a fixed discharge; rather, the discharge can vary over time. The upstream 
boundary condition is defined by a flow hydrograph, which indicates an increasing discharge as time 
progresses. The first value of this hydrograph is used as an initial condition for the model. The downstream 
boundary condition is defined by the normal depth. A more detailed explanation of these boundary 
conditions can be found in Paragraph 7 and 8 of Appendix G. Furthermore, the Manning roughness 
coefficient, derived from the steady flow model has to be implemented in the unsteady flow model. 

5.3 MODELS 

5.3.1 FULL MODEL 

The full model is developed according to paragraphs 1, 2 and 3 of Appendix G. The geometry is created in 
RAS Mapper, depicting the actual course of the river. All measured cross-sections are included in this 
geometry. As explained in paragraph 5.2, the steady flow model was first run to determine manning’s 
coefficient, followed by the unsteady flow model, as explained in paragraph 7 and 8 of Appendix G. A 
detailed explanation of how to view the results in  HEC-RAS is provided in Appendix H. For both models, 
the validation data is used. The inputs for both the steady and unsteady flow are summarized in Table 1.  

 

 

 

 

 

 

 

1 The Manning roughness coefficient is determined for different channel types by Ven Te Chow, in his 
textbook Open Channel Hydraulics, published in 1959. A table can be retrieved on 
https://www.fsl.orst.edu/geowater/FX3/help/8_Hydraulic_Reference/Mannings_n_Tables.htm  

https://www.fsl.orst.edu/geowater/FX3/help/8_Hydraulic_Reference/Mannings_n_Tables.htm
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Table 1: Input of full model in HEC-RAS 

Type of input Input 

Geometry • 13 measured cross sections 
• Downstream reach lengths correspond to actual distances 
• Underlaying terrain and projection 
• Course of the river 

Flow regime • Subcritical 

Boundary conditions Steady 
Flow 

• Discharge 1.85 [m3/s] 
• Upstream  known W.S. equal to  

1900.85 [m]  
• Downstream known Normal Depth equal to 0.00251 [m/m] 

Boundary conditions 
Unsteady Flow 

• Upstream Flow Hydrograph,  
1.85 [m3/s] during 1 hour 

• Downstream known Normal Depth equal to 0.00251 [m/m] 

Slope • 1 consistent slope 

For the unsteady flow model, a constant discharge equal to the steady-state discharge of 1.85 [m3/s] is 
applied throughout the entire simulation time of the flow hydrograph. However, as shown in Figure 4, this 
resulted in unrealistic output. The figure shows the water levels that were reached after simulating the 
model one hour, which were found to be inconsistent with the validation data, indicating that the model 
does not accurately describe the reality. 

Figure 4: Output unsteady flow full model 

The values in Table 2 correspond to Figure 4 and confirm that the output is not representative of reality. 
Both the discharge and velocity exhibit negative values, which is not possible. Additionally, the velocity 
shows unrealistic high values, even though the discharge defined in the flow hydrograph is not particularly 
high.  
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Table 2: Output unsteady flow full model 

River Station Q Total [m3/s] Velocity [m/s] 

13 1.85 210.9 

12 -5.96 -0.41 

11 0.16 29.52 

10 5.58 517.70 

9 -0.08 -1.38 

8 0.96 159.17 

7 8.88 28.69 

6 54.44 9.56 

5 64.64 2.24 

4 69.85 35.88 

3 26.93 6.83 

2 8.94 88.36 

1 3.59 27.03 

It was suspected that the problem originated from the terrain data and the projection file uploaded in RAS 
Mapper. It appears that HEC-RAS either geo-references the cross-sections even when no coordinates are 
provided, or it still considers the elevation data from the Digital Elevation Model (DEM), despite this data 
being removed from the cross-sections. The disadvantage of RAS Mapper is that you must specify a 
projection file and add a terrain layer before you can include web imagery, even if you don’t want to geo-
reference your project or use a DEM. It seems that HEC-RAS is primarily designed for creating elevation 
data using a DEM rather than using field measurements. To confirm this hypothesis, an analysis had to be 
performed. A simplified model was taken as starting point and expanded step by step to determine the 
source of the problem. The following paragraphs will elaborate on the intermediate models that were 
developed during the analysis and serve as a checkpoint for the performance of the model. 

5.3.2 MODEL BUILD-UP 

This section describes the performance of each intermediate model, as explained in Paragraph 5.3.1. For 
each model, a conclusion will be drawn regarding its shortcomings and what might have caused the 
inconsistent results observed in the unsteady full model.  

SIMPLIFIED LINE MODEL 

This is the simplest model that can be considered. This model is developed to check whether it reacts the 
way it is expected to, for both steady and unsteady flow. The model is created by following the steps 
specified in Paragraph 4 of Appendix G.  

INPUT 

Table 3: Input of simplified line model 

Type of input Input 

Geometry  • No underlaying terrain and projection 
• Straight line 
• 2 Rectangular cross sections 
• Downstream reach length equals 500 m 
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Boundary conditions Steady 
Flow 

• Discharge 1.85 [m3/s] 
• Upstream  known W.S. equal to  

1900.85 [m]  
• Downstream known Normal Depth equal to 0.00251 [m/m] 

Boundary conditions 
Unsteady Flow 

• Upstream Flow Hydrograph,  
1.85 [m3/s]during 1 hour 

• Downstream known Normal Depth equal to 0.00251 [m/m] 

Slope • 1 consistent slope 

RESULTS 

For both the steady and unsteady models, the outcomes were as expected. The water elevations remain 
within realistic ranges. It can therefore be concluded that there are no issues when creating the geometry 
in HEC-RAS with rectangular cross-sections. 

EXPANDED LINE MODEL 

This model builds on the previous one but will be slightly expanded. First, the rectangular cross-sections 
will be replaced by the measured cross-sections. This can be accomplished by removing the cross-section 
data as previously specified and performing step 10a of Paragraph 4 in Appendix G. Use the cross-sections 
located at the upstream and downstream boundary of the modelled river. Be sure to redefine the main 
channel bank stations (step 13 of Paragraph 4 in Appendix G). Secondly, the downstream reach length is 
prolonged to the measured distance between the cross sections (step 11 of Paragraph 4 in Appendix G). 

INPUT  

Table 4: Input of expanded line model 

Type of input Input 

Geometry  • No underlaying terrain and projection 
• Straight line 
• 2 measured cross sections 
• Downstream reach length equals 3500 m 

Boundary conditions Steady 
Flow 

• Discharge 1.85 [m3/s] 
• Upstream  known W.S. equal to  

1900.85 [m]  
• Downstream known Normal Depth equal to 0.00251 [m/m] 

Boundary conditions 
Unsteady Flow 

• Upstream Flow Hydrograph,  
1.85 [m3/s] during 1 hour 

• Downstream known Normal Depth equal to 0.00251 [m/m] 

Slope • 1 consistent slope 

RESULTS 

Replacing the rectangular cross-sections with the measured cross-sections and prolonging the 
downstream reach length to 3500 meter does not result in any significant changes in the model’s output 
for both the steady and unsteady states. Therefore, it can be concluded that there are no issues with the 
distance between two subsequent cross-sections and more complex cross-sections. 
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COMPLETE LINE MODEL 

Use the Expanded line model as the starting point for this model. The complete line model incorporates all 
measured cross-sections and, additionally, interpolated cross-sections. Adding cross-section by 
interpolation enhances the stability of the model, as the step size of the calculations decreases. How to 
interpolate cross-sections is explained in paragraph 6 of Appendix G. There are two differences from the 
full model. Firstly, the river is modelled as a straight line, disregarding the actual course of the river. 
Secondly, this model does not include an underlying terrain or projection file. To add the missing cross-
sections and the correct downstream reach lengths, follow steps 5 to 17 of Paragraph  4 of Appendix G. 
Use step 10a instead of 10b. The correct downstream reach lengths are retrieved from Google Maps. 

INPUT  

Table 5: Input of complete line model 

Type of input Input 

Geometry  • No underlaying terrain and projection 
• Straight line 
• 13 measured cross-sections 
• Interpolated cross-sections 
• Downstream reach lengths correspond to the measured values 

Boundary conditions Steady 
Flow 

• Discharge 1.85 [m3/s] 
• Upstream  known W.S. equal to  

1900.85 [m]  
• Downstream known Normal Depth equal to 0.00251 [m/m] 

Boundary conditions 
Unsteady Flow 

• Upstream Flow Hydrograph,  
1.85 [m3/s] during 1 hour 

• Downstream known Normal Depth equal to 0.00251 [m/m] 

Slope • 1 consistent slope 

RESULTS 

For both the steady and unsteady models, the water elevations remain within the expected margins and 
align with the validation data. Therefore, it can be concluded that the malfunctioning of the full model is 
most likely related to either the representation of the actual course of the river, including the incorporation 
of bends, or the underlaying terrain.  

IMPORT FULL MODEL GEOMETRY 

To determine whether the underlaying terrain is the cause of the malfunctioning of the unsteady full model, 
the geometry of the full model, which was created using a projection, was imported into a new geometry 
file. The geometry could be imported without any linked projection file and terrain data. It had to be 
imported from the full model because the course of the river could not be recreated in HEC-RAS without 
web imagery. By deselecting the GIS Cut Lines option, the geometry is no longer georeferenced. An 
explanation of GIS Cut Lines is provided in Paragraph 5 of Appendix G.  

INPUT 

Table 6: Input of full model geometry 

Type of input Input 

Geometry  • No underlaying terrain and projection 
• Course of the river 
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• 13 measured cross sections 
• Downstream reach length correspond to the measured values 

Boundary conditions Steady 
Flow 

• Discharge 1.85 [m3/s] 
• Upstream  known W.S. equal to  

1900.85 [m]  
• Downstream known Normal Depth equal to 0.00251 [m/] 

Boundary conditions 
Unsteady Flow 

• Upstream Flow Hydrograph,  
1.85 [m3/s] during 1 hour 

• Downstream known Normal Depth equal to 0.00251 [m/m] 

Slope • 1 consistent slope 

RESULT 

The output of the model was found to be identical to that of the Complete line model. When the GIS Cut 
Lines option is selected, the model’s output is not identical and results in unrealistic values, confirming 
that the terrain data and projection file were indeed the root cause of the problem. 

Additionally, it can be concluded that representing the actual course of the river is not the cause of the 
malfunctioning in the unsteady full model, and that drawing the course of the river does not incorporate 
bends. The geometry can be exported to a new project without the attached terrain data and projection 
file. This model does not yield negative velocities or discharges, nor does it result in extremely high 
velocities. 

When comparing the model’s output with the validation data, it was found to align approximately, 
especially at the most upstream cross-section. This makes sense, as the bends are not incorporated into 
the model. As you move further downstream, more bends will be encountered, leading to a deceleration 
of the water and an increase in the water level. This aligns with the validation data. The difference between 
model’s output and the measured water level increases as you go further downstream. The model’s output 
will likely be closer to the validation data if bends are incorporated. 

ADDING BENDS TO MODEL 

As explained in the previous paragraph, drawing the course of the river does not mean that bends of the 
river are accounted for. Therefore, different approaches need to be considered to add bends to the model. 
This paragraph elaborates on different possible approaches. 

QGIS 

HEC-RAS  recognizes a bend in the river by changing the downstream reach length of the left and right over 
bank. Doing this manually would require a lot of time and wouldn’t be very precise, as the reach lengths 
are measured from web imagery. This requires a very good resolution of the web service used. As an 
alternative, QGIS can be employed. However, burning the river in the DEM led to a resolution which was 
too coarse to give precise results. Therefore, it was decided not to choose this method. More elaboration 
on the application of GIS data in HEC-RAS, is given in Appendix H.  

To check whether changing the downstream lengths has an effect, a part of the river was adjusted 
manually. This does have an effect on the model’s results. The results give higher water elevations as 
expected. 
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MINOR LOSS COEFFICIENTS 

Considering that changing the downstream reach lengths is not achievable. Defining minor loss 
coefficients could be a solution. This coefficient adds an energy loss to a selected cross-section. However, 
it is very hard to verify whether the selected coefficient is correct as one cannot validate this. This approach 
is explained in Paragraph 9 of Appendix G. 

MANNING’S COEFFICIENT 

The final considered option is to adjust Manning’s coefficient to simulate the energy loss generated by the 
bends. The coefficient could theoretically be adjusted per section to match the validation data. However, 
this option was not used as it is not representative for the real situation. 

CONCLUSION 

The most accurate way of incorporating bends into the model is by adjusting the reach lengths of the left 
and right overbank for each cross section. However, doing this manually for a long river reach is 
impractical, as it would require too much time. Therefore, QGIS could be a solution. However,  for this 
case, the results were not precise enough. Nevertheless, this method should still be considered for future 
projects, as it can lead to the most accurate way of incorporating bends into the model. The two other 
options shouldn’t be considered as they are either difficult to verify or not representative of reality. 

5.3.3 CONCLUSION  

The following conclusions were drawn from the intermediate models: 

 Simplified line model 
There are no issues with creating the geometry in HEC-RAS with rectangular cross-sections. 

 Expanded line model 
There are no issues with the distance between two subsequent cross-sections and more complex 
cross-sections. 

 Complete line model 
The malfunctioning of the full model is most likely related to either the representation of the actual 
course of the river, including incorporation of bends, or the underlaying terrain. 

 Import full model geometry 
The terrain data and projection file were indeed the root cause of the problem. Additionally, it can 
be concluded that representing the actual course of the river is not the problem and drawing the 
course of the river does not incorporate the effect of bends. Furthermore, the model aligns 
approximately with the validation data.  

Adding a projection file is relevant when one wants to incorporate bends into the model.   Important is that 
when one draws the course of the river this does not mean that HEC-RAS sees it as such. HEC-RAS only 
models for bends when the downstream lengths are taken into account. As was concluded above this 
cannot be done manually and QGIS did not work in this case.  QGIS however should still be considered for 
future projects. This manual will continue with the complete line model, to elaborate on further steps. 

5.4 CONSLUSION BASED ON COMPLETE LINE MODEL 

As explained, the difficulty of modelling with HEC-RAS lies in incorporating the bends of the river, which is 
yet to be understood. However, the critical discharge and corresponding warning time can still be 
concluded from a model without bends, namely the Complete line model. They will be a bit more 
conservative in the sense that the warning time will be longer in reality since bends cause energy losses 



P a g e  | 31 
 

  
 

due to friction and turbulence. This will result in a lower average velocity of the water and thus, a longer 
travel time to the flood point.  

Computing an exact warning time is not possible with this manual, as there is no sufficient data for the 
boundary conditions in the unsteady state. Measuring this is very challenging, as measurements in these 
conditions, a high water level and velocity, go hand in hand with dangerous situations. Therefore, the 
stage/flow hydrograph is based on the bank-full discharge, determined by the Manning method, at the 
most upstream cross-section. This discharge is accompanied by a lot of uncertainties, since the bank-full 
level of the river is based on judgement by sight. The simulation time, the step size of the discharge during 
the simulation and the initial value of the discharge remains very uncertain as well. The preferred method 
is conducting measurements to define the necessary flow hydrographs. 

Setting the correct boundary conditions when modelling unsteady flow is crucial for getting a 
representative output. The following boundary conditions should be known to estimate the warning time: 

1. Stage/flow hydrograph at the upstream boundary 
2. Flow hydrograph for the lateral inflows where tributaries enter 
3. The bed slope, used for calculating the normal depth, at the downstream boundary 

When one compares the results of the steady- and unsteady model with the verification measurements it 
can be concluded that the model gives a realistic output. The model itself could therefore be used to model 
a flash flood provided that the flow boundary conditions are known. 

The conclusion on the warming time and the corresponding critical discharge of this model can be found 
in Implementation of a Flood Early Warning System in Narok Town, Kenya. In this chapter, also a brief 
sensitivity analysis is included. Here, the impact of reducing the number of measured cross-sections is 
explored. This sensitivity analysis should be expanded with more subjects, such as the number of 
measurement points per cross-section, or the need of measuring a flow velocity profile. However, since 
the results of the model so far are unreliable, these analyses are not yet executed. Their conclusions 
should be implemented in this manual. 

5.5 CONCLUSION 

HEC-RAS can be used to simulate a flash flood, but it is accompanied by many uncertainties: 

 Inaccurate measurements of the water level and velocity can result in an unrealistic Manning’s 
coefficient. Manning’s coefficient is changed until it corresponds to the water levels and 
velocities that are provided, therefore, it depends highly on these measurements.  

 The upstream boundary condition in case of a flash flood is defined as a stage/flow hydrograph. 
To be able to define this properly, measurements have to be conducted in these conditions, 
which is very dangerous. Therefore, the flow hydrograph is based on the bank-full discharge 
calculated with the Manning method. This discharge is very inaccurate as it is based on 
judgement by sight of the bank-full level of the river. The simulation time, the step size of the 
discharge during the simulation time and the initial discharge remains very uncertain as well.  

 Bends are not incorporated into the model. When bends would be incorporated, it would result 
in a higher warning time. Bends lead to a deceleration of the water and an increase in water level.  

A model without bends can be used to determine the critical discharge and corresponding warning time. 
However, it is recommend to use a model with bends, as it will be a better representation of the reality. 
Therefore, incorporating bends into the model by using QGIS should be further explored. 

Alternative manual computations also form a promising method, but should be further explored.  
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6. IMPLEMENTATION 
This chapter describes the implementation of the Flood Early Warning System, and all aspects that play a 
role in this phase.  

6.1 PARTNERS INVOLVED 

A Flood Early Warning System will only be valuable if a partner is willing to be responsible for the system. 
Responsibilities include protection, maintenance, and verification and transmitting of the warning.  

6.1.1 LOCAL AUTHORITIES 

In Chapter 1, the local authorities are listed and described. These local authorities are often already 
involved in flood damage reductions and warning systems. Credibility and clear communication are key in 
transmitting an early warning, considering that actions taken and therefore the effectiveness of the system 
will depend on this.  

In many countries and regions, general research is done on the subject of early warning systems, often 
describing stakeholders involved. This is already listed in Chapter 1 as well. Take lessons from found 
conclusions and apply these to the system you are designing.  

6.1.2 LOCAL COMMUNITY 

The sensor, triggering a warning, will often be located in remote areas, not close to local authorities. To be 
able to ensure a year-round functioning system, regular checks and tests should be conducted. The 
involvement of local community could play a important role in this. Protection is considered one of the 
major challenges as well, also giving way to the role of local community.  

Typical failures of a FEWS in the long-term are a failing sensor, empty batteries, malfunctioning solar 
regulators, or an expired SIM-card.  

A possible strategy is to place sensors in the proximity of institutes like schools, governmental companies, 
or churches. At these institutions, a responsible person can be set in charge of the system, and social 
control will make sure the responsibility is kept. An added benefit is the accessibility of these locations, 
which allows for the local authorities to visit and conduct maintenance. 

An example on community-oriented flood early warning system is designed by the International Centre for 
Integrated Mountain Development (ICIMOD), a regional intergovernmental organization working in the 
Hindu Kush Himalaya mountain range. Their system is based on a river water level monitoring, like in this 
manual, and the transmission is done by local communities, by means of a clear message system and the 
designation of roles and a flood risk management committee. (ICIMOD, 2024) 

Lessons that are learned from examples like this one, is to design a clear and strict system with a simple 
message system and clear role distributions. Another lesson learned by former early warning systems in 
Kenya, according to the Kenya Meteorological Department, is the importance of not relying on 
governmental payment. Relying on an inconsistent financial supply will affect the reliability of the persons 
involved. Since constant reliability and willingness to cooperate are vital for a continuous warning system, 
this is an important aspect. Appreciation and valuation can be rewarded in different ways. More on funding 
is described in 6.1.3.  
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6.1.3 FUNDING 

Funding is a critical aspect of the implementation of a Flood Early Warning System. In addition to the costs 
involved in the design, which includes executing the steps above and/or another method, and the costs of 
the installation of a water level gauge and communication system, continuous costs will be present. These 
long-term costs are considered the most difficult to supply, since budgeting and long-term payment 
promises are difficult to estimate and to come by. A list of aspects of these long-term costs is given below:  

 Maintenance of the sensor 
 Power supply of the sensor 
 Maintenance of the power supply 
 Compensation of involved local communities 
 Costs for the managing party 

Typical failures of a FEWS in the long-term are a failing sensor, empty batteries, malfunctioning solar 
regulators, or an expired SIM-card. All of these failures ensure a complete shutdown of the system, which 
makes these kind of information-based structures highly vulnerable. However, the costs of these failures 
are reasonably low.  

The sustainability and durability of the system depend on the funding method. It is not desirable to rely on 
governmental fundings, or funding by (international) organizations. In many African countries, delays in 
payments by the government are experienced, and the continuation of the financing can alternate due to 
political changes. Funding by international and/or humanitarian organizations often deals with the 
difficulty to provide a long-term payment, and it doesn’t contribute to the self-reliance of a community and 
the sustainability of the system.  

It can be concluded that a sustainable financial income should come from the local community itself and 
be handled by a local authority. How to achieve this, is rather difficult.  

TEMBO has documented approaches in terms of the funding in a report on the design of modular Flood 
Early Warning Systems. As is concluded here, it is stated that in most African countries, local authorities 
such as Hydro-Meteorological Services are under-staffed and under-funded, to maintain and operate a 
FEWS. It is also stated, that typically initial funding is provided by international donors, but measures to 
ensure that the FEWS remains operational often lack. The approach of TEMBO is to design a FEWS in an 
inverted process, based on the locally available financial supply. A first estimate is given, of an amount of 
EU 0.05 per inhabitant per year. This amount can come from local and/or national government institutions. 
The implemented equipment will be maintained by a private entity, such as TAHMO, with sufficient 
technical staff and rapid deployment capability. (TEMBO Africa, 2024) 

A concept that is used by authorities in Kenya is to compensate the involved local community not in means 
of payments, but in acknowledgement and engagement in the developments. The responsible person 
could be invited to meetings and/or conferences on the subject. This way, contact is maintained and no 
financial expectations are risen.  

It is recommended to do further research in well-functioning Flood Early Warning Systems in similar areas, 
and to take lessons from there.  

6.2 FUNCTIONING OF THE SYSTEM 

After installation, the functioning of the system needs to be defined. With this, two main aspects are aimed 
at. Firstly, how a trigger of the sensor will be processed and transformed into a warning. Will this be 
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automated or should this be confirmed manually? And if so, how and by whom? Secondly, after a warning 
is confirmed, how will this be communicated to the community?  

6.2.1 PROCESSING THE WARNING 

The water level gauge will trigger a warning, based on a threshold value. This can either regard a discharge 
measurement, a water level depth measurement, a flow velocity measurement, or the change over time in 
any of these parameters. This is part of the design choices made in Chapter 5. When the gauge triggers a 
warning, this needs to be processed into an actual warning. This process is not extensively investigated for 
the creation of this manual.  

The processing will need to be determined in coordination with the involved parties, determined in 
Paragraph 6.1. The goal of the process is to confirm the reliability of the trigger, and to convert to an actual 
warning.  

This process will add to the total warning time of the system. An estimate of an addition of 15 minutes is 
given in Chapter 2. The actual warning time of the system itself, without processing, is determined by the 
model in Chapter 5. When the process is determined, the real warning time can be concluded. It is an 
important step to validate this total warning time, based on the required needs established in Chapter 2. If 
the required result is not met, an iterative revision of the warning system is needed. 

6.2.2 COMMUNICATION OF THE WARNING 

The warning message needs to travel from the source, to the intended recipients. Successful 
communication methods will differ for different regions, and for different recipients. A recommended 
approach is given below. The results of following this approach is given in the document “Implementation 
of a Flood Early Warning System in Narok Town, Kenya".  

A first note is to pay attention to the type of warning you will want to transmit. Following the design as is 
suggested in this manual, there will only be one straightforward possible warning: a flood is coming in a 
certain amount of time. This amount of time should be known by the recipients beforehand, in order for 
them to be able to correctly interpret the signal. Another possibility is a warning with multiple risk levels, 
for example: level 1: low flood risk, level 2: medium flood risk, and level 3: high flood risk. If this is the case, 
a system based on codes, colours, text, or different sounds need to be designed.  

For now, the first option, with only one possible meaning of the warning, is considered. The following steps 
are proposed in order to get a sense of the effective communication methods in your region. Input of local 
community and authorities will be very valuable in the process of deciding on a communication method.  

1. Define the intended recipients of the warning. This includes everyone who could be benefited by 
the flood early warning, or who could contribute to anticipatory action. Think of residents, shop 
owners, employees in shops and offices in the floodplain, visitors, and authorities such as the 
police or fire department.  

2. Hold a brainstorm session to think of all possible communication methods, that would be 
available in the region, and that would fit in the budget of the project. This list of methods will 
function as a starting point for the selection. 

3. Per type of recipient, think of effective communication methods.  
 Think of all restrictions and resources a recipient type might encounter. Compare this 

with the list of possibilities and cross off not effective methods.  
 Interview representatives per type of recipient. Let them think of communication methods 

first by themselves, in order not to restrict the possibilities. Then inquire what method 
would work best for them.  
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4. Compare the effective communication methods per type of recipient and find corresponding 
methods. Keep in mind the ratio of recipient types, to give importance to certain factors. 

5. Decide on the most suitable communication method. 

6.3 SELECTING A SENSOR  

The threshold value that is concluded in Chapter 5 can be measured in multiple ways, with different kind 
of sensors. Deciding on the type of sensor includes considerations like costs, energy demand, 
maintenance and applicability. How to include all these considerations, and an enumeration of possible 
sensors, is described in this step.  

6.3.1 TYPES OF SENSORS 

This section discusses the different type of sensors that are available to measure the water height in the 
river. Several things are important in this. Firstly, the angle in which the sensor is mounted. Some sensors 
need to be straight above the water, but others can be next to the water and pointed to the water surface 
under an angle. Secondly, the weight and the required stability are of importance. Another thing to mention 
is that this section only focusses on non-contact sensors, which do not actually make contact with water. 
There are however in situ methods that can measure the water height, but these are left outside the scope 
of this section. This is because in situ methods are more prone to extreme conditions, such as debris that 
is transported by the river. Non-contact methods are more flexible in that sense and provide more 
convenience (AGU - Advancing Earth and Space Sciences, 2024).  

The first possible sensor is a radar level sensor. This sensor measures the water level using radar, which 
means that it should hang perpendicular above the water. Advantages are that these sensors are very 
compact and robust. They have no troubles in adverse weather conditions. Additionally, they can 
communicate their measurements through radio signal. (iJiNUS - Groupe Claire, 2024)  An example is given 
in Figure 5.  

A Lidar sensor is the second sensor that belongs to the possibilities. Such a type of sensor works by 
emitting a laser pulse and measuring its time-of-flight till it returns to the sensor, as depicted in Figure 6. 
An advantage to the radar level sensor, is that such a sensor doesn't have to hang straight above the water, 
but can also operate under an angle. This does decrease the accuracy, but only on centimetre level, so 
that could still be applicable for the case of a FEWS. (AGU - Advancing Earth and Space Sciences, 2024)                                 

 

 

 

 

 

 

       

 

  

Figure 5: A sensor mounted straight above 
the water level 

Figure 6: Functioning of a lidar sensor 
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Lastly, it is possible to use a camera. This camera records the flow of the river and can use an open 
source, such as pyorc (pyOpenRiverCam 0.5.6, 2023), software to analyse the flow. In that way, the 
camera can measure water level and the flow velocity, which means that a rough estimation of the flow 
can be made. 

  

Figure 7: Camera for water measurements 

An example is given in Figure 7.  

There are more non-contact methods available to measure water level, such as using GPS. However, these 
methods are deemed to be less applicable than the sensors above. In short, Table 3 gives an overview of 
the discussed sensor and their applicability. 

Table 7: Summary of possible types of sensors and their required installation method 

Type of sensor Straight/under angle Measures 

Radar level sensor Straight Water level 

Lidar Both Water level 

Camera Angle Water level 

Flow velocity 

6.3.2 SELECTING THE SENSOR 

The sensor is a crucial element in the FEWS. Therefore, it is important to consider the different aspects 
that come into play when selecting a sensor. The previous section discussed the different types of sensors, 
while this section introduces criteriums that can guide the user to select the proper sensor.  

Firstly, the costs of the sensor are important. A very expensive sensor can measure very accurately and 
possibly multiple things. However, a very expensive sensor will highly impact the implementation costs of 
a FEWS, which reduces its applicability in small urban areas in Africa. Additionally, what if the sensor gets 
stolen? It will be very costly to replace it. 

Secondly, robustness is important. A sensor that requires a lot of maintenance, is not as suitable for a 
FEWS, as there is a higher chance of operation being compromised. The sensor for this application will 
most likely experience adverse weather conditions, so it better be able to withstand such type of 
conditions. 

Additionally, the power required for operation is of concern. In the areas of application, the sensor will 
likely be placed at a somewhat remote place, which is a difficult location to get power to. It's not 
impossible, but it could increase the complexity of the FEWS.  
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Lastly, the communication method should be considered. If data can only be stored on a SD-card for 
example, how can people ever be warned on time that a flash flood is coming? This criterium is probably 
less dependent on the sensor itself, but it is important to keep it in mind when selecting one.  

In conclusion, when looking at possible sensors, one should consider factors such as costs, robustness, 
power use and communication methods. These criteriums can guide the user in selecting the proper 
sensor for the application at hand.  

6.4 INSTALLATION OF THE SENSOR 

Building on the proceeding steps, the sensor can now be installed. Do mind that there are many different 
considerations to be taken into account. Looking at previously installed sensors a lot can already be 
learned. Within Kenya, Ghana and numerous other African countries, many examples of sensors being 
stolen or destroyed can be found. Destruction can be humanly intended, but also wildlife and weather 
conditions play a roll. Furthermore, failure of the sensor itself is a possibility, which leads to the 
requirement of maintenance and repair, and therefore accessibility. Lastly, the functioning of the sensor 
places important restrictions on its placement, e.g. above or in the water. Depending on the 
communication of the warning, cell reception might also be a requirement. 

6.4.1 LOCATION 

Looking at the upper boundary condition determined in Paragraph 2.2 Gauge placement, the minimal 
required distance between the bottleneck and the sensor is determined. And thus a first rough location of 
placement is established. Considering the specific placement methods required by each type of sensor, a 
second constraint on the location is added. Building on this, a couple of characteristics that describes a 
suitable location should be sought: 

 Accessibility to perform maintenance 
 Property of governmental or social institutions with limited access for the general public 
 Access to a power source or enough year round sunlight for a solar panel 
 Possible integration with the existing infrastructure 

In case there are no governmental or social institutions available for the placement of the sensor. The 
option of local involvement should be investigated. This is tricky as often compensation is expected for 
looking after the sensor. Something that might be discontinued when interest or budget changes occur. 
From which one can expect the involved local people to stop caring for the sensor. 

An alternative to the (monthly) compensation is in making some of the members of the local community a 
representative for the sensor. This is an idea that followed from Josiah Kahuthu, working at the KMD office 
of Narok Town. The representative does not receive any financial incentives, but if there is any display of 
functioning, think of a conference, this person is invited and acts as spokesperson. It is a different 
approach to the same involvement of the local community. 

6.4.2 INSTALLATION 

Each type of sensor requires its own placement and installation. Nonetheless, there are some general 
considerations to take into account when looking at the installation of the sensor. Starting with the 
robustness of the sensor and the installation.  

Whether the placement of the sensor takes place on governmental/social institutional grounds, or on 
locally owned land, the construction should be robust and durable. Firstly, it has to withstand all the 
natural forces involved in flash floods while still being able to function properly. Heavy winds or rains are 
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common and should not interfere, especially in the giving out the warning. On top of that the sensor has to 
be temper proof. As case studies learned, they often get stolen. 

A solution might be found in working with rigid materials like steel or concrete. The materials are both 
durable and temper resistant. Which both fulfil the requirements discussed above. Combined with 
placement under for example a bridge, or high up a pole, the chances of the sensor being tempered with 
are further reduced. The downside of this approach is discussed in the next section. 

6.4.3 MAINTENANCE 

Maintenance might be required at any moment throughout the lifespan of the sensor and therefore it 
should be accessible. Using the described rigid materials or placement on an inaccessible location, works 
against the principle of accessibility for maintenance. An option to solve this, is another way of installation, 
based on the principle of “hiding in plain sight”. 

By using everyday items to hide the sensor in, think for example of bee hives, or by placing it on structures 
that people normally do not interfere with, like power lines, the chance of theft can be reduced. This simply 
because people notice the sensor less. 

Each of the installation strategies have their own up- and downsides and they weigh differently in each 
application. It is therefore very important to look into the local context before installing the sensor.  
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APPENDIX A. SPATIAL ANALYSIS OF THE 
CATCHMENT USING QGIS 
INTRODUCTION 

QGIS is a geographic information system (GIS) software that is widely used to analyze and visualize spatial 
information. The software is free and open-source and can be downloaded on Windows, macOS and Linux 
systems.  

By using QGIS, the water system of your location can be analyzed and mapped. The goal of this manual is 
described below. In QGIS, extra attention should be paid to the method of saving and naming the files, 
since this is very important, and a clear overview of the created layers should always be present.  

GOAL OF THIS STEP 

A Digital Elevation Model with a corresponding projection file is also needed as input for the HEC-RAS 
model, which is described later in this manual. By following the steps below, the required files will be 
created, as well as some visualizations and spatial information of the watershed. This is finished after the 
Paragraph Digital Elevation Model. Another goal of this step is to determine the watershed corresponding 
to the flood point of your location, and the watersheds of connected side streams in your river reach. The 
area of these catchments will be calculated. 

REQUIRED HARDWARE 

For this chapter of the manual, only digital data will be processed. The required hardware therefore is a 
laptop or computer, with internet connection.  

REQUIRED SOFTWARE 

The QGIS software can be accessed and downloaded via the website of QGIS, or via their repository. 

The latest version, as noted in October 2024, is QGIS 3.38 (Grenoble). The version used for the steps below 
is QGIS 3.36 (Maidenhead). For any of the QGIS 3 versions, the steps below will be suitable. 2 

  

 

2 QGIS (2024, October). Spatial without compromise: Spatial visualization and decision-making tools for 
everyone. Retrieved from QGIS: https://www.qgis.org/  

http://www.qgis.org/
http://www.github.com/qgis/QGIS
https://www.qgis.org/
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STEP BY STEP INSTRUCTION 

The step by step instruction is subdivided into three parts. First a QGIS project is created and the area of 
interest is selected. In the second part, elevation data is imported and processed. In the third part, 
channels and drainage basins of your area are delineated. 

Many of the steps are based on YouTube videos of Hans van der Kwast, of the IHE Delft Institute for Water 
Education. 3 Multiple other free step-by-step instructions for hydrological applications in QGIS can be 
found on the GIS Open CourseWare. 

AREA OF INTEREST AND PROJECTION FILE 

1. Open the QGIS desktop app on your computer 
2. Click on New Empty Project  
3. In the top bar, go to Quick Map Services, select OSM and then OSM Standard. This will give a 

window of OpenStreetMap on your screen. By hand, zoom in and go to the area of your interest.  

4. Now select a projection zone. Click on the  icon in the bottom bar, which will open the CRS 
tab of the Project Properties interface. Here, select an appropriate Coordinate Reference 
System, preferably a WGS 84 UTM zone. The correct zone for your area can be found on the 
internet. Every Coordinate Reference System also has an EPSG code that corresponds. After 
selecting a WGS UTM zone, the window below will show a red selection of the included part of the 
earth; make sure the purple cross, defining the area you just zoomed into on your window, is inside 
the red selection. Click Apply and OK. 

DIGITAL ELEVATION MODEL 

5. To download elevation data, there are many possibilities, varying over different locations in the 
world. The method that is used in this manual is downloading Shuttle Radar Topography Mission 
(SRTM) data.￼ In QGIS, a plug-in for SRTM data is available. Go to 4 on your top bar and select 
Manage and Install Plugins. Search for SRTM-Downloader and Install Plugin. Now the SRTM-
Downloader should be visible under the Plugins menu.  

 

6. Before you are able to download SRTM data with the plugin, you will need an account. A login menu 
will pop up while you are downloading and will give this link. Here, anyone can create an account 
in order to get access. Do this first, then proceed.  

7. Select SRTM-Downloader under the Plugins menu. A window will open where you can select the 
area of interest. Click on Set canvas extent to download elevation data of the area that you 
zoomed into in step 3. Make sure the entire watershed of interest is included in this canvas extent, 
rather too large than too small. It will download multiple tiles, depending on the size of your area.  
The Output-Path can remain the automatic given option. Make sure the box Load Images to QGIS 

 

3 For all videos, go to https://www.youtube.com/c/hansvanderkwast  
4 USGS (2018, July). Digital Elevation – Shuttle Radar Topography Mission (SRTM) 1 Arc-Second Global. 
Retrieved from USGS science for a changing world: https://www.usgs.gov/centers/eros/science/usgs-
eros-archive-digital-elevation-shuttle-radar-topography-mission-srtm-1  

SRTM is a dataset of NASA and is open-source. The mission of February 2000 managed to cover 
approximately 80% of the Earth's Surface, namely between 60 degrees North and 56 degrees South, at 
a resolution between 30 and 90 meter. Ongeldige bron opgegeven. 

 

 

              
 

                   
             

      

              
    

              
  

 

               
        

http://www.gisopencourseware.org/
https://urs.earthdata.nasa.gov/users/new
https://www.youtube.com/c/hansvanderkwast
https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-shuttle-radar-topography-mission-srtm-1
https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-shuttle-radar-topography-mission-srtm-1
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is selected and click on Download. The different tiles will appear in the layers box in your main 
window as a group called ‘srtm_images’ and will also appear as 1 layer all together.  

8. By selecting the separate tiles identify which tiles you will need to cover the watershed of interest. 
Delete the tiles that are not of interest (right click on tile in layers list and select Remove layer). 
Now mosaic the elevation tiles: from the Raster menu select Miscellaneous, then Build virtual 
raster. As Input layers select the tiles that you want to use, click OK on the right side and then 
uncheck all other boxes in the window. On the right side of the box [Save to temporary file] click 
on the three dots and select Save to file…. Give your file a clear name, for example 
DEM_mosaic.vrt. Now click Run. The new mosaic layer will appear in the list of layers, probably 
called Virtual.  

9. Now reproject this file as a TIFF file. Select the Virtual layer, go to the Layer menu on top and select 
Save as…. Select as Format GeoTIFF in the drop-down menu. Click on the button with three dots 
and give the layer a name, for example DEM_mosaic.tif. Make sure the correct CRS is selected 
that you chose in step 4, then click OK.  

10. Delete all unnecessary layers in the list of layers, except for the TIF file of DEM_mosaic and the 
OSM Standard map.  

11. Make a subset of the elevation layer. From the Raster menu select Extraction and then Clip 
Raster by Extent… As Input layer use the DEM_mosaic layer. Clip a hand drawn box on the screen 

( ) to select approximately the area that you will need, from river source to flood point. Again, 
rather too large than too small. Drawing the box will be easiest on the OpenStreetMap layer, so 
make sure beforehand that this is the upper layer. Via the three dots, Save to file as TIF file, for 
example named DEM_subset.tif. Now click Run. 

12. In the elevation data, there is probably some missing values and so-called sinks, which can occur 
at lakes or other difficult points. The SAGA plug-in is used to fill those sinks in the layer. If SAGA is 
not already in the Processing Toolbox of your QGIS, you first need to install it as a plugin, in a 
similar way as in step 5. Then search for the option Fill sinks (wang & liu) in the Processing 

Toolbox ( ).  As DEM use DEM_subset, keep minimum slope at standard value. We are only 
interested in the Filled DEM option, so here save a file via the three dots, as DEM_filled.sdat, and 
click Run. It might take a while, depending on the size of your area.  

Figure 8: SRTM elevation data downloaded in a QGIS project for Narok county, Kenya 
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13. Again, delete all layers that are no longer required. This is good practice in QGIS, since a clear 
overview of the different layers is important to prevent mistakes. Only keep OSM Standard and 
DEM_filled. 

14. The DEM is now approximately finished. In order to create visualizations of the elevation data, style 
the properties of the layer. Go to the Layer properties menu by double clicking on the DEM_filled 
layer. In Symbology select Singleband pseudocolor as Render type. From the Color ramp drop-
down menu, choose Create new color ramp, in the new window select Catalog: cpt-city. In this 
catalog, under the tab Topography, choose elevation. Choose Apply and OK.  

15.  Create a hillshade layer below the DEM layer to visualize hills. Right click on the layer DEM_filled 
and Duplicate Layer. In the Processing Toolbox, search for Hillshade, use the DEM_filled copy 
as input and click Apply. Right click on the new layer and Save as GeoTIFF file, for example called 
DEM_hillshade.tif. Delete the old layer Hillshade. Now, go to the properties of the new layer 
DEM_hillshade and under Layer Rendering, select Multiply as Blending mode. Choose Apply and 
OK.   

16. As input for the HEC-RAS model, as is described in another chapter, both a TIF file and a 
corresponding projection file (PRJ) are required. For this, we will use the DEM_filled. In the QGIS 
folder on your computer a prj-file will already be present, called DEM_filled.prj. The DEM_filled 
layer is only a sdat-file at the moment. Right click on the layer and choose Export and Save as…. 
As Format, select GeoTIFF, click on the three dots and save the file as DEM_filled_GeoTIFF.tif in 
the same folder as all other layers. Make sure the CRS is the same as you selected in step 4, then 
click OK. Copy the style of the old DEM_filled layer, by right-clicking and selecting Styles and Copy 
style. Right-click on the new DEM_filled_GeoTIFF layer and select Styles and Paste style. 

Figure 9: Result of the step Digital Elevation Model, in QGIS 

DELINEATE STREAMS AND CATCHMENTS 

In QGIS, based on the elevation data, you can delineate the natural streams, as well as the borders of 
(sub)catchments. Depending on the comprehensiveness of the study that you are conducting, you can 
choose whether to follow the steps underneath. The result will be a visualization of the total catchments, 
different sub catchments, for example for side streams connecting to your river reach, together with the 
streams.  
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1. The SAGA plug-in, that is installed in step 12, will again be used in this step. Search in the 
Processing Toolbox for the option Channel network and drainage systems. In the window that 
pops up, use as Elevation the DEM_filled file (not DEM_filled_GeoTIFF), The threshold is based on 
the Strahler order that you want to display. This will depend on the water system that you are 
looking at. Use for example threshold 5 or 6. Keep the box Subbasins selected. We are only 
interested in the channels and drainage basins. For the options Flow Direction [optional], Flow 
Connectivity [optional], Strahler Order [optional], Drainage Basins [optional], and Junctions 
[optional] on Skip Output, via the three dots on the right side. For the options Channels and 
Drainage Basins, choose Save to File and save both as a shapefile (shp) with clear names in the 
general folder for this QGIS project, for example channels.shp and drainagebasins.shp. Then click 
Run. This will take a while, depending on the size of the area of interest. 

 

2. Adjust the channels and drainage basins, as wanted. For the channels, go to the Properties of the 
layer, make the lines blue. For the drainage basins, go to the Properties, choose Categorized at 
the top and then click Classify. All drainage basins will now get a different colour. 

 

3. Now you’ll have many small sub basins However, you are interested in the total watershed from 
the flood point in your area of interest. Use the Coordinate Capture tool to find the coordinates 
of the flood point. This is a plugin, that can be installed via Manage and Install Plugins under the 
Plugins menu. The tool will appear in the bottom left corner, first click Start capture, then select 
the flood point in your screen. The coordinates will stay visible in the box in the corner.  

4. In the Processing Toolbox, you will find the tool Upslope area under the SAGA package. With this 
tool, you are able to delineate the upslope area from a certain point. This will approach the 
watershed area from that point. Copy and paste the coordinates as Target X coordinate and 

Target Y coordinate, use the ( ) coordinates. Use DEM_filled.sdat as Elevation, and save the 
file via the three dots, for example as catchment_floodpoint.sdat. 

5. Select the new layer, go to the Raster menu, to Conversion and choose Polygonize (raster to 
vector). Save the layer as catchment_floodpoint.shp.  

6. Change the Properties as needed. Choose a colour for the shapefile like blue and make the 
Opacity 40%.  

7. The shapefile probably doesn’t consist of only one piece but has many small parts at the edge of 

the watershed. These smaller parts can be deleted via the Attribute Table ( ) of the layer. In 

this table, choose Field Calculator ( ). Select the box Create a new field, give as Output field 

The Strahler stream order is used to define stream size, based on the hierarchy of tributaries. A stream 
is considered as a mathematical tree, where the first stream, coming from the spring, has Strahler 
number 1. When another first order stream connects, the streams together form a stream with Strahler 
number 2. Only when another second order stream connects, the stream will get Strahler number 3. 

The streams that are now delineated, are purely based on elevation data of the terrain. The further 
away from the source, the more this will deviate from the actual stream. Due to human intervention, 
erosion, and many other factors, a stream can change its course. By selecting the channels layer 
together with the OpenStreetMap layer, you can check the accuracy of the defined channels. For our 
purpose, it is not a problem if the channels are a bit of, since it is only used to give an overview of the 
water system and to define the watershed, which will still be correct. In addition, this method will 
always give errors for flat areas and lakes, which will be expressed as straight lines in parallel.  
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name the name Area (m^2). As Expression, type $area in the white box and click OK. Now for 
every attribute of the layer, the area will be shown in the table. By clicking at the top of the column, 
you can order the attributes based on the area. Only keep the large attributes and delete all other 
attributes by selecting them (they will turn yellow with red edges in the main window) and clicking 

Delete selected features ( ). 
8. Repeat steps 3-7 for any side streams that connect to the river reach that you are looking at. First 

select the coordinates at a point in the side stream just a little bit upstream from the junction and 
then create the watershed corresponding to that point. Give these shapefiles a clear name as 
catchment_sidestream1.shp and give them another colour with opacity 40%. Also determine the 
area as described in step 7.  

9. Add labels to the different sub catchments, by going to the Properties of a layer, on the left side 
go to Labels, choose Single label and as Value select Area which you added yourself. Play with 
the Text/Buffer/Placement to get the view as you like. Note that all areas are determined in square 
meters.  

10. Now clip the channel layer to the catchment of the flood point, since this is the only area you are 
interested in. Select the channels layer, and go the Vector menu, select Geoprocessing tools and 
choose Clip. As Input layer, choose the channels.shp, and as Overlay layer choose 
catchment_floodpoint.shp. Save as channels_catchment.shp. 

Figure 10: View of delineated (sub) catchments, with water streams, in QGIS 

11. The same can be done for the Digital Elevation Model. Go to Raster menu, select Extraction and 
choose Clip Raster by Mask Layer. As Input layer choose DEM_filled, as Mask layer choose 
catchment_floodpoint. Specify a NoData value, like 0, save as DEM_catchment.sdat. Copy and 
paste the style of the old DEM_filled layer and apply to this layer. Make all 0-values transparent.  
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HOW TO SAVE A QGIS PROJECT?  

In order to properly save a QGIS project, all layers need to be saved correctly, by using the Save as option. 
Save all layers in 1 folder, and refrain from moving these files once saved.  

Under the Project menu, select Save as and save the QGIS project as a project file on your computer. Give 
the project a clear name, such as [Rivername]-Project.qgz. 

SAVE AS GEOPACKAGE 

In order to save QGIS projects in a more compact manner, and to also be able to share the spatial 
information, a project including all layers and their corresponding files can be saved as a GeoPackage. 
Start with a window displaying the QGIS project, with all layers that you will want to include. There are two 
options: 

1. EXPORTING THE ENTIRE PROJECT  

In the Project menu, select Package Project. Here, select as Format GeoPackage and specify the name 
and location of the file, for example [Rivername]-GeoPackage.gpkg. 

2. EXPORTING LAYERS INDIVIDUALLY TO A GEOPACKAGE 

For each layer, do the following: right-click on the layer in the Layers list, select Export and then Save 
Features As…. In the Format drop-down menu choose GeoPackage. Click on the button with three dots 
and specify a name and location for the GeoPackage, for example [Rivername]-GeoPackage.gpkg. As 
Layer Name specify a name for that layer within the GeoPackage. For clarity, use the same name you were 
already using. Now click OK and repeat for the other layers.  

SAVE LAYER PROPERTIES 

By sharing or moving layer files, the properties of these files can get lost. These properties can include 
coloring, labeling, transparency, etc. To prevent this from getting lost, you can save a layer style separately. 
A saved style can always be loaded into a layer from the computer it is stored on. To save a style, go to 
Layer Properties by double clicking on the layer. At the bottom of the Symbology window, select the Style 
drop-down menu and choose Save Layer Style. Save the style as QGIS QML style file and select a name 
and location via the three dots, for example DEM_style.qml. Click OK.   
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HOW TO EXPORT IMAGES FROM QGIS? 

After gathering and analyzing spatial data in QGIS, you can export this spatial information as maps. These 
maps can include multiple views of the main window, a legend, scale bars, extra blocks and arrows, etc. 
This way you can export the gathered data exactly as you want to.  

CREATING A BASIC PRINT LAYOUT 

1. Under the Project menu, choose New Print Layout. A new window will open, while the main 
window remains open as well. First, you will be asked to give the print layout a name. In this name, 
clarify what you want to show in this print, for example elevation data or catchment delineations 

2. Click Add Map (circle 1 in Figure 11) and create a field on the paper. In this map, automatically the 
view will be given that is also in your main window. In your main window, select the layers you want 
to show and the approximate zoom-level. When a change is made in the main window, this will 
update in the map window.  

3. Add a title to your map, via Add Label (circle 2). The text, font, and size can be added in the window 
in the bottom right corner (Item Layout).  

4. Add a legend to your map, via Add Legend (circle 3). In the bottom right window, you can select 
the layers you want to feature, by deselecting the box Auto update.  

5. For correctness of the map, also add a scale bar via Add Scale bar (circle 4), and a North arrow, 
via Add North Arrow (circle 5). Select a place to place them with your mouse.  

Figure 11: Print Layout window, with circles around the options that will be used in these steps 

EXPANDING THE PRINT LAYOUT 

By following the steps above, a basic map is created. There are many other options available in Print 
Layout, of which an overview is given here.  

 You can include more than 1 map on a print layout, for example including a zoomed-in section. 
Simply add another map and modify the content.  

 Add grids or graticules to help with reading locations. This can be customized as you like, changing 
intervals, line styles, and labels.  

 Add custom shapes, such as rectangles, circles, polylines, arrows, and markers. This can be done 
for decoration, emphasis, or annotating areas of interest. 

5 
4 

2 
3 

1 
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 Add external images such as logos, photos, or other visualizations to the print layout.   
 Insert a table with information. This can be filled with a list of attributes from a layer. 
 You can also add attribute charts, such as bar charts, pie charts, etc.  
 Customize layout settings as you like. As default, the print layout will be given in A4 and landscape-

oriented, but this can be customized. It is also possible to create multi-page layouts.  
 Any element that is placed, can be customized and styled as you like: text styles, fonts, colors, line 

thickness, symbols, etc. Additionally, you can adjust transparency levels and apply blending 
modes.  

EXPORTING A PRINT LAYOUT 

While working on a print layout, make sure to save the project in between. When finished, the print can be 
exported, as image or as PDF. Under the Layout, choose Export as Image or Export as PDF.  As default, 
the name of the print layout will be given to this new file.  

Figure 12: Exported JPG file of a print layout, in QGIS, showing the total catchment of the flood point and two sub 
catchments, with their area in m^2 

If you want to create multiple prints, with a consistent layout, then first create a print layout exactly the 
way you want all to be. In this layout, under the Layout menu, choose Save as Template, and save with a 
clear name in the folder you were using. From the main window of QGIS, add a new print layout. In this new 
blank window, choose Add Items from Template under the Layout menu. Now select the template that 
you created and change anything that needs to be changed. 5 

 

5 There are also sample layouts available online, see https://layout-hub.github.io/  

https://layout-hub.github.io/
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APPENDIX B. INSTALLATION MANUAL 
GNSS RECEIVER 
INTRODUCTION 

This appendix discusses the use of the ArduSimple surveyor kit for cross-sectional and longitudinal river 
profile measurements. The ArduSimple set-up was choses for its ability to provide high-precision GNSS 
positioning affordably. 

For the surveying Post Processing Kinematic (PPK) methods are used. This rather than the more commonly 
used Real Time Kinematic (RTK). The fundamental distinction between PPK and RTK lies in the timing of the 
corrections applied to the data. Where RTK corrects data in real-time (during the measurement process), 
PPK applies these corrections afterwards, during post-processing. This key difference offers greater 
flexibility for fieldwork. With PPK, the base and rover do not need to maintain visual contact, which is 
typically required in RTK setups. Consequently, the distance between the base and rover can extend up to 
15 or 20 kilometres, making PPK particularly advantageous for surveying in challenging terrains. This 
method proved useful for the project in Narok, Kenya. 

 

For more information on PPK and RTK please follow this [LINK]. 

 GOAL OF THIS STEP 

 Hardware installation of the ArduSimple GNSS base and receiver 
 U-Centre Software installation 
 RTKsoftware installation  
 Software set-up on the ArduSimple GNSS 

REQUIRED HARDWARE 

ArduSimple: 

 2x simpleRTK2B Pro [LINK] 
 2x Serial data logger [LINK] 
 1x U-Blox GNSS Multiband antenna ANN-MB-00 [LINK] 
 1x Budget Survey GNSS Multiband antenna (IP66) [LINK] 
 Thread adapter for the Antenna [LINK] 

Other 

 2x USB-A to USB-C cable +/- 0.5 [m] 

Figure 13: Overview Ardusimple setup based on RTK [LINK] 

https://coptrz.com/blog/ppk-or-rtk-which-is-best/#:%7E:text=RTK%20is%20applying%20correction%20to,capturing%20images%20from%20a%20site
https://www.ardusimple.com/product/simplertk2b-pro/
https://www.ardusimple.com/product/serial-datalogger-to-microsd/%22
https://www.ardusimple.com/product/ann-mb-00-ip67/
https://www.ardusimple.com/product/survey-gnss-multiband-antenna/
https://www.ardusimple.com/product/adapter-survey-gnss-multiband-antenna/
https://link.s%5Dpringer.com/article/%5d10.1007/s12517-021-08857-8/figures/1
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REQUIRED SOFTWARE 

 U-Center 
 The installation of U-centre is discussed under “U-centre Installation” 

 RTKconv, RTKpost 
 The installation of RTKconv and RTKpost is discussed under “RTKsoftware Installation” 

STEP BY STEP INSTRUCTION 

1. HARDWARE INSTALLATION ARDUSIMPLE GNSS REVEIVER AND BASE 

1.1. Unpack both simpleRTK2B Pro boards. In the figure below the ports that will be used are circled. 
The corresponding names to the number are given in the list below. In further steps the name and 
number are used as reference. For more information about the board and it’s functioning follow 
this [LINK]. 
 (1) XBEE socket 
 (2) POWER+GPS USB  
 (3) GPS/GNSS Antenna  
 (4) XBEE switch 
 (5) POWER+XBEE USB 

1.2. Both port (2) POWER+GPS USB and port (5) POWER+XBEE USB can serve as power sources. The 
board is designed to seamlessly switch between power supplies without disrupting its operations, 
which is crucial during field measurements. Please ensure to: 

 Always connect your computer to port (2) POWER+GPS USB for communication. 

 Always connect a power source to port (5) POWER+XBEE USB. 

1.3. Make sure (4) XBee switch is set to “XBEE to GPS UART2”. Following the orientation of Figure , the 
switch should be in left position. Do this for both boards. 

Figure 14: Overview of the simpleRTK2B Pro board 

1 

3 

2 

5 

4 

https://www.ardusimple.com/simplertk2b-pro-hookup-guide/
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1.4. Unpack both Serial data loggers. They can be installed directly onto the (1) XBEE socket of the 
simpleRTK2B Pro boards. Make sure all pins of the Serial data logger are connected. See Figure 14 
below for the correct installation and orientation. Do this for both boards.  

1.5. Carefully use a knife to modify the simple RTK2B Pro’s cardboard packaging. Create openings that 
ensure cable access to ports (2) POWER+GPS USB, (3) GPS/GNSS Antenna, and (5) POWER+XBEE 
USB while the lid is closed. Refer to Figure  below for guidance. Do this for both boards. 

1.6. Modify the container holding both the board and the powerbank to allow the antenna cable to be 
routed externally. An example is given in Figure 17. 

Figure 16: Modify the cardboard package 

Figure 17: External routing of the antenna cable 

Figure 15: Correct installation and orientation of the Serial Data logger 

1 

3 

2 5 
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1.7. Remove the Budget Survey GNSS Multiband Antenna (IP66) from its packaging. Connect the 
provided antenna cable to port (3) GPS/GNSS Antenna on the board and to the antenna port on 
the Multiband Antenna. Ensure the board stays within its cardboard packaging. Refer to Figure 16 
for guidance. This configuration will serve as the Rover setup. 

1.8. Remove the U-Blox GNSS Multiband antenna ANN-MB-00 from its packaging. Connect the 
provided antenna cable of the Multiband antenna to port (3) GPS/GNSS Antenna on the board. 
Again ensure the board stays within its cardboard packaging. Refer to Figure 18 for guidance. This 
configuration will serve as the Base setup. 

1.9. The Base and Rover are ready for configuration. Proceed to the next step “U-Center software 
installation”. 

  

Figure 19: Base configuration 

Figure 18: Rover configuration 
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2. U-CENTER SOFTWARE INSTALLATION 

2.1. Open your preferred web browser (e.g., Chrome, Firefox, or Edge). 
2.2. Proceed to the U-Blox website and find the u-center page or follow this [LINK].  
2.3. Click the Download button on the U-Center software page. Please note that there is also an U-

Center 2 version available, this is NOT the one to use.  

2.4. Wait for the download to complete. 
2.5. From your download centre, open the downloaded zip folder. 
2.6. Double click (left button) the u-centre_v24.05.exe file. One might be prompted with an anti-virus 

software message “Do you want to allow this app to make changes to your device?”. Click Yes or 
Run to allow the installer to open. 

2.7. A setup window will appear. The first requesting to select a language. In this demo, English is set 
by clicking the OK button. 

2.8. Click Next on the introduction screen. 
2.9. Read and accept the License Agreement by clicking I Agree. 

2.10. At the “Choose Components” step, make sure “u-center 24.05” and “Drivers” are selected. Then 
click Next. 

2.11. The last step, “Choos Install location”, offers the opportunity to choose an installation folder. 
One is set by default. To change this location click Browse… and find a preferred location. Then 
click Install. 

2.12. Wait for the installation process to finish. 

https://www.u-blox.com/en/product/u-center
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2.13. When the installation is complete, click Finish. The software automatically opens. 
2.14. The software is now ready to install the drivers on the base and rover. Proceed to the next step 

“Configuration of the GNSS Base and Receiver”. 

3. RTKSOFTWARE INSTALLATION 

3.1. Again proceed to your preferred browser (e.g., Chrome, Firefox, Edge). 
3.2. Proceed to GitHub and find the rtklibexplorer page by following this [LINK]. 

3.3. On the GitHub page, under the release note,  “Assets” is found. The “demoX_bXXk.zip” folder 
depicted in light-blue. Depending on the version of the last release the numbers can change. For 
this tutorial the “demo5_b34k.zip” was used. By clicking on the demoX_bXXk.zip the files are 
downloaded.  

3.4. From your download centre open the downloaded .zip folder. By copying the “demoX_bXXk” 
folder inside the .zip folder, relocate the “demoX_bXXk” to a preferred location. 

3.5. Open the folder and check if the following .exe files are present:  
• rtkconv.exe 
• rtk.post.exe 

3.6. Now the required RKTsoftware is installed and ready to use. Proceed to the next step: 
“Configuration of the GNSS Base and Receiver”. 

In case the link to the GitHub page does not work: 

Proceed to this [LINK]. If the link also does not work, the proceed to your preferred search engine (e.g. 
Google, Bing, Ecosia) and paste the following title: 

“How to do Post-Processing Kinematic (PPK) with free software RTKLIB” 

One should be able to find a page with the corresponding title on the Ardusimple website. When 
scrolling down, under “Required software”, RTKLIB GUI app is depicted in light-blue. 

 

            

https://github.com/rtklibexplorer/RTKLIB/releases
https://www.ardusimple.com/how-to-do-post-processing-kinematic-ppk-with-free-software-rtklib/
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4. CONFIGURATION OF THE GNSS BASE AND RECEIVER 

4.1. Make sure the Rover and Base are connected to their antenna’s. See Figure  and Figure  how they 
are properly connected.  

4.2. Place the antenna’s in such a position that they have a good view of the sky for testing 
functionality. 

4.3. Connect the computer to the board of the Base. Use the (2) POWER+GPS USB, this is a USB-C 
type of connection.  

 
4.4. Open u-center. Select the COM port to connect your Base. If all is good, the connection symbol 

will turn green. If the Base does not show, one can restart U-Center. This often resolves the issue. 
Otherwise check the Device Manager of your PC to find the receiver. 

Please note that any software is prone to updates. This manual is written for the current version of the 
software (U-Center v24.5). If any of the following step fails, or if you are in need of further clarification, 
please refer to the following [LINK]. 

 

https://www.ardusimple.com/how-to-configure-ublox-zed-f9p/
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4.5. Check the firmware version of the Base by going to View -> Message View -> UBX -> MON -> VER. 
The firmware is either 1.13 or 1.32. In this case it is 1.32 as seen in the screenshot below. 

 
4.6. Download the Firmware update from this [LINK].  

 
4.7. Open the downloaded zip folder containing the Firmware update. The zip folder should contain a 

“.bin” file. Relocate this file to a preferred location. This file is from now on referred to as the 
“Firmware Update” file. 

  

In case the link to the file does not work: 

This file is found halfway through this [PAGE], under “Firmware version check” the two firmware 
versions are depicted in light-blue. Make sure to download the 1.32 version even if the 1.13 version was 
installed. Click the light-blue button Version 1.32. 

 

https://www.ardusimple.com/wp-content/uploads/2022/09/UBX_F9_100_HPG132.df73486d99374142f3aabf79b7178f48.bin_.zip
https://www.ardusimple.com/how-to-configure-ublox-zed-f9p/
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4.8. Download the base configuration file using the following link: [BASE]. One is redirected to a page 
which should look like this: 

 
Now use Ctrl+A to select all entities. Then copy this selection by using Crtl+C. Open Notepad or 
any other text processor and use Crtl+V to paste all entities. Now save this file as a “.txt” file in the 
same location as the Firmware update from step 4.7. This file is from now on referred to as “Base 
configuration file”. 

4.9. Repeat the same steps for the rover configuration file, found via this link: [ROVER]. The file created 
is from now on referred to as “Rover configuration file”. 

Download the data logger configuration file from this [LINK]. Again, use Crtl+A, Crtl+C, to copy all 
entities and save them as a “.txt” file as described in step 4.8. This file should be saved in the same 
location as the Firmware update and the Base & Rover configuration files. This file is from now on 
referred to as “Data logger configuration file”. 

In case the link to the files does not work: 

The files are found at step 5 on this [PAGE] 

 

In case the link to the files does not work: 

The files are found halfway through this [PAGE], under “Examples of configuration file”. Make sure to 
download the files from the FW 1.32 column. The following files need to be downloaded: 

• Base (column FW 1.32) 
• Rover 1 Hz (column FW 1.32) 

To download the files, click the light-blue File button and then follow step 4.8. 

 

 

https://www.ardusimple.com/wp-content/uploads/2022/09/simpleRTK2B_FW132_Base-00.txt
https://www.ardusimple.com/wp-content/uploads/2022/09/simpleRTK2B_FW132_Rover_1Hz-00.txt
https://www.ardusimple.com/wp-content/uploads/2022/09/simpleRTK2B_FW132_PPK_UART1&2&USB_1Hz-00.txt
https://www.ardusimple.com/how-to-build-a-portable-ppk-data-logger/
https://www.ardusimple.com/how-to-configure-ublox-zed-f9p/
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4.10. Return back to u-center 
4.11. Make sure the Base is (still) connected to the laptop and check if the COM-symbol is green (see 

step 4.4) 
4.12. Change the baudrate which is running in U-Center. Click the downward arrow next to the wave 

symbol . Then select 115’200 and the Magic Wand button. 

 
4.13. Update the Firmware of the Base. Go to Tools -> Firmware Update…. In the pop-up window, 

under “Firmware image” select … and select the firmware update file. Check the box in front of 
“Use this baudrate for update” and choose 115200. Then select GO in the lower left corner. 
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4.14. Load the “Base configuration file” to the receiver. Go to Tools -> Receiver Configuration…. 
Select Generation u-blox Generation 9. Select the “Base configuration file” saved in step 31 by 
using the … button. Then click Transfer file -> GNSS. 

 
4.15. Save the configuration to the Base. Go to View -> Messages View. In the newly opened window 

go to UBX -> CFG (Config) and select Save current configuration. Then click Send. 
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4.16. Load the “Data Logger configuration file” to the receiver. Follow Step 4.15 but remind to upload 
the data logger file. 

4.17. Again save this configuration by repeating Step 4.16. 
4.18. In the menu bar go to View -> Generation 9 Configuration View. For the application in Africa, 

make sure the following Systems and Signal Controls are selected. 
 GPS -> 1C/A & L2C 
 Galleo -> E1 & E5b 
 BeiDou -> B1 & B2 
 GLONASS -> L1 & L2 

Also check RAM and Flash. Then click Send Configuration. 

4.19. In the menu bar go to View -> Messages View. In the pop-up window, right click NMEA and 
choose Disable Child Messages. 
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4.20. Still in the Messages View, go to UBX -> LOG -> CREATE. Make sure “Maximum safe size” is 
selected, and the box in front of “Circular log” is checked. Then click Send. 

 
4.21. Still in the Messages View, go to UBX -> RXM -> RAWX. Right click and choose Enable Message. 
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4.22. Still in the Messages View and under UBX, right click SFRBX (Subframe Data NG) and then click 
Enable Message. 

4.23. Now save the configuration again, following from Step 4.16. 
4.24. The base is now all set! One can remove the power. 
4.25. Connect the Rover to your computer using port (2) POWER+GPS USB. And open U-Center. 
4.26. Redo Step 4.14 till 4.24. Make sure to upload the “Rover Configuration file” in Step 4.15. 
4.27. Both the Base and Rover are ready for field measurements. The nest step (5) discusses how the 

field measurements should be set up. 
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APPENDIX C. FIELDWORK 
PREPARATION 
The execution of fieldwork is an important but time consuming task. Proper preparation of the fieldwork is 
therefore of the essence. This appendix discusses how and where to get the right permissions for 
measurement execution, and what is needed for execution.   

PERMISSIONS FOR MEASURING 

When executing field measurements, one is often always working on land that is owned by others. This can 
be land owned by governmental institutions, businesses, or families. Permission to enter the areas of 
interest are therefore very important to gain in advance.  

The first step is in contacting the governmental institutions. Water management is often governed on many 
different levels, from country to local municipal level. Each with its own governing body or authority. 
Because each country has a different management structure, it is impossible to describe who or which 
authority to contact for each situation. But a nice rule of thumb is: the bigger the river, the less local the 
authority.  

 Before contacting the authorities it is important to have a detailed plan of your fieldwork execution. 
This plan entails the locations of measurement, the timeframe, the way of execution, and the possible 
support required form the authority. Below in Figure 19 an example of visualisation is given. 

 After obtaining the required permissions of the governmental bodies, one can start contacting the other 
landowners, both businesses and families. Doing online research on who the owner of which plot of land 
is, can be quite challenging. Therefore, an alternative approach is recommended: doing a in-person visit of 
the potential measurement sites. By acquainting yourself with the people and businesses one will get a 
good feeling of the possibilities and limitations of the chosen locations. This visit can be combined with 
the Exploration of cross-sections mentioned in Exploration of cross-sections. 

Taking possible language barriers into account, it is advisable to carry a document which discusses the 
intent for measuring in several languages. An example is given below under “Letter for communication”. 

  

Figure 20: Example of visualisation 
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LETTER FOR COMMUNICATION 

The letter is a form of proactive communication. This example contains details about the project, the 
planned measurements, and the permissions gained by governmental institutions. Numbers for contact 
were also provided. In light of language barriers, the example letter was drafted both in English and Swahili, 
see Figures 21 and 22.   

Figure 21: Picture of communication letter, English version 
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Figure 22: Picture of communication letter, Swahili version 
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REQUIRED EQUIPTMENT 

The last step in preparing the fieldwork is in obtaining the right equipment. The list below is indicative, if 
other materials or types of equipment are up for the job, feel free to use those instead. After the equipment 
list some are elaborated on. 

LIST OF EQUIPMENT 

 Rover setup (including SD-card) 
 Base setup (including SD-card) 
 2 Powerbanks (10.000 mAh at least) 
 2x small (lunch) container to hold the simpleRTK2B pro boards 

and their powerbanks 
 Pole for survey GNSS antenna [LINK] (recommended) 
 Surveying tripod 
 Drybag (depicted on the right, Figure ) 
 Rope with half meter markings 
 4x Tent peg [LINK] 
 Water velocity meter 
 Pen and paper 
 Wading boots / swim suit  
 Letter for communication 
 First Aid kit  

ROPE WITH HALF METER MARKINGS & TENT PEG 

During the cross sectional measurements it is important to follow a perpendicular line to the waterbody. 
And perform the measurements at the determined interval, recommended at most half a meter. But this 
of course depends on the scale of the river. This scale also determines the rope length required. Half meter 
marks are made by making small knot in the rope as displayed in Figure  below. The advantage of having a 
knot each half a meter is in the fact that it is also a place to tie the rope down. 

To tie the rope down tent pegs can be used. But also sticks with a sharpened point are more than suitable 
for the job. 

 

 

 

 

Figure 23: Drybag 

Figure 24: Knotted rope 

https://www.ardusimple.com/product/pole-for-survey-gnss-antenna/
https://en.wikipedia.org/wiki/Tent_peg
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WATER VELOCITY METER 

There are many different options in determining the water velocity, all with their own benefits and 
limitations. A flow probe is a more commonly used device and advised in this application. Make sure it has 
height markings to get an accurate overview of the height. Below an example in Figure . 

PERFORM TEST MEASUREMENTS 

Before heading out for any measurements that will be used for the modelling or Manning calculations, it is 
very important to execute mock measurements. By repeating the same mock measurement twice and 
processing the data, one can check for unexpected results. Checking the correct functioning of the 
equipment and execution of the measurement beforehand, saves a lot of time compared to discovering 
irregularities afterwards. An example of a mock measurement is spanning the knotted rope across stretch 
that has some height variations, this does not have to be meters. The GPS can then be used to measure 
the same stretch and the same points over different days. This should of course yield the same results. If 
this is not the case, one should try to trouble shoot. Try to pinpoint whether the problem is hardware or 
software related. The problem can also lie in the way the measurement is executed. Only by playing around 
one can get a good grasp of the problem at hand. 

HEIGHT MEASUREMENT INSTABILITY 

A special case of problems that one can encounter is in the instability of height measurements. This means 
that between two different days, the same measurement returns a different value for the elevation. If after 
troubleshooting the problem remains unsolved, a way of dealing with it is found. This is discussed in 3.5.5 
Slope of the river and should only be executed when the instability in height measurement is encounterd.  

Figure 25: Water probe 
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APPENDIX D. FIELDWORK EXECUTION 
The execution of cross-sectional measurements is a time consuming task. But it should be done with 
precision and care to make sure that all measurements are worthwhile. In this step by step manual a 
fieldwork day is explained per step. All measurements should be executed with at least two people. 

0. PREPARATIONS 

0.1. Arrange transportation, taking into account the terrain surrounding the measurement locations. Do 
note that sometimes off-road (4x4) is required. 

0.2. Collect and pack all materials described under “List of equiptment” in appendix E, don’t forget to 
fully load the power banks. 

0.3. Determine the placement of the Base station. There are two options: leave the base at the home 
station, or set it up each measurement location.  

0.4. Prepare enough water and food. A fieldwork day is physically demanding. 
0.5. Inform involved people where you are planning to go and the expected schedule. In case anything 

goes wrong, others know where to start looking. 

1. ARRIVAL ON MEASUREMENT LOCATION 

1.1. Upon arriving inform the local land owners of your presence. Reconfirm that you have permission to 
enter the premises for execution of the measurement. 

1.2. If possible, inquire about the bankfull state of the river. Otherwise, search for bankfull markings.  
1.3. Based on the determined bankfull state, settle on a proper location for the cross section. It is 

important to keep in mind to take an as undisturbed section as possible. If necessary, also settle on 
a location for the Base. 

1.4. Place the antenna of the rover on the pole and make it lean upright. Make sure the base is placed 
perfectly horizontal on the tripod. 

1.5. Use (5) POWER+XBEE USB port to Power the Rover (and Base) using the battery packs. For the Rover, 
make sure the SD-card is NOT inserted. The base should have the SD-card inserted. Remember that 
both need a clear view of the sky. Set a timer for at least 20 minutes, but preferrable 30 minutes. 

Placement of the Base station: 

The placement of the Base station is measurement specific and can vary between fieldwork days. It is 
therefore important to consider the placement for each measurement day. 

At home station 

Leaving the Base at a predetermined (safe) location with an unobstructed view of the sky is 
advantageous because there is only once the need for calibration. At the day of the fieldwork one 
powers the Base station and leaves it to calibrate. At the end of the measurement day one can unplug 
the Base station. All data is logged on a single file on the SD-card. It is important to note that the 
maximum distance between the Base and Rover is 20 km (as the crow flies). 

At location 

                   
                

            

Calibration time: 

This is the amount of time needed to get a proper fix with cm-level accuracy. The time required can vary 
depending on the cloudiness, location (non or some obstructions), and the amount of satellites. It is 
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1.6. Place the rope perpendicular to the river stream on the determined location. Use the peg’s to tie the 
rope down, this both directly next to the water and at the edges of the bankfull state. See the 
illustration in the Error! Reference source not found. on the next page. 

1.7. Note down the place, date and time of the measurement at the top of the paper. Then describe the 
type of material of the riverbed, if there is telephone reception, and the length of the Rover stick. 

1.8. Once the timer has finished, one can start doing the GPS measurement as described at step 2. If the 
timer has not yet finished one can also choose to do the velocity measurement described in step 5. 

2. GPS MEASUREMENT 

2.1. Wait for the timer to run out, such that the Rover (and Base) had a calibration time of 30 minutes 
with a clear view of the sky. 

2.2. Take the Rover go to the first measurement point. Make sure to hold the rover steady pointed 
towards the sky during the walk. 

2.3. Place the stick vertical at the place of the first measurement. 
2.4. Slide the SD-card into the slot such that the data of the Rover is logged. 
2.5. Place the carton box in the container together with the battery pack. 
2.6. Place the box in the drybag. 
2.7. Start a one minute timer which is on repeat. For example download a interval training app. 
2.8. Wait for the timer, after 1 minute, go to the next measurement point. Again make sure the rover is 

steady and vertical. 
2.9. Repeat the process until the entire cross section is measured. 

2.10. At the last point wait the one minute and then remove the SD-card. Do NOT remove the power. 
2.11. Now perform the Water elevation measurement explained in step 3. 

3. WATER ELEVATION MEASUREMENT 

3.1. Start at the side of the river alongside the rope.  
3.2. Place the rover vertical exactly at the place where the water stops and the land starts. The bottom 

of the stick attached to the rover should be at the same height as the water. 
3.3. Slide the SD-Card back to start logging the measurement. 
3.4. Measure the water height for at least 10 minutes. And then remove the SD-card. 

Figure 26: Visualisation of rope placement 
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3.5. Repeat the measurement on the other bank of the river. Again place the Rover vertical and steady 
at the same level of the water. Don’t forget to slide the SD-card in and out to perform the 
measurement. 

3.6. Now perform the length profile measurement described in step 4. 

4. LENGTH PROFILE 

4.1. Find a place approximately 100 meters upstream. 
4.2. Take the Rover to this place holding it steady and upright. 
4.3. Repeat the water elevation measurement by placing the Rover steady at the same height of the 

water level. 
4.4. Slide the SD-card in to start logging the measurement. 
4.5. Wait for 10 minutes. Then remove the SD-card. 
4.6. Now find a point approximately 100 meters downstream. 
4.7. When walking always keep the Rover steady and upright. 
4.8. Place the Rover again steady and upright at the water level height. 
4.9. Slide in the SD-card to make it log. 

4.10. Wait for 10 minutes. 
4.11. Remove the SD-card and the power of the Rover. 
4.12. If applicable, also remove the power of the Base station. 
4.13. Note down all measurements that were performed and their order. E.g.: 

#1 Cross profile 
#2 Water height left bank 
#3 Water height right bank 
#4 Upstream point 
#5 Downstream point 

5. VELOCITY MEASUREMENT 

5.1. Count the number of knots spanning the entire river. 
5.2. Number all the knots on the peace of paper next to each other. Determine the height interval in which 

the velocity is measured. Note these underneath each other. The essence is to make a table similar 
to the one depicted below. 

5.3. There are four things that can be noted down: 
 X – The measurement is false, the water depth is not sufficient to perform a measurement 
 0 – The water depth is sufficient, but there is no flow 
 Value – The water depth is sufficient and there is a flow measured 
 Blank – All knots between the bankfull state and the start of the water should be left blank 

5.4. Prepare the velocity meter and check the units it is measuring in 
5.5. Now start the measurement at the first knot that is above the water. Note the number of the knot, 

counting from the bankfull state. Leave the numbers lower than this number blank. 
5.6. Execute the water velocity measurement. Note that this measurement can also be a false 

measurement noted by an X. 
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5.7. For each knot try the water velocity measurement. If the first depth, e.g. 5 cm, is successful (zero 
measurement is also considered as successful), then try the deeper depth, e.g. 25 cm. 
Communicate the result: value, zero or false. Keep increasing the depth by the set intervals until the 
bottom is reached and the measurement is false. The other person notes the result down. 

5.8. Continue repeating step 5.7 until you have had all the knots above the water. 

6. FINISH THE MEASUREMENT 

6.1. Check if all measurements are performed. 
6.2. Remove the pegs and the rope from across the river. 
6.3. Pack the Rover (and Base). 
6.4. Remove all thrash.  
6.5. Go back to the mode of transport. 
6.6. Repeat Step 1 to 6 for all measurements executed on the same day. 

7. SLOPE OF THE RIVER 

Only execute this step if the elevation determination of the cross sections contain errors! 

Determine how many measurements are feasible to execute on a single day.  

7.1.  Take into account that the most upstream and downstream locations must be visited. If time allows, 
one is free to add measurements in between for improved accuracy. 

7.2. Revisit Step 0 and make sure all is arranged for a safe and useful measurement in the field; 
7.3. On the day itself, place the base at a secure location and let it log its position for the entire day 
7.4. Arrived at each location, the Rover should calibrate for at least 15 minutes. 
7.5. Try to find the spot where the initial cross section measurement took place. 
7.6. Redo step 3. Measuring the water elevation at both sides of the river. Each side at least 10 minutes. 
7.7. One can consider doing an extra profile measurement (only taking five points) and a water velocity 

measurement for extra model validation. 
7.8. Note all measurements performed down before continuing to the next location. 
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APPENDIX E. RTK SOFTWARE 
PROCESSING 
This appendix discusses the RTK processing software used for post-processing of the logged 
measurements. It is a step by step instruction and builds on the software download executed in Appendix 
B. Before one can start it is important that each log file is recognisable as the measurement itself and that 
the “.TXT” extension is changed to “.ubx”. This is also discussed in 4.1.1  structure. The example given: 

Rover file: 

 LOG00017.TXT  →   Cross_section_3_Profile.ubx 
 LOG00018.TXT →   Cross_section_3_Water_Height_1.ubx 
 LOG00019.TXT →   Cross_section_3_Water_Height_2.ubx 
 LOG00020.TXT →   Cross_section_3_Upstream.ubx 
 LOG00021.TXT →   Cross_section_3_Downstream.ubx 
 LOG00022.TXT →   Cross_section_4_Profile.ubx 
 Etc. 

Base file 

 LOG00003.TXT →   Base_Loc_3.ubx 
 Etc. 

It is important to note that one should NOT use “.UBX” (in capital) extension. This will lead to errors later in 
the process. 

RTKCONV.EXE 

1. With the proper file structure in place, one can proceed and open “rtkconv.exe”. To open double 
click rtkconv.exe. 

2. Within the window select Options 
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3. In the options menu make sure to select the highlighted options below. Pre-selected features that 
are not selected in the image should be deselected. Then hit OK. 

4. Using the … button under RTCM, RCV RAW or RINEX OBS one can select the “.ubx” file of the 
measurement. Then check the boxes in front of the file output “.obs” and “.nav”. The last step is 
to click Convert. The newly generated files are saved in the same location as the “.ubx” file, if you 
want to change this, use the … behind the file output line. 

  

Preferred file_path 

Preferred file_path 

Preferred file_path 
Preferred file_path 

Preferred file_path 

Preferred file_path 

Preferred file_path 

Preferred file_path 

Preferred file_path 
Preferred file_path 
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5. Now click the plot button. A new popup window will load. Similar like the one below. 

6. Here verify that there are observations from all constellations. Green indicates dual frequency 
measurements, yellow is single frequency. GPS observations will be a mix of both. Other things 
to note: 

-> Red ticks indicate cycle slips. Too many of these will make it difficult to get a decent solution.  
-> Gaps in the data usually indicate the receiver lost lock.  
-> If all measurements are grey, please check if a “.nav” as well as a “.pos” file were generated. 
And select Convert again before plotting 
-> Grey bands indicate that they are below the elevation threshold, too many of these means the 
quality of the data is low. In that case it is better to record the logs in a location or time with better 
view of the sky.  

7. Repeat step 4 for all files, including the base files. 
8. When all files are converted into “.obs” and “.nav” files, one can close RTKconv. 

 

Trouble shooting: 

Due to updates to the software it can happen that functionalities change or get lost. As stated at the 
download instruction, “demo5_b34k” was used in this instruction. For updated instructions on the 
functioning of the RTKconv follow this [LINK]. 

 

Preferred file_path 

https://www.ardusimple.com/how-to-generate-rinex-files-with-simplertk2b-for-ppk/
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RTKPOST.EXE  

9. Open “rtkpost.exe” by double clicking rtkpost.exe 
10. Once opened, select Options 

11.  In the first setting screen, select Load…. From the same folder as the “demo5 RTKLIB” 
executables select demo5_m8t_5hz.conf and click open. 

12. After opening the configuration file one is returned to the “Setting 1” page. For Frequencies, make 
sure to select L1+L2/E5b. The other fields should be set correctly, but make sure to check the 
field. Then click Setting 2 page. Here apply Fix and Hold, ON, OFF for “Integer Ambiguity”. Again 
check the other fields, but these should be correct. Then click OK.  
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13. In the main window use … to upload:  
 the “.obs” file of the Rover 
 the “.obs” file of the Base 
 the “.nav” file of the Rover 

Then click Execute to run the solution. The bar at the bottom will show the solution status as it 
runs and will report any errors. You should see a mix of Q=1 and Q=2 as the solution runs. When 
you see done when the conversion is finished. 

  

If only Q=0 is displayed: 

Something is wrong and needs trouble shooting. Go back to the Options window and go to the 
“Output” page. Then select Level3 en then hit OK. Rerun by clicking Execute. Then open the **.trace 
file in the solution folder for additional information. Follow the following [LINK] if further 
troubleshooting is required. 

 

 

Your own file path 

Your own file path 

Your own file path 

https://www.ardusimple.com/how-to-do-post-processing-kinematic-ppk-with-free-software-rtklib/
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14. Click plot to visualize the solution with RTKPLOT 

 Q=1 solution means Fix: accuracy is centimetre level 
 Q=2 means Float: accuracy is submeter level 
 Q=5 solution stands for Single, which is usually meter level 

15. Most of the measurement should have acquired Q1 precision to be able to further process the 
cross section. For this the Python file is required and this is discussed in 4.2 Python Processing. 
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APPENDIX F. PYTHON PROCESSING 
INTRODUCTION 

This Appendix shows how to use the Data Processing package to process the collected data. The 
instruction consists out of four steps: 

1. Selecting the input data. 
2. Generating the output. 
3. Generating the localised slopes.  
4. Process individual cross sections if needed. 

GOAL OF THIS STEP 

 The goal of this step is to process the measurements into usable input for the HEC-RAS model. 

REQUIRED HARDWARE 

 Computer 

REQUIRED SOFTWARE 

 Data Processor package 
 This manual is accompanied by the package, so no further downloading is required. 

 Anaconda Navigator with Jupyter Lab installed 
 Download from the Anaconda site: [LINK] 

STEP BY STEP INSTRUCTION 

SELECTING INPUT DATA 

1. Start by opening the Data Processor package folder. This can be found in the same download folder 
as this manual. The folder structure is shown below. The folder structure is further explained in 
‘README.txt’.           

     
2. Go to INPUT and open ‘input.xlsx’. This is the Excel file in which you provide the input data. It exists 

out of two sheets: ‘Explanation’ and ‘Input’. Make sure you first read the ‘Explanation’ carefully, 
before starting to work with the file.  

3. Fill in the input sheet with the correct filenames for each point. Here, an example of how this should 
look like is given: 

https://www.anaconda.com/products/navigator
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Make sure you use the ‘.’ as decimal sign, otherwise the Python script won’t work.  

4. Copy all the files, which you filled in in the ‘input.xlsx’ file, to the INPUT folder. So based on the 
example above, the INPUT folder should look like this: 

 
5. Double check if all the files that are in the ‘input.xlsx’ are located in the INPUT folder. If this is not 

the case, the Python script won’t be able to find the correct files.  

GENERATING THE OUTPUT 

1. Launch the Anaconda Navigator by searching for ‘Anaconda’ in the search bar.  
2. Within the Anaconda environment, launch Jupyter Lab: 
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3. When in Jupyter Lab, browse through the directory on the left side of your screen and find the Data 
Processor folder.    

 
4. Open the ‘RUN_THIS_NOTEBOOK.ipynb’ notebook from the Data Processor package.  
5. Click on the two arrows in the top left of your screen: 

 

6. Click on ‘Restart’ to run the notebook.     
7. After the notebook is completed, the output files are automatically saved in the OUTPUT folder in 

the Data Processor package:        

 

GENERATING THE LOCALISED SLOPES 

For both the boundary condition of the HEC-RAS model and the evaluation of the Manning equation, the 
localised slope is needed. This sub step explains how to use the Python script, that was designed to do just 
that.  

1. Open the ‘input.xlsx’ file, which can be found under the INPUT folder. 
2. Go to the ‘Local_slopes’ sheet. 
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3. In this sheet, fill in the names of the local slope measurements. For each cross section, three .pos 
files are needed: upstream, downstream and at the location of the cross section. A filled in 
template, should look like the following: 

 
4. Upload all the files, which you wrote down in the previous step, to the INPUT folder. 
5. Repeat steps 1-3 from the GENERATING THE OUTPUT substep.  
6. Open the ‘SLOPE_DETERMINATION.ipynb’ notebook. 
7. Repeat steps 5 and 6 from the GENERATING THE OUTPUT substep.  
8. The Excel file with the localised slopes can be found in the OUTPUT folder with the name 

‘Local_slopes.xlsx’.  

PROCESS INDIVIDUAL CROSS SECTIONS (IF NEEDED) 

Sometimes, the ‘RUN_THIS_NOTEBOOK.ipynb’ is not sufficient for every cross section. It could occur 
that a cross section requires a bit more work, as the cross section shown in the following figure, for 

example:  

As can be seen, the cross profile doesn’t seem to fit that well on the outer parts of the cross section. For 
this reason, the Data Processor package includes a notebook that can be used for individual cross 
sections, namely ‘INDIVIDUAL_CROSS_SECTION.ipynb’.  

1. Make a copy of the ‘INDIVIDUAL_CROSS_SECTION.ipynb’ notebook and open it in Jupyter Lab (in 
the same manner as in step 3 of previous sub step ‘GENERATING THE OUTPUT’). 

2. Repeat steps 2 and 3 of the previous sub step ‘GENERATING OUTPUT’. This will give an error for the 
second code cell, but ignore that one and move on to the next step. 

3. Fill in the required file names and other information in the first code cell, as is done in the 
following figure and click on ‘Import data’.  
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4. Run the second code cell (SHIFT + ENTER) 
5. Run the third code cell (SHIFT + ENTER) and click on ‘Run this cell when data is loaded’.  
6. The data trim tool will show up. This tool allows you to cut of data points at the beginning and the 

end of the dataset. The two accompanying plots will help you to determine the correct cut-off 
points: The red part shows what is cut off the dataset. Once you’re happy with the cut, click on 
‘Cut Dataset’.  

 
 

 
7. Run the remaining two code cells. The output based on the new cross-section is generated and 

stored in the OUTPUT folder of the Data Processor package. Only the hydraulic parameters aren’t 
stored separately. You need to copy them yourself. However, as only the outer parts of the cross 
sections change, the values of the hydraulic parameters will probably be the same as in the excel 
file the previous notebook exported.  
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APPENDIX G. HEC-RAS 
INTRODUCTION 

This Appendix shows the steps that need to be taken to build a one-dimensional hydraulic model in HEC-
RAS. It is subdivided in different aspects of modelling with HEC-RAS:  

 How to start a new project 
 How to create the geometry 
 How to enter the cross-section data 
 How to export geometry data 
 How to specify a steady flow model 
 How to specify an unsteady flow model 

The blue boxes give background information about the specific terminology of HEC-RAS. 

GOAL OF THIS STEP 

 Create a steady and unsteady one-dimensional model in HEC-RAS 
 Finding a correct Manning’s n Value 
 Simulate a flash flood 
 Determine the critical discharge and corresponding warning time 

REQUIRED HARDWARE 

 Computer 

REQUIRED SOFTWARE 

 HEC-RAS (This manual uses HEC-RAS version 6.6) 
 Download HEC-RAS on the following website: 

https://www.hec.usace.army.mil/software/hec-ras/download.aspx 
 If this website is unavailable, search for download HEC-RAS in your search engine and 

download HEC-RAS.  

STEP BY STEP INSTRUCTION 

1. STARTING A NEW PROJECT 

1. Create a folder on your computer named HEC-RAS. Use a directory path of your own choice. Add 
the DEM_filled.tif file and the DEM_filled.prj file that were created in QGIS, see Appendix A.  

2. Open HEC-RAS on your computer. The main HEC-RAS window will show: 

 
3. To start a new project, go to the File menu and select New Project. 

https://www.hec.usace.army.mil/software/hec-ras/download.aspx
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4. Select the drive and path you want to work in by double-clicking the folder you created in step 1 
in the directory box.  

5. Enter a project title and file name. The project file must have the extension “.prj”. 
6. Press OK. 
7. A message box appears with the title of the project and the directory that the project is going to 

be placed in. If the information is correct, press OK.  

8. Select the unit unit system you would like to work in by selecting Unit system (US Customary/SI) 
from the Options menu of the main HEC-RAS window. This manual uses System International 
(Metric System). 

2. GEOMETRY IN RAS MAPPER 

 

1. Click on the View/Edit Geometric Data button.  

2. The Geometric Data window will open. Click on File | Save Geometry Data As. 
3. Enter a title for your geometry file and double-click on the HEC-RAS folder. Press OK. You have 

created a geometry file.  

GEOMETRY IN HEC-RAS OR RAS MAPPER 

The course of the river can be modelled by using the built-in function of HEC-RAS that allows you to 
add a background layer created with web imagery. For this a terrain and a projection file have to be 
added. This manual makes use of OpenStreet Maps. Since OpenStreet Maps takes a long time to load 
in HEC-RAS, the geometry can also be created in RAS Mapper, which is a graphical interface within 
HEC-RAS. This paragraph and paragraph 3 explain the RAS Mapper method. Paragraph 4 explains the 
HEC-RAS method. 
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4. Click on the RAS Mapper button: 

5. The RAS Mapper interface will open as shown below and is comprised of a menu system, data 
layers list, status window and the mapping window. 
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6. Click on Project | Set Projection. The following window will open.  

7. Search for the projection file by clicking on the following button . Choose the projection file 
DEM_filled.prj. It should have the extension ”.prj”. Click on Apply  and OK. 

8. Click on Project in the main RAS Mapper window and select Create New RAS Terrain. 
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9. The New Terrain Layer window will open as shown below. Click on the plus button  to load a 
Digital Elevation Model. Choose the DEM_filled.tif file. 

10. Click on Create. 
11. The Creating Terrain window will open. If the task was completed successfully, the window will 

display “Terrain Complete”. 

12. Click on Project in the main RAS Mapper window and select Add Web Imagery to add 
background imagery. The data is temporarily downloaded from the selected web service and then 
projected to the coordinate system specified in RAS Mapper. Different web services are possible.  
In this manual OpenStreet Maps will be used.   

13. The OpenStreet Maps layer will appear on the RAS Mapper window after clicking on the 
OpenStreet Maps option and pressing OK. 

14. Click on the plus button in the data layers list located in front of Geometries. Right-click on 
Geometry and select Edit Geometry. All the possible layers associated with Geometry appear. 
Now you can start creating the River System Schematic. When selecting a layer it should appear 
in magenta as shown below: 

TERRAIN LAYER AND PROJECTION FILE 

Setting a projection for your project will ensure that the terrain and geometric data are all in a common 
coordinate system. A terrain layer and projection file are not necessary for the purposes of this model 
since all the data is not georeferenced. The data doesn’t consist coordinates. RAS Mapper only allows 
you to load a background layer, such as OpenStreet Maps, if you have created a terrain layer. Therefore, 
a terrain layer and projection file are still applied.  
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15. Select Rivers and make sure the Add New Feature button is selected. You can now start 
drawing the river, beginning from the point where you took your most upstream field 
measurement. It is essential to draw the river in the downstream direction, as HEC-RAS considers 
this the positive flow direction. Follow the river’s course as depicted in the OpenStreet Maps 
layer. For simplicity, model the river as a single reach. Tributaries will be accounted for later.  

16.  Select Cross Sections in the Data Layers List and select the Add New Feature button.  Draw the 
cross sections at the locations of your field measurements. Each cross-section will be 
automatically assigned a river station in RAS Mapper. The values of the river stations can be 
changed later in HEC-RAS. 

 

 

 

 

RIVER SYSTEM SCHEMATIC 

In HEC-RAS, a river is modelled as a sequence of  reaches. The River System Schematic illustrates how 
all the reaches  are interconnected. The reaches are separated by junctions, where tributaries enter or 
exit the main river. Tributaries do not necessarily need to be modelled using junctions. A simpler 
approach is to  model  the river as a single  reach and incorporate  flow change locations, which will be 
explained later on. 

 

RIVER STATIONS 

Each cross-section is assigned a river station, which is a numerical value. This is done on a reach-by-
reach basis. The most upstream cross-section in a reach should be receive the highest river station 
value. River stations do not indicate the exact location of a cross-section within a reach; instead, they 
provide information about its position relative to the other cross-sections on that reach.  
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17. The model should look something like this: 

18. Deselect the OpenStreet Maps layer in the Map Layers group, which can be found in the Data 
Layers List. Only the geometry and the terrain layer will remain visible. Verify if the river aligns 
properly with the Digital Elevation Model.   

19. Click on File in the main RAS Mapper window and click on Save. 
20. Close RAS Mapper. 

3. CROSS-SECTION DATA AFTER CREATING IN RAS MAPPER 

1. Click on the View/Edit geometric data button. 

2. Optional: click on the Select layers to view in background button  and select OpenStreet 
Maps. HEC-RAS will respond more slowly if the OpenStreet Maps layer is loaded, however, it 
provides more visual information. 

3.  To change the values of the river stations click on Tables | Names | River Stations in the 
Geometric Data Editor. The most upstream cross-section of a reach should have the highest 
value. 

4. Now we will add the measured data to each cross section. Click on the Cross section button in 
the left menu of the Geometric Data Editor. The following window will show: 

SLOPE OF THE RIVER 

When using the CSV files generated in chapter 4 as input for the model, HEC-RAS automatically 
computes the corresponding slope. 
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5. Use the drop-down menus to select the River, Reach and River Station of the cross-section to 
which you are adding the data. Then, include a brief description of a feature or landmark that 
characterizes that particular cross-section. 

6. Copy and paste the cross-section data from the CSV file corresponding to that particular cross-
section, which was generated in chapter 4. 

7. If the column n val appears in the Cross Section Coordinates table, it can be deleted by going to 
the options menu and deselecting Horizontal Variation in n Values. 

8. Enter the Manning’s n Values that were found in literature and given in chapter 5.1.1. Enter the 
same value for the LOB, Channel and ROB Manning’s n Values, since the river will be modelled as 
a main channel without a LOB and ROB. 

9. Add the Main Channel Bank Stations. The left bank station should correspond to the lowest 
Station, while the right bank station should correspond to the highest. This way, the river is 
modelled as a channel without a left and right overbank, for simplicity.  

10.  Leave the Cont/Exp Coefficients as they are. 
11. Click on Apply Data. 
12.  Repeat steps 35 to 41 for each cross section. 
13. Click on the File menu of the Geometric Data Editor and click on Safe Geometry Data. 

4. CREATING GEOMETRY IN HEC-RAS WITHOUT OPEN STREET MAPS 

1. Start with the Creating a new project paragraph of this Appendix G except for step 1. 
2. Click on the View/Edit geometric data button. 

3. Click on the Add new River Reach button  to draw the river. Draw the river as a straight line 
and double-click to finish the line. The following screen will show: 

4. Enter a name for the river and the reach. 

5. Click on the Edit and/or create cross-section button . 
6. Click on the Options menu of the Cross Section Data Editor.  

GEOMETRY IN HEC-RAS 

As explained in the preceding paragraph, the geometry can be created in RAS Mapper with a 
background layer. It is also possible to create the geometry in HEC-RAS itself. No background layer is 
used in this case to enhance the reaction rate of the program. It is more difficult to model the course 

               



P a g e  | 91 
 

  
 

7. Click on Add a new Cross Section. The following screen will show: 

 
8. Enter a value for the river station. 
9. Use the drop-down menus to select the River, Reach and River Station of the cross-section to 

which you are adding the data. Then, include a brief description of a feature or landmark that 
characterizes that particular cross-section. 

10.  
a) Copy and paste the cross-section data from the CSV file corresponding to that particular 

cross-section, which was generated in chapter 4. 
b) If you want to model a rectangular cross-section, you don’t need to use the CSV file; you can 

manually enter the Station and Elevation data as needed 
11. Enter the Downstream Reach Lengths. Enter the same value for the LOB, Channel and ROB.  
12. Enter the Manning’s n Values that were found in literature and given in chapter 5.1.1. Enter the 

same value for the LOB, Channel and ROB Manning’s n Values, since the river will be modelled 
as a main channel without a LOB and ROB. 

13. Add the Main Channel Bank Stations. The left bank station should correspond to the lowest 
Station, while the right bank station should correspond to the highest. This way, the river is 
modelled as a channel without a left and right overbank, for simplicity.  

14.  Leave the Cont/Exp Coefficients as they are. 
15.  Click on Apply Data. 
16.  Repeat steps 7 to 15 for each cross section. 
17. Click on the File menu of the Geometric Data Editor and click on Safe Geometry Data. 

5. IMPORT GEOMETRY DATA 

1. Create a new project by following steps 2 to 8 of the paragraph Starting a new project.  
2. Click on the View/Edit geometric data button. 
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3. In the Geometric Data Editor click on File | Import Geometry Data | HEC-RAS format. Double-
click the geometry file that you created in step 2 and 3 of the paragraph Geometry. The following 
screen will appear: 

4. Select SI (metric) units , click on Next. 
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5. In the window illustrated below, click  Next. 

6. The following window appears: 

7. Deselect GIS Cut Lines and HTab Parameters, now click Finished-Import Data. 
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8. Your geometry should now look similar to this: 

 

6. INTERPOLATE CROSS-SECTIONS 

1. Click on the Tools menu of the Geometric Data Editor.  
2. Click on XS Interpolation. 

GIS Cut Lines 

GIS Cut Lines in RAS Mapper are lines used to define specific boundaries within a model, particularly 
for creating cross-sections. They ensure that the model accurately captures the terrain contours and 
river geometry. By deselecting GIS Cut Lines, the model is not georeferenced, meaning it is not linked 
to a specific coordinate system. 

HTab Parameters  

HTab Parameters refers to Hydraulic Table Parameters that define the relationship between flow rate 
and water surface elevation  You should deselect the HTab Parameters option when importing 
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3. Click on Within a Reach. The following window will show: 

4. Select the correct River and Reach for which you want to add interpolated cross-sections. 
5. Define the maximum distance between two cross-sections. 
6. Click on Interpolate XS’s. 
7. Click on Close. 
8. The interpolated cross-sections will be displayed in the geometry. 

7. STEADY FLOW MODEL 

1. Click on the View/Edit Steady Flow Data button  in the main HEC-RAS window. The following 

window will show: 
2. Enter the number of profiles to be computed. A profile indicates a flow data scenario.  
3. Select the desired River, Reach and River Station for which you want to specify the discharge. 
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4. To enter the boundary conditions click on Reach Boundary Conditions. The following window will 
show:  

5. Enter the downstream boundary condition, assuming a  subcritical flow regime as was explained 
in chapter 5. Click on OK. You will probably use either a Known W.S. or the Normal Depth. Use the 
validation measurements as explained in chapter 4. If you model the river with multiple reaches, 
you should specify boundary conditions for each reach. 
 

6. Add the desired discharge in the empty cell  under Profile Names and Flow Rates. 
7. Click Add a flow change location to specify the new discharge of the river at the points where 

tributaries enter (or exit)  the main river.  

ADD A FLOW CHANGE LOCATION 

This is a simplified method for incorporating tributaries into the model. A more detailed approach is 
modelling the tributaries themselves and adding junctions. If you choose this method,  you will need 
at least  two cross-section measurements for each tributary, along with  boundary condition data 
corresponding to those tributaries. Additionally, you need additional information about the junctions, 
such as the junction length. 

 

 KNOWN W.S.  

A known W.S. refers to a known Water Surface level.  

NORMAL DEPTH 

When selecting  this boundary condition, you need to enter an energy slope that will be used to 
calculate the normal depth at that location. If the energy slope is unknown, you can approximate it by 
using either the slope of the water surface or the slope of the channel bed. In this manual the slope of 
the channel bed is used. 

FLOW REGIME 

If the flow regime during the validation measurements was mixed, you should define both the 
downstream and upstream boundary condition. If the flow regime was found to be supercritical, only 
an upstream boundary condition needs to be defined. 
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8. Click on File | Save Flow Data AS, save the data in the folder you are working in and give the file a 
title. 

9. Click on Steady Flow Analysis  to run the steady flow model. The following screen will 
appear: 

 

10. Choose between subcritical, supercritical and a mixed flow regime, based on the conditions 
during the validation measurements. You will likely need to choose a subcritical flow regime. 

11. Select the correct Geometry and  Steady Flow File you have created when following this manual. 
12. Click on Compute and all the calculations will be performed. 
13. Click View | Detailed Output Tables to display the results. 
14. Compare the results, mainly the hydraulic depth and water surface elevation, with the validation 

measurements. 

  

FINDING THE CORRECT MANNING’S N VALUE 

Finding the correct Manning’s n Value is an iterative process. The result of this paragraph functions as 
a starting point. Manning’s n Value will be adjusted at each iteration step until a value is found that 
results in a minimal error between the validation data and the output of the model, mainly the hydraulic 
depth and water surface elevation. 
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8. UNSTEADY FLOW MODEL 

1. Click on the View/Edit unsteady flow data button . The following window will show: 

 
2. Specify the upstream and downstream boundary conditions. The upstream boundary condition is 

defined by a flow hydrograph, while the downstream boundary condition is specified as the normal 
depth. It is important to note that the flow regime does not need to be specified. For each reach, 
an upstream and downstream boundary condition are required when the flow is modelled as 
unsteady. 

 

 

FLOW HYDROGRAPH 

A flow hydrograph is primarily used as an upstream boundary condition. A flow hydrograph specifies 
the change of the discharge during a time interval.  

SIMULATION WITH VALIDATION DATA 

The unsteady flow model will be run using the validation data to ensure it functions correctly. The flow 
hydrograph will be defined using a constant discharge, specifically, the value measured during the 
validation measurements at the most upstream cross-section. The model’s output  will then be 
compared with the validation measurements, mainly the hydraulic depth and water surface elevation.  

SIMULATION OF A FLASH FLOOD 

The goal of the model is to simulate a flash flood in order to determine a critical discharge at the 
upstream boundary that leads to flooding at the flood point, along with the corresponding warning 
time. To achieve this, the discharge specified in the flow hydrograph will be increased until the model 
indicates that water exceeds the banks at the downstream boundary. Once this occurs, the flow 
hydrograph will be defined as follows: the initial value of the flow hydrograph will be set at the discharge 
prior to the rapid rise in water level, and will continue to increase until the critical discharge is reached. 
The simulation time depends on the rate at which the water rises or can be estimated. In this manual, 
the simulation time is estimated to be one hour. 
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3. Click on the Add RS button. This will enable you to add a discharge to the main river to account for 
tributaries. The following window will show: 

 
4. Double-click on the River Station where a tributary enters or leaves the main river. 
5. Click on OK. The following screen will appear: 

  
6. Select the empty cell, click on the boundary condition Lateral Inflow Hydro and enter the 

discharge that either enters or exits the main river due to the tributary. 
7. Click on File | Save Flow Data AS and save the data in the folder you are working in. 
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8. Click on Unsteady Flow Analysis   to run the unsteady flow model. The following screen will 
appear: 

9. Select the following programs to run: Geometry Preprocessor, Unsteady Flow Simulation and Post 
Processor.  

10. Select the correct starting date and time and ending date and time, these should correspond to 
the simulation time specified in the flow hydrograph boundary condition. 

11. Set all the computation settings to 1 minute.  
12. Click on Compute and all the calculations will be performed. 
13. Click View | Detailed Output Tables to display the results. 

9. MINOR LOSS COEFFICIENTS 

1. Click on the View/Edit geometric data button. 
2. Click on the Tables menu in the Geometric Data – Geometry Editor. 
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3. Click on Minor Losses. The following window will show: 

 
4. Enter the correct minor loss coefficients to the corresponding river stations. 

  

MINOR LOSS COEFFICIENTS 

Minor loss coefficients can be used to account for energy losses, such as those occurring at bends. 
HEC-RAS calculates the energy loss by multiplying the minor loss coefficient with the flow velocity 
head. As an approximation, minor loss coefficients for flow in pipes can be used, which can be found 
in literature.  



P a g e  | 102 
 

  
 

APPENDIX H. THEORETICAL 
BACKGROUND HEC-RAS 
INTRODUCTION 

This appendix provides the theoretical background for HEC-RAS. General information is covered in 
Chapter 5, while this section includes additional insights on three specific topics. These details serve as a 
reference document for those looking for more understanding of the program.  

First, an outline of all project files in a HEC-RAS project are given. This outline provides background 
information on the working of the program, which might be valuable if expansion on the model is needed, 
or other changes are wanted. The information is not necessary to be familiar with, before following the 
instructions of Chapter 5 and Appendix G.  

Secondly, an overview of all possibilities regarding generation of output is given. HEC-RAS can provide 
results in many different formats. The needed output for the manual is included in the step-by-step 
instruction. This information serves as extra information if more or different output is requested. 

Thirdly, the application of GIS data in HEC-RAS is elaborated upon. Only a brief overview is given of the 
possibilities, not including clear instructions or defined outcomes. The paragraph is meant to give insights 
in more options of HEC-RAS and RAS-Mapper, which could be valuable when other methods to model the 
river reach are investigated.  

Information for this theoretical appendix is retrieved from the HEC-RAS 5.0 Users Manual. (US Army Corps 
of Engineers - Hydrological Engineering Center, 2016) 

ELEMENTS OF A PROJECT 

A project can include the following types of files, which can only be created through or by the user interface:  

 Plan Files 
Have extension .P01 to .P99, in order of creation. The file contains a description and short identifier 
for the plan, a list of files that are associated with the plan, and a description of all the simulation 
options that were set for the plan. Created by New Plan or Save Plan As from the simulation 
windows. 

 Run Files 
Have extension .R01 to .R99, number associated to plan files. The file contains all of the necessary 
data to perform the computations that are requested by the plan files. The run file contains the 
input to any of the computational engines available in the HEC-RAS system. Generated 
automatically when using the Compute button from the simulation window. 

 Output Files 
Have extension .O01 to .O99, number associated to plan files. The file contains all of the 
computed results from the requested computational engine. File can only be read in the user 
interface.  

 Geometry Files 
Have extension .G01 to .G99, in order of being saved for a particular project. The file contains all 
of the geometric data for the river system that is being analysed: cross-section information, 
hydraulic structure data, coefficients, modelling approach information. A file is created when 
using New Geometry Data or Save Geomery Data As from the Geometric Data window.  
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 Steady Flow Data Files 
Have extension .F01 to .F99, in order of being save for a particular project. The file contains the 
number of profiles to be computed, flow data, and boundary conditions for each reach. A file is 
created when using New Flow Data or Save Flow Data As from the Steady Flow Data window.  

 Unsteady Flow Data Files 
Have extension .U01 to .U99, in order of being save for a particular project. The file contains flow 
hydrographs at the upstream boundaries, starting flow conditions, and downstream boundary 
conditions. A file is created when using New Flow Data or Save Flow Data As from the Unsteady 
Flow Data window. 

 Hydraulic Design Data Files 
Have extension .H01 to .H99, in order of being save for a particular project. The file contains 
information corresponding to the type of hydraulic design calculation that is requested. A file is 
created when using New Hydraulic Design Data or Save Hydraulic Design Data As from the File 
menu of the Hydraulic Design Functions window.  

Not applicable to similar projects are:  

 Quasi-Unsteady Flow Data Files 
 Sediment Data Files 
 Water Quality Data Files 

An overview of the elements and their mutual relations is given in Figure 20 below.  

Figure 27: Schematic of project data files (US Army Corps of Engineers - Hydrological Engineering Center, 2016) 
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GENERATING OUTPUT 

All graphical and tabular output can be displayed on the screen, sent directly to a printer (or plotter), or 
passed through the Windows Clipboard to other software, such as a word-processor or spreadsheet. 

SUMMARY OF VIEWING AND PRINTING RESULTS 

Several output features are available under the View option from the main window: 

 Cross section plots 
 Options here include zoom in, zoom out, full plot, pan, animate, selecting which 

plans/profiles/variables to plot, profiles/variables to plot, velocity distribution, viewing 
interpolated cross-sections, control over the lines/symbols/labels/scaling/grid options. 

 Water surface profile plots 
 General profile plots 
 Rating curve plots 
 X-Y-Z perspective plots 
 Hydrograph plots 
 Hydraulic property tables (only for unsteady flow) 
 Tabular output at specific locations (Detaild Output Tables) 
 Tabular output for many locations (Profile Summary Tables) 
 Summary of errors 
 Warnings 
 Notes 

GRAPHICAL OUTPUT 

Graphical plots can be extracted via the File menu on the plot windows: 

 Send graphical plots directly to whichever printer/plotter you have defined under the Windows 
Print Manager. 

 Send graphical plots to the Windows clipboard and paste them into other programs, such as a 
word-processor.  

 

Figure 28: Example cross-section plot            Figure 29: Example general profile plot 
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TABULAR OUTPUT 

Tabular output is available in two different formats:  

 Detailed Output Table: detailed hydraulic results at a specific cross section location. 
 Elevation, velocity head, slope, discharge, top width, total velocity, maximal depth, flow area, 

n-value, average velocity, wetted perimeter, shear, hydraulic depth, and more. 
 Profile Summary Table: a limited number of hydraulic variables for several cross-sections and 

multiple profiles. There are several standard tables predefined under Tables menu. It is also 
possible to define your own table by specifying what variables you would like to have in a table. 
These specified tables can be saved and selected later as one of the standard tables available to 
the project. 

Figure 31 Example profile output table 

 

 

Figure 30: Example X-Y-Z perspective plot, of a river reach with a 
bridge. You are able to choose the starting and ending location of 
the plot and rotate left or right,  up or down.  The computed water 

surface profiles can be overlaid on top of the cross section 



P a g e  | 106 
 

  
 

VIEWING RESULTS 

Chapter 9 of the HEC-RAS 5.0 Users Manual describes all possible results in more detail. This includes the 
graphical and tabular outputs as mentioned above, and all features within these options. Op pages 9-10 
and 9-11 the steps on sending graphics to the printer or plotter and sending graphics to the windows 
clipboard are described. Page 9-22 includes the steps of sending tables to the printer of sending tables to 
the windows clipboard.  

Some of the output possibilities are further described here.  

PLOTTING VELOCITY DISTRIBUTION OUTPUT 

Velocity distributions can only be plotted at locations where the user has specified that flow distribution 
output is calculated during the computations. To view, first go to a specific cross-section plot and then 
select Velocity Distribution from the Options menu. First, you need to set the minimum velocity, 
maximum velocity and velocity increment for plotting. It is better to let the program use the maximum 
velocity range for plotting. Select Plot Velocity Distribution and press “OK”. Details on the computation 
can be found in chapter 7 and 8 of the HEC-RAS 5.0 Users Manual, or chapter 4 of the Hydraulic Reference 
Manual.  

Figure 32 Example velocity distribution plot 

PLOTTING OTHER VARIABLES IN PROFILE 

Any variable can be selected for a plot from the General Profile Plot option and then using Plot Variables 
under the Options menu. Multiple variables can be plot at the same time, however, be careful with scaling. 
When certain variables are selected, this can be saved as User Defined Plot by Save Plot from the Options 
menu. There are several predefined plots available under the Standard Plots menu at the top of the 
graphic window.  

PLOTTING ONE VARIABLE VERSUS ANOTHER 

The rating curve plotting window has the ability to plot other variables, by choice. Select the X Axis Variable 
and Y Axis Variable from the Options menu of the rating curve plotting window.  
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DETAILED OUTPUT TABLES 

Any cross section can be displayed in a detailed output table by selecting the appropriate river, reach and 
river station from the list boxes at the top of the table. You can also view detailed hydraulic information for 
other types of nodes, by selecting from the Type menu, like culverts, bridges, multiple openings, inline 
structures, lateral structures, storage areas, storage area connections, pump stations, and flow 
distribution in cross sections. 

The table can describe its output on either English or Metric units, no matter the format of the input data. 
Use the Units System for Viewing button.  

PROFILE SUMMARY TABLES 

Examples of possible variables to show in a summary table are: discharge, slope, flow area, top width, 
Froude number, and more. The different standard tables are described on page 9-18 and 9-19 of the HEC-
RAS 5.0 Users Manual. To view one of the types of tables, use the Std. Tables menu on the profiles 
summary table. You can also specify which plans, profiles and reaches to include in the table.  

Interpolated cross-sections can be turned on or off in the table, with the Include Interpolated XS’s button 
from the Options menu. Default is to view all cross-sections, including the interpolated ones.  

Additional to the standard tables, it is possible to create user defined tables, with the Define Table option 
from the Options menu. These are limited to 15 variables. Instructions are described on page 9-20 and 9-
21 of the HEC-RAS 5.0 Users Manual. 

USING GIS DATA IN A HEC-RAS MODEL 

During 1D hydraulic computations, only two-dimensional data is utilized. 3D data can be imported in HEC-
RAS for display purposes. Also, GIS data can be imported for flood inundation maps, via HEC-RAS Mapper. 
Appendix B of the HEC-RAS 5.0 Users Manual describes the file formats used for importing and exporting 
GIS or CADD data.  

Within HEC-RAS, uploading GIS data can also replace the need of having to draw a river reach by hand. The 
program can determine the riverbed based on elevation data and calculate the lengths between cross-
sections and the difference in length between left and right banks in turns. A set-up for this method is 
included at the end of this Appendix. 

More detailed information on using GIS data can be read in Chapter 14 and Appendix B of the HEC-RAS 5.0 
Users Manual. 

ARCGIS EXTENSION 

HEC-GeoRAS, allows a user to write geometric data to a file in the required format for HEC-RAS. Results 
from HEC-RAS can be read in HEC-GeoRAS to perform flood inundation mapping. HEC-GeoRAS is not part 
of the program, but software needs to be downloaded separately and used with ArcGIS.  

GENERAL PROCEDURE FOR UTILIZING GIS/CADD DATA WITH HEC-RAS 

1. Start a New Project form the File menu of the main window.  
2. Go to the Geometric Data editor and import the GIS/CADD data. By selecting Importing 

Geometric Data and then GIS Format from the File menu of the geometric data window.  
 For this step, the GIS/CADD data needs to have been transformed to a text file as according 

to the required format. See Appendix B of the HEC-RAS 5.0 Users Manual. 
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3. Add any additional geometric data that is needed to represent the physical system. 
4. Perform the water surface profile calculations for the desired flow rates.  
5. View the results as a text file using the Export GIS Data option from the File menu of the main 

window.  
6. Import the results file into your GIS/CADD system and develop the floodplain maps for each of the 

profiles.  

Once you are utilizing GIS data in your project, any additional data can be imported directly into an existing 
HEC-RAS geometry file without starting a new project. For example, additional cross sections can be 
placed into the appropriate River and Reach sections of the model as needed.  

GRAPHICAL CROSS SECTION EDITOR 

This is a tool to visualize a cross section and allows to add, delete and modify cross section properties. 
The editor is accessed by the Tools | Graphical Cross Sectional Edit menu. 

Manning’s n value data can be entered using the Tables | Manning n or k values menu.  

UTILIZING A DIGITAL ELEVATION MODEL  

A Digital Elevation Model (DEM) can be loaded in RAS-Mapper, together with a projection file. HEC-RAS is 
capable of defining the riverbed, based on this elevation data.6 One of the major advantages of basing the 
river profile on elevation data, is the ability of HEC-RAS to calculate the reach lengths of the two banks 
itself. This enables the possibility to include the impact of bends and turns in the river flow.  

Challenges in this method are mostly related to the grid size of the elevation data, and its ratio compared 
to the size of the river. SRTM data for example, provides 30 by 30 meter elevation data for almost the whole 
world, but an average river is often smaller than 30 meters. There are tricks to deal with this challenge. For 
example, the grid size of a certain DEM can be made smaller, to 1 by 1 meter. The elevation data with this 
new grid, can be adjusted manually based on measurements. Alternatively, a river can be burned in a DEM, 
with a fixed width and relative depth.7 First adjust the elevation data in a program like QGIS, then upload it 
in HEC-RAS. 

 

 

  

 

6 A clear instruction on how to utilize a Digital Elevation Model as the base of your model is given in the 
following YouTube series: 
https://www.youtube.com/watch?v=BUjF_MGcxYQ&list=PLk_n8Ox5nf3G3SXucyn8XQNtwnByMXrvP   

7  A video of Hans van der Kwast (IHE Delft) explains the method of burning a river in DEM, in: 
https://www.youtube.com/watch?v=ZyM1jnxFamU  

https://www.youtube.com/watch?v=BUjF_MGcxYQ&list=PLk_n8Ox5nf3G3SXucyn8XQNtwnByMXrvP
https://www.youtube.com/watch?v=ZyM1jnxFamU
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APPENDIX I. ALTERNATIVE MANUAL 
COMPUTATIONS 
INTRODUCTION 

This appendix expands upon manual calculations, based on Manning’s equation and the Leopold & 
Haddock method, which can give valuable insights in the flow in a natural open channel, with limited 
required data. The methodology is explained, and results for the case study in the Enkare Narok river, Narok 
Town, Kenya, are given. The results, given in the other document, were not conclusive unfortunately, 
therefore the methodology is not further implemented in this manual. It is appended because we think it is 
a promising method with which you can make valuable estimates of a river flow, without the need of an 
elaborate model. The instructions could serve as a starting point for further elaborations on this subject. 

GOAL OF THIS STEP 

The input for this step is the measured cross-sections, water levels, flow velocity profiles, and slopes per 
measurement point. Firstly, a Manning roughness coefficient will be determined. This is based on 
measured average flow velocities, with corresponding hydraulic radii and slopes. With the determined 
Manning roughness coefficient, discharges for bank full states of the various cross-sections can be 
determined.  

With these bank full state discharges, the relation between geometry characteristics and discharge are 
studied using the Leopold & Haddock method. The objective is to determine non-linear between width and 
discharge, depth and discharge, and velocity and discharge.  

REQUIRED HARDWARE 

A computer is recommended to execute the computations. However, they could also be done manually.  

REQUIRED SOFTWARE 

Software to execute the computations can be Microsoft Excel, or any programme working with Python, like 
Anaconda. The manual comes with a python package, named the “Alternative Manual Computations 
package”, which is the suggested software to use. This package serves as a set up to this alternative 
method and can be used as a guideline for the needed calculations. The package involves two python 
scripts, which use an Excel file as input. For further information, the reader is referred to the package itself, 
which includes a “README.txt” file with a brief instruction. 

STEP BY STEP INSTRUCTION 

The steps are distinguished in two main parts, firstly the application of Manning’s equation, determining 
an adequate Manning’s coefficient for the river, and secondly the application of the Leopold & Haddock 
method. The methodology is not written in a step-by-step way, but in a more theoretical manner.  

MANNING EQUATION 

The Mannings equation is an empirical equation that applies to steady uniform flow in open channels, and 
describes the relation between discharge, flow velocity and channel slope. It was introduced by Robert 
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Manning in 1889, as an alternative for the Chézy equation and is now one of the most commonly used 
equations for open channel flow.  

𝑄𝑄 = �
1
𝑛𝑛
� ∗ 𝐴𝐴 ∗ 𝑅𝑅

2
3 ∗ √𝑆𝑆 

Where 𝑛𝑛 [ 𝑠𝑠

𝑚𝑚�13�
] is the Manning roughness coefficient, 𝐴𝐴 [𝑚𝑚2] is the flow area of a cross section, 𝑅𝑅 [𝑚𝑚] is the 

hydraulic radius and 𝑆𝑆 [𝑚𝑚
𝑚𝑚

] is the slope of the channel bed. 8 

The cross section of the river flow is determined as described in Chapter 3, by measuring elevation and 
coordination points with a GPS system. The hydraulic radius can be calculated based on the cross section 
combined with the measured water level. The hydraulic radius is based on the wetted cross section and 
the wetted perimeter; the surface of the channel that is covered by water. The channel slope is determined 
based on the difference of elevation over a certain length at the cross-section. All required measurements 
and the processing of the data is described in Chapters 3 and 4.   

Since 𝑄𝑄 = 𝑣𝑣 ∗ 𝐴𝐴, the Manning equation can be rewritten to: 

𝑣𝑣 =
1
𝑛𝑛
∗ 𝑅𝑅

2
3 ∗ √𝑆𝑆 

Where 𝑣𝑣 [𝑚𝑚
𝑠𝑠

] is average flow velocity. At cross sections where the water level and the average velocity are 

measured, the Manning roughness coefficient 𝑛𝑛 is the only unknown parameter. It is recommended to only 
use cross-sections that had a natural and undisturbed flow. Calculate 𝑛𝑛 for these cross-sections and take 
the average value as a constant roughness coefficient over the entire river.  

To verify and improve this method, the Manning coefficient should be compared to Manning coefficients in 
literature based on the river bed material. 9 The Manning coefficient ranges approximately between 0.01 
and 0.07 [s/m1/3], and describes the roughness of the river bed. This depends on the material and 
coarseness of the river bed material. The coefficient reduces for smoother riverbeds, such as concrete. 

BANK FULL DISCHARGE 

The determined Manning roughness coefficient 𝑛𝑛 is used as input for the original Manning equation in order 
to determine the bank full discharge at the different cross sections. This is the input for the Leopold & 
Maddock method. The bank full state of a river refers to the water level in a river that stays just between the 
natural levees of the river bank, just not overtopping and flooding the adjacent floodplains. It is in general 
expected that a natural levee of a river is only overtopped between twice per year and once per two years. 
10 The bank full states for all cross-sections can be determined, by looking at signs in the landscape that 
indicate the natural levee and the bank full water level. Examples of indications can be: 11 

 

8 Venutelli (2005). A Constitutive Explanation of Manning’s Formula. Meccanica, Springer. Retrieved from: 
https://link.springer.com/article/10.1007/s11012-005-6529-5  
9 The Manning roughness coefficient is determined for different channel types by Ven Te Chow, in his 
textbook Open Channel Hydraulics, published in 1959. A table can be retrieved from 
https://www.fsl.orst.edu/geowater/FX3/help/8_Hydraulic_Reference/Mannings_n_Tables.htm 
10 Williams (1978). Bank-full discharge of rivers. Water Resources Research, Volume 14, Issue 6. Retrieved 
from: https://doi.org/10.1029/WR014i006p01141  
11  More examples and explanations on how to locate the bank full states can be retrieved from: 
https://www.waterboards.ca.gov/water_issues/programs/swamp/docs/cwt/guidance/413.pdf  

https://link.springer.com/article/10.1007/s11012-005-6529-5
https://www.fsl.orst.edu/geowater/FX3/help/8_Hydraulic_Reference/Mannings_n_Tables.htm
https://doi.org/10.1029/WR014i006p01141
https://www.waterboards.ca.gov/water_issues/programs/swamp/docs/cwt/guidance/413.pdf


P a g e  | 111 
 

  
 

 A change in vegetation at a clear horizontal line 
 A river bank turning flat 
 A change in colour of soil and/or stone, at a clear horizontal line 
 An excavation in the river bank, often with loose hanging roots 

Keep in mind that the bank full water level should be approximately equal at both river banks. Water inlets 
or outlets, or human interference, can distort the natural levees. 

LEOPOLD & MADDOCK METHOD 

Research of Leopold & Maddock in 1953 developed a set of exponential relations between some features 
of the geometry of a natural open surface flow, and the discharge. 12  The geometry is described by the total 
width of the channel 𝑤𝑤, in [𝑚𝑚], the average depth of the channel 𝑑𝑑, in [𝑚𝑚], and the average flow velocity 
over the entire cross section 𝑣𝑣, in [𝑚𝑚

𝑠𝑠
]. The method consists of a set of equations: 

𝑤𝑤 = 𝑎𝑎 ∗ 𝑄𝑄𝑏𝑏 

𝑑𝑑 = 𝑐𝑐 ∗ 𝑄𝑄𝑓𝑓 

𝑣𝑣 = 𝑘𝑘 ∗ 𝑄𝑄𝑚𝑚 

The relation of the parameters 𝑎𝑎, 𝑏𝑏, 𝑐𝑐, 𝑓𝑓, 𝑘𝑘,𝑚𝑚 to the values for width, depth and velocity is described by the 
following set of conditions:  

𝑤𝑤 ∗ 𝑑𝑑 ∗ 𝑣𝑣 = 𝑄𝑄 

𝑏𝑏 + 𝑓𝑓 + 𝑚𝑚 = 1 

𝑎𝑎 ∗ 𝑐𝑐 ∗ 𝑘𝑘 = 1 

By solving the equations above by taking measured values of the geometry and the discharge as input, the 
Leopold parameters can be solved. The 𝑤𝑤,𝑑𝑑, 𝑣𝑣,𝑎𝑎𝑛𝑛𝑑𝑑 𝑄𝑄 of all measured cross sections together give average 
Leopold parameters. The parameters 𝑏𝑏, 𝑓𝑓,𝑎𝑎𝑛𝑛𝑑𝑑 𝑚𝑚  are given by the slope of the relation of a fitted line 
between 𝑤𝑤,𝑑𝑑, 𝑜𝑜𝑜𝑜 𝑣𝑣 and 𝑄𝑄 on a logarithmic scale. If these parameters are known, the values for 𝑎𝑎, 𝑐𝑐,𝑎𝑎𝑛𝑛𝑑𝑑 𝑘𝑘 
can be derived from the set of equations. This method is proposed in the original report of Leopold and 
Maddock. However, it is easier to fit a line for the two unknown parameters per relation in one go. This is 
the method that is executed in the corresponding python script. The set of conditions are used as a check 
on whether the available data was suitable for the method. The initial study of Leopold & Maddock, gave 
average values for the parameters 𝑏𝑏, 𝑓𝑓,𝑎𝑎𝑛𝑛𝑑𝑑 𝑚𝑚  that were found in studying a large variety of rivers in a 
semiarid area: 𝑏𝑏 = 0.26, 𝑓𝑓 = 0.40,𝑚𝑚 = 0.34. (Luna B. Leopold, 1953) In the master thesis of Dorius Le 
Poole, Leopold parameters were determined as well, for the Enkare Narok river. These were based on the 
same method as described in this report, with 5 measured cross sections as input, and a fitted trendline 
through his data points. The found values were: 𝑎𝑎 = 6.16, 𝑐𝑐 = 0.28, 𝑘𝑘 = 0.60, 𝑏𝑏 = 0.32,𝑓𝑓 = 0.39 𝑎𝑎𝑛𝑛𝑑𝑑 𝑚𝑚 =
0.27. (Poole, 2024) 

The discharge that serves as an input, will be calculated using the Manning equation, as described above.  
This will be done based on the bank full capacity that is measured at the different cross sections of the 

 

12  Leopold, Maddock (1953). The Hydraulic Geometry of Stream Channels and Some Physiographic 
Implications. Geological Survey Professional Paper 252. United States Government Printing Office, 
Washington. Retrieved from: https://pubs.usgs.gov/publication/pp252  

https://pubs.usgs.gov/publication/pp252
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Enkare Narok river. When the Leopold parameters are known, the set of equations above can use as a way 
to calculate discharge at any point in the river, based on the geometry of a cross section.  

On the use of the Leopold & Maddock method, lots of successive and elaborating studies have been done. 
In different ways, the method is assumed to be able to give reasonably accurate predictions of discharge 
and is mostly applied in data scarce areas. In cases where the maximum discharge is regarded, such as in 
this report, the hydraulic radius can be used instead of average depth. This is also done in this report. 13 

 

 

13 S. Lawrence Dingman (2006). Analytical derivation of at-a-station hydraulic-geometry relations. Journal 
of Hydrology, Volume 334. Retrieved from: 
https://www.sciencedirect.com/science/article/abs/pii/S0022169406005063?via%3Dihub  

https://www.sciencedirect.com/science/article/abs/pii/S0022169406005063?via%3Dihub
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PREFACE 
This document, together with the “Manual for the implementation of a flood early warning system in small 
urban areas in Africa”, are written as part of the course CEGM3000 Multidisciplinary Project in the MSc 
programmes Civil Engineering and Environmental Engineering of TU Delft. We want to express our gratitude 
to our supervisors, Dr. Ir. Nick van de Giesen and Dr. Ir. Frank Annor.  

The main objective of this multi-disciplinary project is to "design a flood early warning system to reduce the 
impact and damage of flash floods in Narok town, Kenya”. The obtained methodology and findings are used 
to write a manual for the design and implementation of flood early warning systems in similar small urban 
areas in Africa. This manual should be easily readable and is written in a step-by-step manner. The target 
audience is anyone who is concerned about the impact of (flash) floods of rivers in small urban areas in 
Africa, for example municipalities, county governments, water authorities, or meteorological 
departments.  

This document is meant as a guidance next to the manual, and gives an example on how the manual could 
be interpreted on a small town in Africa. The document follows the same structure as the manual. Per 
chapter the results are given and discussed. For some steps, the methodology of the case study deviates 
from the suggested methodology of the manual. In this case, elaboration will be given to the considerations 
that were made. In chapter 1, a description of the flooding problems in Narok Town is given, together with 
a brief analysis of the water system and possible causes for the floods. Chapter 2 will elaborate on 
boundaries of the river system that is accounted for in the FEWS design. This is based on the warning time 
for the system and the identified bottleneck. In this chapter, some other spatial statistics and visuals are 
given as well. In Chapter 3, results are given of the field measurements at the Enkare Narok River. After 
processing, the final results are shown in Chapter 4. Subsequently, the gathered data is processed in a 1D-
flow model, called HEC-RAS. The model is shown and illustrated in Chapter 5. Simulations that were run 
in this model, are given in Chapter 6. Finally, in Chapters 7 and 8, the proposed design and implementation 
method are discussed. For these steps however, only a suggested approach is given. The FEWS is not 
actually implemented in the area. 

This project was carried out in collaboration with TEMBO, an organization focused on closing the 
environmental data gap in Africa. TEMBO’s goal is to create affordable sensor networks that are supported 
by climate services built around them. Currently, their services include Flood Early Warning Systems, 
Water Reservoir Management, and Agricultural Information. TEMBO works closely with TAHMO and TU 
Delft. (TEMBO, 2024) 
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INTRODUCTION 
Narok Town, in the Southwest of Kenya, has a history of frequent flash floods. These floods have a large 
impact on the lives of the inhabitants of Narok, as they cause loss of life and livestock, damage to homes 
and businesses, contamination of water supplies, and social instability. The floods are primarily caused 
by a combination of heavy rains in upstream areas and an inadequate drainage system in town. Although 
efforts have been made to improve Narok's drainage system, challenges are faced due to the substantial 
financial and technical resources required. Given the difficulty of fully preventing flooding, the concept of 
a Flood Early Warning System (FEWS) has been proposed. A warning to the town before a flood will occur, 
can reduce the impact and damage of such a flood.  

Flood early warning systems are not new to the town and the region; already many attempts have been 
made to make such a warning system work, however with limited success. Triggers for early warning 
models may include weather predictions, rainfall measurements, or water level gauges. Currently, none 
of the official warning systems that were designed are still in place. Informal warnings are given through 
personal contacts and rainfall predictions are given through a WhatsApp group, which is managed by the 
Kenyan Meteorological Department. A lack of official and properly maintained warning systems is common 
for small urban areas (<700,000 inhabitants) in Africa, but the utility could be high. Therefore, there is a 
need for affordable, low-maintenance and easy-to-design flood early warning systems for similar riverine 
(flash) floods like the case in Narok Town. (TEMBO Africa, 2024) 

Narok Town, and Narok County, have been subject to similar feasibility studies in recent years. The town 
is located in a valley, and therefore the point of convergence for multiple water streams. The Enkare Narok 
river is the main water stream in this part of the Rift Valley. The source lies at the Mau Escarpment, 
approximately 60 kilometres to the north of Narok Town, and the river drains into the major Ewaso Ngiro 
river. At the border of Kenya and Tanzania, this river drains into Lake Natron. The Enkare Narok river, whose 
name was given by Maasai, meaning ‘dark water’, is a permanent stormwater river with a highly fluctuating 
discharge. In Narok Town, two seasonal rivers drain into the Enkare Narok river. These two rivers are 
channelled in town, and are generally considered the main cause of flooding. The corresponding 
catchments are small, but prone to heavy rains and have a very fast runoff. In both water ways, around 
2020, check dams have been constructed to slow down the water flow, and the channels in town have 
been enlarged. These measures have relieved the flood stress significantly, however the confluence of 
these channels and the main river in town remains a critical flood risk.  

In this study, the implementation of a Flood Early Warning System based on a water level gauge 
approximately 16 kilometres upstream of the identified bottleneck in town has been investigated. The 
study builds upon a master thesis by Dorius Le Poole (TU Delft), who identified the bottleneck and the flood 
point in town.  
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1. INVESTIGATE THE FLOODING 
PROBLEM 
The initial study is divided into a couple of steps, that are described below. The results are given per 
intermediary step. The chapter is concluded with a list of questions, that are answered by the combination 
of all information gathered.  

1.1 FIRST ENVIRONMENTAL ANALYSIS 

The Enkare Narok river originates in the Mau Escarpment, about 60 kilometer North of Narok Town, Narok 
County, Kenya. This escarpment is a steep natural rampart that rises up to 3000 meter above sea level. The 
Mau is known for its rich Mau Forest and nutritious soil. In Figure 1, the watershed of the Enkare Narok river 
is colored orange and placed in its surroundings, ending in Narok Town. According to Hydrosheds, an open 
database offering various hydrographic data products like catchment boundaries, river networks, and 
lakes, the drawn watershed has a total area of 950 km2 (HydroSHEDS, 2024). The Enkare Narok river is a 
permanent river and flows downstream into the Ewaso Ngiro river, which enters Tanzania at Lake Natron.  

Figure 1: Catchment area of Enkare Narok river (OpenStreetMap, 2024), (HydroSHEDS, 2024) 

Following Enkare Narok river from Narok Town upstream, you will come upon some junctions, splitting the 
river into smaller rivers. Figure 2 shows the first junction upstream from Narok Town. This study will follow 
the main river, the left one of the two waterways. However, water intake from this right waterway will need 
to be included in modelling the discharge along the river. In this eastern waterway, a bridge is found, which 
acts as a bottleneck for this water system. In case of high discharge, the surrounding area floods at this 
point. At the junction, also a water factory is located, tapping water from the river. The quantity is not known 
from this drinking water source. Looking at the figure, it is noticeable that the river meanders a lot, leading 
to many (sharp) turns in the waterway. Coming into town, the river follows a more straight path.  
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Figure 2: Enkare Narok river flow upstream from Narok Town (OpenStreetMap, 2024) 

In Figure 3 it can be seen how the river runs as it flows into the Central Business District of Narok Town. 
Notice here that two drainage channels enter the river in the center of the town. Below the entry of the 
drainage channels, the river is crossed by two bridges. These two bridges are formed by first the B3 
Kaplong-Narok-Maai Road and secondly a smaller nameless road next to it. Additionaly, a pedestrian 
bridge crosses the river next to the first bridge.  

Figure 3: Enkare Narok river flow in Narok Town (OpenStreetMap) 

1.2 LOCAL AUTHORITIES 

In Narok County, Kenya, there are various authorities concerned with water management and flood risk. 
Some of these authorities are described in this paragraph. 

1.2.1 KENYA METEOROLOGICAL DEPARTMENT 

As part of the Ministry of Environment and Forestry, the Kenya Meteorological Department (KMD) is 
responsible for the provision of meteorological and climatological services, to agriculture, forestry, water 
resources management, civil aviation and the private sector. The KMD is located in Nairobi, and has 
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various smaller offices over the country. Their findings can be found on their website, are shared to certain 
organizations, and are shared by means of posts on X. They give out daily, 5-day, 7-day, monthly, and 
seasonal weather forecasts, as well as weather advisories and alerts. In Narok Town, a KMD office is 
located as well. Here, meteorological measurements are taken hourly, 24 hours a day. The KMD of Narok 
maintains a WhatsApp group, sharing rainfall forecasts, for Narok County. Many business owners, 
farmers, and residents are part of this WhatsApp group, which exceeds a number of 500 members. No 
flood alerts are given in this group, since this is highly variable spatially. Additional to the measurements 
of the KMD, also TAHMO stations are included in their analyses.  

The major cause of the floods is considered to be heavy rainfall, during one of the rain periods. March until 
May is considered the period of long rains, when most of the average annual rainfall occurs. October until 
December is considered the period of short rains. Intensity of these rain periods vary per year, and are 
influenced by global phenomena such as El Niño. (Kahuthu, 2024) (Kenya Meteorological Department, 
2024) 

1.2.2 WATER RESOURCES AUTHORITY 

Under the Water Act of 2016, the Water Resources Authority (WRA) was established, succeeding the Water 
Resources Management Authority (WRMA), which had been in existence since the Water Act of 2002. The 
mission of the WRA is “to effectively regulate the management of water resources in partnership with 
stakehoders”. The WRA offers a chart of services, which can be ordered by various stakeholders. Some 
services are free of charge, and some not. The Water Resources Authority collaborates with many 
internationally funded and organized projects as well. For example, the Horn of Africa-Groundwater for 
Resilience Project by the World Bank, the Blue Deal Programme of the Dutch Ministry of Foreign Affairs, 
and the TWENDE project (Water Resources Authority, 2024). 

In Narok Town, an office of the WRA is located as well. The WRA is the authority of all public water systems 
such as the Enkare Narok river and therefore should be included and informed in any research done in the 
river. The WRA offered their knowledge on the flooding problems, and also lent some materials.  

1.2.3 MAASAI MARA UNIVERSITY 

Narok Town is the home of Maasai Mara University, which was founded in 2008, as Narok University 
College. The institute was chartered as a fully-fledged university on 2013. Over the last years, the university 
has grown a lot, and has also expanded their buildings. There are approximately 12,000 students, of whom 
most are undergraduates. The university has six schools, including the School of Natural Resources which 
corresponds most to the subject if this project. (Maasai Mara University, 2024) 

The university appeared to be very much open for collaboration, and eager to share knowledge of the 
surroundings. They shared with us knowledge on the land type and land use of Narok County, as well as 
their ideas on the main causes of floodings in town and already taken measurements.  

In the north of the county, the Mau forest functions as an important resource, as well as agriculture, with 
crops like carrots, cabbages, and potatoes. In the southern part, livestock is the most important resource. 
The southern part is a lot drier, and for a large part covered by the Maasai Mara National Park. Narok Town 
is located in a depression, which makes it very vulnerable to floods. Besides the location of the town, the 
contribution of the two sub catchments are also considered to be main causes of flooding, due to the large 
and very fast runoff of the drylands just above Narok Town. Although the river is very dangerous according 
to the university, it is not necessarily the main water source of floods.  

The university emphasized the importance of empirical research and to include many stakeholders, like 
the National Forest Service and the National Disaster Management Authority. Flood risk and flood 



P a g e  | 8 
 

 
 

warnings for local areas are handled on a provincial level. There are also some measurements already 
taken by the County, namely the implementation of check dams and improved channels in town. 
(Mabwoga, 2024) 

1.2.5 FINDINGS AND CONCLUSIONS 

For the implementation of a Flood Early Warning System the Kenya Meteorological Department and the 
Water Resources Authority are the main stakeholders which need to be informed and involved. Their 
knowledge of the river and weather system are highly valuable. Additionally, will their help be needed for 
the actual implementation of a Flood Early Warning System. Mainly the KMD is traditionally responsible for 
flood warnings. Maasai Mara University has contributed in knowledge, and offered insights in the local 
stakeholders in general. Involvement of an educational institute is not essential.  

Conclusions on the main causes of the floods in Narok Town were not unanimous. Further study will be 
done on this subject based on literature research.  

1.3 LOCAL COMMUNITY 

A round in town has been made to identify experiences with floods in town, the expected need of an early 
warning system, the warning time that would be appreciated, and to quantify damage caused by floods.  

The flood prone area in Narok Town covers mainly the Central Business District. In this area almost no 
residents are found, it mainly includes small businesses such as car garages and small shops.  

Some of the owners of small shops in the flood prone area stated that the only reaction on a flood warning 
would be to flee to higher grounds. No valuable possessions would be taken with them, besides possibly 
a motorcycle or car. The main motivation for this response is the lack of truly valuable material in the shop, 
and the experience that the water levels will not surpass knee-level. The main concern is loss of life. A 
corresponding warning time mentioned by these stakeholders is 30 minutes, up to 1 hour. Some of the 
interviewees stated as well that a formal system would not be necessary. A flood is preceded by rising 
water levels in the drainage systems and warning is given by shouting in the streets and by contacts living 
further upstream. This gives sufficient warning. Furthermore would it be important that warnings are 
accurate, and the meaning is well communicated. If a false warning is given, trust is easily lost.  

Right at the river bank, two tree nurseries are located. One of the owners is interviewed on her experiences. 
She stated that being so close to the river bank, damage can be substantial. A flood can come very sudden, 
and water will flow from many directions towards their property. A warning could be very valuable, with an 
emphasis on the accuracy of this warning. A corresponding warning time would be 2 hours, up to 1 day.  

Another response given by various interviewees is a concern about the new check dams that are 
constructed just north of town. In 2024, the long rains were extremely intensive, and a fear was spread that 
one of the dams could break.  

1.4 LITERATURE STUDY 

A literature study was conducted, mostly appending to the found results of other sources. The findings are 
structured per subject. Firstly, the sub catchments draining into the channels that run through town are 
further illustrated. Subsequently, the influence of heavy rainfall upstream and deforestation is discussed. 
Existing warning methods are elaborated upon in Paragraphs 1.4.4. In Paragraph 1.4.5, studies on local 
critical precipitation amounts for flood risk in Narok Town are discussed. 

1.4.1 ESAMBURMBUR AND KAKIA CATCHMENTS  
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As mentioned above, two major drainage channels run through town and drain into the Enkare Narok river. 
These two channels are formed by drainage water coming from the Esamburmbur and Kakia catchments, 
northeast from Narok Town. The catchments cover an area of 15 km2 and 30 km2 respectively. The 
channels are considered to be seasonal rivers, only containing water during rain seasons. (Mossel, 2020) 
Upon entering the central business district of Narok Town, both waterways are contained within concrete 
channel beds. These channels streamline the water flowing through the center of town towards the Enkare 
Narok river. The channels are crossed by multiple bridges.  

The two sub catchments are dry lands, with low infiltration capacities. This leads to high runoff coefficients 
and therefore fast and high discharge in the streams. In case of intensive rainfall, flash floods can form 
within the streams, causing the contribution of these two streams to the main river to be significant, 
increasing the risk of flooding. Over time, land use and land cover shifted towards increased agricultual 
and urban development in the Kakia and Esamburmbur subcatchments. This shift further reduced the 
soil's infiltration rate and hydraulic conductivity, resulting in more runoff. (Etienne Umukiza J. M., 2021) 

In a study to implement flood risk reducing measures, it was concluded that the Kakia channel had 
irregular height and width due to constructions that were placed throughout the canal, extending from 
upstream to downstream. Regarding the Esamburmbur channel, it was noted that the bridge's location 
caused the channel to narrow downstream and the banks to get lower. The channel's free flow is impacted 
by the changes in geometry, which could result in overflow in the channel's narrower section. The 
respective total lengths for Kakia and Esamburmbur were determined to be 1420 m and 360 m. (Etienne 
Umukiza J. M., 2022) 

 

1.4.2 DEFORESTATION AND HEAVY RAINFALL IN THE MAU FOREST    

In the Rift Valley in Kenya, the Mau Forest is located, north of Narok Town. This forest complex is 
considered the largest indigenous montane forest in East Africa, with an area of 273,300 hectares. The 
region also forms the largest drainage basin in Kenya, and is the source of multiple rivers, among which the 
Enkare Narok river, later on draining to the Southern Ewaso Ngiro river. (Wikipedia, 2024) 

In Kenya, land is a very important resource, getting more valuable over time. The Mau Forest, which has 
very rich soil and rich wood resources, has been subject to deforestation for logging, and for area clearance 
for settlement and for agriculture. This process is not beneficial for the risk of floods as trees absorb large 
amounts of water. With deforestation, less water is absorbed, thus increasing the runoff and discharge in 
the Enkare-Narok river, increasing the risk of flooding. The severity and frequency of floodings increases 
because of this change in land use upstream of the Enkare-Narok river. Due to global warming, the intensity 
of rainfall has increased, further raising the risk of floods. 

1.4.3 EXISTING LOCAL WARNING SYSTEMS 

In Narok County, stakeholders  receive flood early warning information from various sources and types. 
This early warning information includes weather forecasts, inundation maps, advisories and alerts, and 
indigenous flood information. In terms of available knowledge, is prediction data from the Kenya 
Meteorological Department the major source, accounting for almost 50% of the data, indigenous and local 
knowledge follow with 17%. In terms of flood early warning information, the sources include Kenya 
Meteorological Department, Water Resources Authority, National Disaster Operation Centre, County 
Commission’s office, County Government and Red Cross. Kenya Meteorological is the major source of 
flood early warning information followed by Water Resources Authority. (World Bank, 2021) 
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Inhabitants of Narok County receive the warnings  through radio (57%), TV (17%), social media (11%), 
friends (9%) and social gatherings (6%). WhatsApp is one of the channels used to communicate 
information about impending flooding to other county-relevant government entities. The Kenya Red Cross, 
the county disaster management unit, and other pertinent county officials also spread the early warning 
information to the community. Community meetings (Barazas), which are arranged by chiefs and assistant 
chiefs, are also a noteworthy additional means by which flood information is communicated in Narok 
County.  

Key informant interviews show that only 67% of relevant institutions and department received flood early 
warning information for March-April-May 2018 flood events. This indicates the need for an effective and 
efficient communication strategy that aims on improving the knowledge and building support for flood 
early warning communication. Based on the stakeholders’ needs, timely communication (more than 7 
days before flood occurrence) of flood early warning information will help in mitigating flood impacts since 
more time will be available to take flood early actions such as relocation to higher grounds. (World Bank, 
2021) 

1.4.4 FLOOD PRONE AREA IN NAROK TOWN 

It was already found that especially the Central Business District of Narok was prone to floods. This is the 
lowest part of town and also the junction of the main river and the two channels. A study by Dorius Le Poole, 
for his MSc thesis at TU Delft, concluded on the main bottleneck, the flood point and estimated flooded 
areas for different flash floods.  He concluded that a bridge was the main bottleneck, due to the narrowing 
in the river bed and a limited water level depth. Approximately 400 meters upstream of the bridge, the 
channels drain to the river. Just after this junction, the flood point was identified. At this point, the banks 
are the lowest and high water levels are reached due to the combination of both the addition of the 
discharge of the channels and the backwater curve caused by the bridge. Le Poole modelled the 
occurrence of flash floods in this small river reach by using SFINCS, for different peak discharges.  In his 
model, different time series of discharge were simulated. Firstly, constant discharges, ranging from 30 to 
160 m3/s for a period of 4 hours were used as input, not resulting in floods. Subsequently, a flash flood was 
simulated, starting at a base river discharge of 30 m3/s, going up and down in steps of 30 minutes over a 
total period of 4 hours, to either 170 m3/s, 180 m3/s, 190 m3/s, 200 m3/s, 210 m3/s, 220 m3/s, 230 m3/s or 
420 m3/s. All scenarios led to flooding in town. The results are shown below, in Figure 4. The blue parts 
indicate land overflow, with a grid of 30 by 30 meter. These discharges were selected, since Le Poole 
determined the maximum discharge of the natural bank flow conditions upstream of his river reach to be 
230 m3/s, and downstream of his river reach 420 m3/s. (Poole, 2024) 

Figure 4: Simulated floodplains in Narok Town. Discharge input is given at the black arrows 1, 2, and 3, for the river and the two 
channels. The flood point is concluded to be at red point 2, and the bottleneck at point 4. (Poole, 2024) 

 



P a g e  | 11 
 

 
 

1.4.5 CRITICAL PRECIPITATION AMOUNTS 

By comparing historical data on rainfall measurements, to recorded flood events, conclusions can be 
drawn on critical precipitation amounts that cause flood risk.  

A statistical flood frequency analysis in 2019, analysed past major flood events by identifying rainfall return 
periods on these days. In January 1993, a daily rainfall of 81.7 mm, corresponding to a return period of 6 
years, led to a major flood in town. In March 2013, April 2013, and April 2015, daily rainfall amounts with 
return periods of 1 year, of respectively 33.6 mm, 24.4 mm and 33.2 mm were measured, which also led to 
flood events. Additionally, it was concluded that flood risk not only depends on daily rainfall on the day 
itself, but is also influenced by the cumulative rainfall over the three days before. (Eva Audrey Yessito 
Houessou-Dossou, 2019) 

A study by TEMBO on Narok County states that accumulated rainfall of 20 mm in 24 hours causes no risk 
for flooding. Rainfall amounts between 20 and 50 mm are considered to have a medium risk, while rainfall 
amount exceeding 50 mm are considered to indicate a high flood risk. (TEMBO Africa, 2024) 

1.5 MEDIA SOURCES 
In local media, past flood events have been reported upon, stating damage, casualties and the causes. 
Additionally, videos of flash floods flowing through town can be found on YouTube. Historical flood events 
that are found in media sources, are listed in Paragraph 1.5.1. Some risk-reducing measures have been 
made in the Kakia and Esamburmbur catchments, just north of Narok Town, which are also reported in 
local media. This is described in Paragraph 1.5.2.  

1.5.1 PAST FLOOD EVENTS 

Past flood events were found on the following dates: January 20th 1993, March 30th 2013, April 18th 2013, 
April 28th 2015, May 6th 2015, January 26th 2020, April 3rd 2023 and December 6th 2023. This list of events is 
combined of multiple sources. In April/May 2015 exact dates are not found to be conclusive, this is due to 
high daily rainfall amounts for many days in a row, leading to multiple floods in this period. (Eva Audrey 
Yessito Houessou-Dossou, 2019) (World Bank, 2021) (Sayagie, 2015) (Citizen TV Kenya, 2020) (Nation, 
2023) (NTV Team, 2023) 

1.5.2 CURRENT FLOOD RISK-REDUCING MEASURES  

Two check dams have been constructed near Narok town to reduce the frequent flooding in the town, 
Mukuru mbili and Oloipito Ilmasharian dam. A check dam is a construction with the goal to reduce the flow 
velocity and soil erosion, while also contributing to groundwater recharge. Locals are scared that the check 
dams will overflow during heavy rainfall or even worse, break. Several mitigation measures have been 
carried out to prevent failure.  (Kirui, 2024)  

The construction of Osonini Check dam is ongoing while five more check dams have been proposed along 
rivers Esampurmpur and Kakiya to reduce floods in Narok.  (National Water Harvesting & Storage Authority, 
2024) 

1.6 CONCLUSION 

A short answer is provided on the questions defined in the “Manual for the implementation of a flood early 
warning system in small urban areas in Africa”. This functions as a summary of information retrieved by 
different sources and already described in this Chapter.  

 Where do the floodings occur? 



P a g e  | 12 
 

 
 

Floodings occur in the centre of Narok Town, just north of the bridge and south of the junction with the 
channels, on the east side of the river. The flood plain covers an estimated area of 18000 m2 approximately. 

 What is the impact of the floodings? 

Narok Town has experienced flash floods approximately every 5 years over the last decades. An exact 
number of casualties is not known, but is assumed to be 1 to 5 persons. Additionally, a lot of cattle has 
been lost during floods. Damage includes damage to properties, household contents, valuables in shops, 
damage to infrastructure, and loss of market goods. In most of the region, water levels will rise to knee-
height. Therefore, the damage mentioned is limited. However, flow velocities of the floods can get rather 
high, sweeping away cattle and property.  

 What is the frequency of the floodings? 

Floodings can either occur during the ‘short rains’ season, or during the ‘long rains’ season. Together, this 
period accounts for a period of about 5 months. Historically, major flood events occurred in Narok Town 
every 5 years. In Narok County, floods occur yearly.  

 What are the conditions in which floodings occur? (e.g. heavy rains?) 

Floods occur in Narok Town due to heavy rainfall north of the town. Two areas are considered major 
contributions; the Mau Forest, and a dryland area of approximately 45 km2, right north of town. High rainfall 
amounts in these two regions can indicate flood risk for Narok Town. Additionally, high daily rainfall over 
consecutive days increases flood risk.  

 Are there any external factors that can influence the occurrence of floods, e.g. side channels or 
the presence of dams and levees? 

Two channels drain into the Enkare Narok river right in town. These channels are have two seasonal rivers 
as supply, draining rainfall of catchments of 15 and 30 km2. Their discharge is a substantial contributor to 
the discharge in the river. Further upstream, about 6 kilometres upstream from the bridge, another side 
stream contributes to the river. At this same junction, a water factory is located, tapping water from the 
river to produce drinking water. The quantity is unknown.  

Upstream in the two channels that flow through town, check dams have been constructed. These 
structures collect water temporarily, to decrease flow velocity and increase ground infiltration. These 
dams could break at high discharges, which would cause major flash floods in the direction of Narok Town. 
This flood risk would not be included in the Flood Early Warning System as proposed in this project, which 
will only measure water levels in the main river, and not in these channels. 

 What are the main stakeholders concerning water management and rainfall predictions? 

The main stakeholder is the Kenya Meteorological Department, which is traditionally responsible for flood 
warnings and already maintains multiple (simple) warning systems in Narok County. Secondly, the Water 
Resources Authority needs to be included in the design steps needed to implement a FEWS. For this, 
measurements need to be made in the river, which the WRA would like to be aware of.  

 Have any measures been taken to prevent the floods and what is their effectiveness? 

For flash floods in the two channels flowing through town, multiple prevention measures have been taken. 
Firstly, the water ways have been channelled in concrete beds, upon entering the centre of town. In the 
last decade, these channels have been further deepened and widened to give more space to the water. 
Upstream in these same channels, check dams have been constructed, which aim to slow down the water 
flow and a the same time increase groundwater infiltration.  
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 Do local residents already have a sort of warning system in place (e.g. through WhatsApp) and how 
does this function? 

At the moment, a flood warning is given to residents in various ways. First of all, floods are expected when 
the water levels rise quickly in the drainage channels in town. Shouting through the streets will follow when 
a flash flood in the main channels is identified. This will warn people and cause them to run from the lowest 
parts of town to higher grounds. Additionally, personal contacts in upstream areas give warnings to 
residents in town, when high rainfall amounts are experienced. The KMD maintains a communication 
channel for rainfall predictions via WhatsApp, where forecasts are shared and different stakeholders can 
communicate about water levels and flood risk.  

With all findings that are described in this Chapter considered, the need for a Flood Early Warning System 
is considered valuable. The certainty and warning time of the warning system are important characteristics 
to keep in mind, to design a truly valuable system.   
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2. BOUNDARIES OF THE RIVER REACH 
AND SPATIAL ANALYSIS 
The Flood Early Warning System will be designed based on a river reach, that is limited by the bottleneck 
in town at the downstream end, and river flow gauge at the upstream end. This river reach will be mapped 
and modelled, which is described in Chapters 3, 4, and 5. The boundaries are determined in this chapter.  

2.1 IDENTIFICATION OF THE FLOOD POINT 

The flood point is identified just downstream of the junction of the Enkare Narok river and a drainage 
channel, in the centre of Narok Town. At this point, water will flow over the river bank first, causing the start 
of the flood. The capacity of the river is determined by the bridge, another 400 meters downstream. The 
bridge is therefore the bottleneck of the water system, due to the narrowing of the river banks and a limited 
water level depth due to the bridge deck. This bottleneck will cause a backwater curve, which is noticed by 
increasing water levels in the upstream direction from that point, up until the flood point. These points are 
determined by Dorius Le Poole in his MSc thesis on “Rapid hydraulic assessment tool for river floods using 
hydraulic geometry relations in data scarce areas”. His study has functioned as a starting point for this 
study. The two identified points are illustrated in Figure 5. The bridge is considered the downstream 
boundary of the river reach, since it is assumed that if the capacity at this point is exceeded, a flood will 
occur.  

 

 

 

 

 

 

Figure 5: Identified flood point (1) and bottleneck (2) of the water system in Narok Town, of which point 2 will be the 
downstream boundary (Poole, 2024) 

2.2 IDENTIFICATION OF THE GAUGE PLACEMENT 

To determine a location for the water level gauge, firstly, rough estimations were made on the reachability 
of the river going upstream. Multiple points were identified where the river could be reached, after which 
the steps below were followed.  

2.2.1 WARNING TIME 

To determine an adequate as well as feasible warning time, mostly information gathered in interviews is 
used. Additionally, literature has  been consulted on general findings in the relation of warning time and 
damage reduction.  

  

1 

2 
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INTERACTIONS IN TOWN 

As described in Paragraph 1.3, interviewed stakeholders in town, mostly small business owners, 
considered loss of life as their main concern when it comes to floods. A warning would therefore be 
appreciated, in order to be able to flee. Described actions included taking motorcycles and/or cars, or just 
running to higher grounds. Considering the flood plain has proven to be quite small in former flood events, 
the required time to flee is limited to approximately 30 minutes at its maximum; most interviewees 
mentioned a time of a couple of minutes. If more time was given, some business owners that are closer to 
the river banks would evacuate all their belongings, but others would still leave their business behind. 

INPUT OF STUDENTS OF MAASAI MARA UNIVERSITY 

To further dive into the subject of warning time related to different stakeholders, an interactive session was 
held at the Maasai Mara University. This session was attended by 15-20 students of the faculty Natural 
Resources, of which most were enrolled in the Urban Planning programme. Four stakeholders were given: 
visitors, residents, shop owners and farmers. For every stakeholder, the possible actions were asked for 
different warning times, e.g. 5 minutes, 30 minutes, 60 minutes, 120 minutes, or 1 day. The results are 
included in Appendix A. The main findings are described here.  

 For visitors, it was noticed that unfamiliarity with the surrounding, and the warning system, are 
delaying factors. First, the right contacts will need to be made, in order to receive good 
instructions. 30 minutes will suffice to run, 60 minutes will be required in order to understand the 
impact. 1 day is required for visitors to return to their homes and to dodge the flood event.  

 For residents, the main concerns included the ability to take personal belongings, and the ability 
to warn family and neighbours. It was concluded that in 5 minutes, you can only save yourself and 
possibly an ID and/or mobile phone. In 30 minutes, essential items can be taken and family and 
neighbours can be warned quickly. In 60 minutes, you will be able to reach more friends and family 
and possibly pack an emergency kit, suited for a longer time. In a day, a safer living place could be 
identified and reached. In conclusion, a required warning time of 120 minutes was stated, since 
this would give ability to inform and relocate everyone, including essential personal belongings. 

 For farmers, main concerns included machinery, relocation of livestock, and post flood recovery. 
30 minutes was considered sufficient to evacuate most of the livestock and run themselves. With 
more time, all valuable belongings and all livestock could be safely relocated. If a day is given, 
possibly even the fields can be harvested to save the goods. In conclusion, a required warning 
time of 1 day was stated.  

 For shop owners, main concerns include notifying customers, and saving their stock. For shop 
owners, the reliability of the warning was also stated multiple times, since this will influence the 
actions of this stakeholder. In 5 minutes, one could run. In 30 or 60 minutes, one could notify all 
customers and relocate some of the stock to higher shelves. In more time, one could relocate all 
properties to a saver place, but there is doubt on whether this would actually happen. In 
conclusion, a required warning time of 1 hour was given.  

FINDINGS IN LITERATURE 

Not many conclusions are drawn in former studies that determine a perfect warning time. As is already 
described in the manual, a warning time will be a trade-off between accuracy of the warning, and larger 
timeframes.  

A study by Schröter et al. (2008), emphasizes the need of a proper cost-benefit analysis before 
implementing a Flood Early Warning System. This analysis can be used to determine the utility of a system, 
as well as the decisions that need to be made when warnings are issued. Damage reduction is found to 
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range between a few percent points to 35 percent, of average annual flood damages. Loss of life is difficult 
to include in these economic terms. Schröter et al. conducted two case studies for small basins, one in 
Austria and one in Spain. In these studies, a damage reduction of up to 60% can be reached for a warning 
time of 12 hours, and a reduction of 20% can be achieved for  a time of 1 hour. For both basins, the case of 
a flash flood is considered. (David Rogers, 2011) 

 

Figure 6: Warning reliability and damage reduction as functions of warning lead time (David Rogers, 2011) 

A study on flood early warning communication in Narok County, determined an optimal warning time for 
the county. In this report, weather forecasts of the Kenya Meteorological Department are given as main 
input for flood early warning models. It is stated that a preferred timing for flood early warning information 
should be more than 7 days, in order for the strategy to be adequately performed. (World Bank, 2021) 

PROCESSING TIME 

When a warning is issued, it is of importance that the reliability of this warning is checked, before an actual 
warning will go out. The detailed process is not yet determined, but an estimation of 15 minutes will be 
added to the warning time. 

CONCLUSION 

In the flood plain of Narok Town, mostly shop owners are found, as well as visitors and other pedestrians. 
For these stakeholders, the main concern will be to collect essential items, warn people in their 
surroundings, and evacuate the low-lying areas. It is concluded that a warning time of approximately 1 
hour would be sufficient. The reliability of the warning is of high importance, and will influence the actions 
taken by everyone who is involved. Longer required warning times were found in literature, however these 
are not feasible in the warning system that is proposed in this project. To account for the processing time, 
an additional 15 minutes is added to the warning time.  

2.2.2 FLOW VELOCITY OF A (FLASH) FLOOD 

In order to estimate the flow velocity of a flash flood in the Enkare Narok river, the range as given in the 
manual is used. It is stated that a flash flood, in Kenya, ranges from 0.05 to 4 [m/s]. To determine a first 
estimate of  the upper boundary of the river reach, the upper boundary of this range, namely 4 [m/s], will 
be assumed. 

2.2.3 CONCLUSION 

An aim to be able to detect a flood risk 1 hour and 15 minutes before the flood will hit town was determined. 
A flash flood is estimated to have a velocity of 4 meters per second, which is equal to 14.4 kilometres per 
hour. This concludes in a minimal distance of 18 kilometres upstream from the bridge in town, as an 
appropriate location for the gauge placement. Combined with the first identification of reachable 
locations, a spot is located which is 16.5 kilometres upstream of the bridge.  This does not satisfy the 
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determined length of 18 kilometres, but is is still regarded the best possible option. The point will be the 
upper boundary of the river reach. 

2.3 SPATIAL ANALYSIS OF THE RIVER REACH AND CORRESPONDING CATCHMENT 

A digital elevation map is created, based on data retrieved from the Shuttle Radar Topography Mission 
(SRTM) of NASA. (NASA's Earth Observing Centre, 2024) Based on this elevation data, water streams 
catchments are delineated for the Narok region. Figure 7 shows the elevation map, of the catchment of the 
Enkare Narok river, established from the bridge in town. Figure 8 shows the flow direction of water runoff 
in the catchment. The maps are drawn with WGS 84 / UTM zone 37S as coordinate reference system. 

Figure 7: Digital Elevation Model, with corresponding legend, of the catchment, created in QGIS 

Figure 8: Flow direction map, with corresponding legend, of the catchment, created in QGIS 
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2.3.1 (SUB) CATCHMENTS OF THE RIVER REACH 

Figure 9 shows the delineated streams, and the catchments of three sub catchments: the side stream that 
connects to the river approximately 6 kilometres upstream, and the two sub catchments belonging to the 
drainage channels that flow through town from the east.   

Figure 9: Catchment delineation map, with corresponding legend, created in QGIS 

The corresponding areas are: 

 Total catchment (yellow area): 895,8 km2 

 Easter side stream catchment (orange area): 199,4 km2 

 Esamburmbur catchment (green area): 15,2 km2 

 Kakia catchment (blue area): 29,3 km2 

 Esamburmbur and Kakia catchments together: 44,5 km2 

The areas are determined based on the delineations in QGIS. These are drawn based on the elevation data 
and the corresponding natural flow. The actual water streams are slightly different, due to erosion and/or 
human interference.  
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3. MAP THE RIVER 
Using the obtained knowledge about the Flash Floods occurring in Narok Town, it is time to determine 
useful cross sections in order to map the river for modelling. Our considerations and selection of cross 
profiles is discussed in paragraph 3.1 and 3.2. The measurement execution is then discussed the following 
paragraphs. Following from this chapter is all the required data for the modelling. 

3.1 EXPLORATION OF CROSS-SECTIONS 

The first step in exploring the cross-sections is to determine how far upstream one has to measure. This 
was done based on the desired warning time and the estimated wave celerity. The ideal warning time 
required would be 2 hours, with an estimated wave celerity of 4 [m/s] this would mean that the sensor 
would have to be placed 28 kilometres upstream. This however did not seem possible as no roads reached 
that far. The most upstream cross-section possible was taken 16 km upstream from the bridge.  

The number of cross sections that one should measure strongly depends on the accessibility of the river. 
The chosen approach in this project was to check on Google Earth how much locations along the river 
seemed accessible. For this case study 10 cross-sections seemed to be possible over a length of 16 
kilometres. Thereby an additional cross-section was taken at the tributary. The explored cross-sections 
are shown below in figure 10. The exact number of cross-sections needed will be decided in chapter 5 with 
a sensitivity analysis of the model.  

Figure 10: Measurement points (red) in the river, starting at the bridge in town going upstream to a distance of 16.5 
kilometres, shown together with delineated water streams and corresponding (sub) catchments, created in QGIS 

Next the measurements that should be done were determined. The following has to be measured: 

 Cross-Section of bankfull state  
 Velocity Profile 
 Waterlevel 
 Slope 
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Based on the needed measurements and the amount cross sections a planning was made. At most, two 
cross-sections can be measured per day. 

3.2 INCORPORATION OF JUNCTIONS 

In the river reach, two junctions are found. For both junctions, a different methodology is used to 
incorporate the additional water flow.  

3.2.1 EASTERN SIDE STREAM AT 6 KM UPSTREAM 

At approximately six kilometres upstream of the bridge, the water stream splits in two. The western stream 
is considered the main branch and also has a larger water flow. The eastern stream will not be modelled, 
but the discharge contribution will be assumed based on a discharge ratio, as described in the manual.  

Measurements have been made in the two streams to determine the discharge at a certain day. The 
discharge was relatively low, and therefore possible to measure. The discharge is based on the average 
flow velocity (𝑣𝑣 ) and the flow area (𝐴𝐴 ), which is measured with a GPS system. The measurement 
methodology is described in this Chapter, Paragraphs 3.3, 3.4, and 3.5. The discharges (𝑄𝑄 = 𝑣𝑣 ∗ 𝐴𝐴), in 
[m3/s], are compared and a ratio is determined. The same ratio is assumed for the case of high discharge 
in the river, which is modelled in Chapter 5. The measured discharge in the western stream (main river) is 
1.39776 [m3/s]. The discharge in the eastern stream is 0.35283 [m3/s]. This gives a ratio of 0.798/0.202 
respectively.  

A discharge ratio can also be determined based on areas of the sub catchments. For the eastern side 
stream, an area of 199,4 km2 is found. The area of the total catchment is 895,8 km2, and the area of the 
catchment of the western side stream is 631.2 km2. This means that 22.3% of the total discharge comes 
from the eastern side stream. At the junction, this relates to a discharge ratio between the western and 
eastern streams of 0.684/0.316 respectively. In this method, it is assumed that rainfall is equally 
distributed over the total catchment, and runoff coefficients are equal as well. In this case, with the 
majority of the Mau Forest laying in the western catchment, this will probably be a light over estimation of 
the discharge coming from the eastern stream.  

It is decided to use an average of both methods, concluding in a discharge ratio of 0.74/0.26 between the 
main river and the eastern side stream, for both low and high discharges.  

NAROK WATER TREATMENT PLANT 

Just a couple meters downstream from the junction, a water treatment plant extracts water from the 
Enkare Narok river. Narok water and Sewerage Services Company Limited (NARWASSCO) is a public 
company, with as main objective to supply clean water and sewerage service to Narok Town, Ololulunga 
Town and its environments. The quantity of water extraction is unknown. This water loss is not included in 
further calculations (Narok County Government, 2024). 

3.2.2 DRAINAGE CHANNEL IN TOWN 

The discharge of the channels, combined with that of the main river, contributes to the overall discharge 
during a flash flood. This discharge is based on literature, as already research had been done on the  
contribution of the channels to the main system, which is considered more accurate than the method 
above. Overflow of the channels will be disregarded since the focus is on potential flooding from the main 
river. 
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Measurements of the dimensions of the Kakia and Esamburmbur channel have already been taken by a 
study from the Pan African University using RTK equipment. This study improves the design of the channels 
based on estimates of future peak discharges, considering four future Land Use and Land Cover (LULC) 
scenarios in the sub catchments. Scenario 1 assumes a significant increase in urbanization and 
agricultural activities leading to drastic reduction of forest area. Scenario 2 projects moderate 
urbanization, a reduction in agriculture and an increase in pastureland and reforestation. Scenario 3 
focuses on major urban expansion with little focus on forest preservation. Scenario 4 proposes a balanced 
distribution, assuming moderate land-use changes across all sectors. (Etienne Umukiza J. M., 2022) 

Calibration of an advanced hydrological model for a small and ungauged basin as this one is difficult as 
observed flow data is scarce. Therefore Umukiza uses the Event-Based Approach for the Small and 
Ungauged Basins rainfall-runoff model (EBA4SUB). The inputs data needed by the model are the Digital 
Elevation Model (DEM) of the investigated catchments, the LULC data and the rainfall data.  Based on this, 
the evaluated values related to peak discharges for 50 and 100 years return periods for the different 
projected scenarios are summarized in Table 1. 

Table 1: Peak discharges in the water streams of the Kakia and Esamburmbur catchments for 50 and 100 years return period 
(Etienne Umukiza J. M., 2022) 

 
According to Umikaza (2019) the highway bridge over the Esamburmbur channel, located 295 metres from 
the upstream, may contribute to overflow. This therefore determines the maximum capacity through the 
channel. With the current geometric properties represented at that position the peak discharge estimated 
in scenario 4 with 10 years return period, is 52.18 [m3/s].  With the current geometry of the Kakia channel 
the capacity is 144.2 [m3/s], it can convey peak flow estimated in scenarios 2 and 2019 at 50 years return 
periods (Paper improving drainage systems). (Etienne Umukiza J. M., 2022) These two estimates will be 
taken as additional discharge input in case of a flash flood, at the junction in town. The two channels are 
combined just before draining into the Enkare Narok river.  

3.3 GPS SYSTEM AND BACKGROUND 

The of Ardusimple was determined to be a viable setup for the intended use, as they are cheap, precise 
and rely on open source software. The setup consisted of: 

 Two simpleRTK2B Pro receiver boards; 
 Two Serial data logger modules; 
 An U-Blox GNSS Multiband antenna ANN-MB-00; 
 A Budget Survey GNSS Multiband antenna (IP66). 

 Kakia Esamburmbur 

LULC Tr50 

[m3/s] 

Tr100 

[m3/s] 

Tr50 

[m3/s] 

Tr100 

[m3/s] 

2019 130.3 164.1 75.1 94.2 

Scenario 1 154.2 191.1 88.9 110.1 

Scenario 2 121.4 154 70.8 89 

Scenario 3 172.2 210.4 100.6 121.8 

Scenario 4 145.3 181 83.4 104.2 
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The system was build based on the principle of Post Processing Kinematic (PPK). This is the approach 
where all received satellite information is stored locally. By using post processing software, the location of 
the Base station and Rover can be calculated. The main advantage of this system is that the Base station 
and Rover do not need a direct line of sight between each other as most systems need. One is therefore 
able to place the Base station in a secure location with a clear view of the sky. The Base station was placed 
as illustrated in Figure 11below.  

Note that the Base station was also placed on a steel cover. This has two reasons with the first being that 
this placement limits the possibility of accidental movements as the antenna is equipped with a magnet. 
Movements of the Base station during measurements mean that all recorded data is unsuitable for data 
processing. Unfortunately, our project team suffered from this once. 
 The second reason for placing the Base station on a steel cover to achieve maximum gain towards 
the sky (Ardusimple, 2024). This is crucial in achieving centimetre level positioning. 

3.4 PREPARING A MEASUREMENT DAY 

In preparation of the measurement days, our first step was contacting the Water Resource Authority and 
present them our measurement plan. An important aspect of this was presenting the locations and 
timeline as showcased below in Figure 12. From this we gained the necessary permissions to execute the 
cross sectional measurements. 

Figure 11: Base Placement 

Figure 12: Measurement plan visualisation 

Lars Heijboer
Dit klopt niet helemaal geloof ik. Heb je een bron?
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Following from Chapter 1.2 we had already acquainted with the Kenya Meteorological Department (KMD). 
As the KMD Officer Josiah was very interested in the project at hand, he provided us with an enormous 
amount of support. In his own time, Josiah acted as chauffeur during measurement days in his 4x4 vehicle 
depicted in Figure 13 below. The required equipment was already gathered in the Netherlands. Familiarity 
with the functioning was obtained by executing trial measurements in our backyard. 

3.5 EXECUTION OF A MEASUREMENT 

Over the course of the ten week project, ten cross sections were taken to serve as an input for the 
modelling. As the project team encountered several problems, some of the measurements had to be 
executed again. Resulting from these in-field experiences, the step by step manual was build. Following 
this guide should therefore result into usable data to proceed with the modelling approach. But always be 
prepared that fieldwork never works out the way as you expect, just like in Figure 14 where a herd of cows 
interfered with our field measurement. It is therefore important to always keep an open mind and look at 
what data and/or options there are given the circumstances one is working with. Be creative, finding or 
obtaining flawless data is near impossible, learn how to work with the uncertainties. 

3.5.1 DETERMINE A SUITABLE CROSS SECTION AND ITS BANKFULL STATE 

Upon arriving at the location it is important to walk along the stretch of the river. Finding a clear bankfull 
state which is also accessible to create a cross section is the ideal scenario. But as Figure 15 showcases, 
not all banks are as accessible. In such instances one has to accept that it is not possible to perform 
measurements at half a meter interval and do the best that is possible. Do keep in mind that the bushes 
on the left bank hinder satellite reception and one should consider increasing the measurement time of 
each point. 

In other instances the bankfull state can unclear as marks are not always present. In this case local people 
can help out a lot as they are often able to point out how high the water rises. But always keep in mind that 

Figure 13: Off-road vehicle 

Figure 15: Challenging bankfull conditions Figure 14: Example of unexpected work environments 
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Figure 17 

Figure 16 

banks that show marks of human interference should be avoided. These are not natural banks and can 
thus lead to unexpected results. 

3.5.2 CROSS SECTION MEASUREMENT 

Having selected a cross section of interest, the rope can be spanned across the river. Marking the interval 
in which the cross section should be executed. It is important to note this step takes quite some time and 
is not very eventful. For us the best practise was one person handling the Rover and keeping it upright and 
the other holding the receiver in the Drybag. A small speaker both sounded the timer each minute. 

Sometimes installing the pegs into the ground can be quite challenging. Look for materials in your 
surroundings. Often a stone is close which can be used to drive the peg into the ground. 

3.5.3 WATER ELEVATION MEASUREMENT 

This measurement can be executed straight after the cross sectional measurement. As the river is already 
crossed one can directly do the measurement on the first bank. Do remember to remove and re-install the 
SD card to create a new logfile. It is advised to perform the water height measurement for about 10 minutes 
for each location. This advice is based on the fact that the water height should (after post processing) 
return single value, not as points to fit a line through as one does when executing the cross sectional 
measurement. When shortening the time of this measurement events like seen in Figure 17 can occur. The 
rover had not stabilized yet and thus the official water height cannot be determined. 

3.5.4 LENGTH PROFILE 

The length profile measurement is repeating the same water height measurement but then both up- and 
downstream of the cross section. The one important thing to note is in the walking with the Rover: keep it 
upright and stable. If it is shaken too much or loses its vertical orientation, it might lose track of its position 
and has to recalibrate. This takes longer than the 10 minutes in which one will execute the water height 
measurement and as one is not able to look at the live measurement/fix, the failed measurement goes 
unnoticed until the post processing. Thus when it is too late. 

3.5.5 VELOCITY PROFILE 

The velocity profile uses the same cross section as the one measured using the GPS. Using the same half 
meter intervals and set depth, one builds a table containing all velocity measurements.  

A special case is when one is in need of extra validation data. Then, using the GPS, a new profile is 
build using 5 points. This to have a rough idea on the shape of the cross section of the river as this is needed 
to calculate the total wetted area. But do realise this validation step should be executed on several steps 
along the river. 

Figure 17: Failed water height measurement Figure 16: Cross section measurement 



P a g e  | 25 
 

 
 

3.5.6 SLOPE OF THE RIVER 

Under normal conditions this measurement is not needed. Unfortunately for us it turned out that our base 
station was unstable in its height measurements. The same location between different days resulted in 
height differences of up to 11 meters. This lead to the fact that in some parts of the river water had to flow 
upwards according to our measurements. Therefore we decided to perform one last elevation 
measurement along the entire river section, leaving the base at our home station. By doing this, all 
measurements during the day were prone to the same error and thus placed them relatively on the right 
elevation from each other. An important part was also performing a “sanity check”. A single point was 
measured twice during the day. Making sure the measured hight was now the same. In our case the 
measurements were still 40 centimetres apart. But considered as acceptable. 

3.6 CONCLUSION 

Field measurements are a dynamic but important part of the research into flash floods. Capturing real 
world phenomena into models is always tricky and one should embrace the uncertainties encountered. 
Our step by step approach offers hand held to get reliable results under uncertain circumstances. But as 
every situation is unique, always take the local circumstances into account. Be creative in the innovative 
solution that is under development.  
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4. PROCESS DATA 
During the field measurements the SD-card was used to log the positional data relative to the satellites. 
The conversion from this relative position to files, that serve as input for the HEC-RAS model, takes several 
steps which are discussed below. To start with this step, the following needs to be installed and 
completed:  

 Fieldwork measurements, discussed in Chapter 3.  
 RTK post processing software, installation discussed in Appendix E.  
 Python processing is further explained in Appendix F. 4.1 RTK software processing of the manual 

4.1 RTK SOFTWARE PROCESSING 

In the case of the Enkare Narok river, eleven cross sections were measured. These cross sections were 
accompanied by additional measurements, like water height and local slopes measurements. This means 
that a lot of datafiles can be on the SD-card at a time. The point of this is to emphasize that it is crucial to 
keep a good administration of the files on the SD-card. A proper administration will prevent the loss of 
measurements. 

Another point to mention is the accuracy of the measurements. Figure 18 shows the accuracy of a cross 
profile measurement. As explained in Appendix E of the main manual, yellow indicates submeter accuracy 
and green indicates centimetre accuracy. With this information, one could observe the following plot and 
think that the measurement is not that good. However, this is not always the case. Even if  it is not 
centimetre accurate, if the location is based on at least 11 satellites, the accuracy can be assumed to be 
between 2 and 8 [cm]. This, in combination with at least 60 datapoints being registered per position, the 
measurement is still viable. 

Figure 18 Output of RTKpost.exe 

4.2 PYTHON PROCESSING 

The Python processing, using the Data Processor Package, results in different outputs, namely: 

 A .csv file with the cross profile points for each point; 
 .png file of the cross profile for each point; 
 .png file of the velocity profile for each point;  
 One .csv file with the hydraulic parameters of all cross sections.  
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Figure 20 

Figure 19 

Below, these results for one of the cross sections of the Enkare Narok river are given. This shows how the 
output looks like. 

The following figure presents an example of the Excel file with the computed hydraulic parameters. This 
output shows the hydraulic parameters of three cross sections. As can be seen, there are no parameters 
computed for point 7. This is the case as no valid water height was measured at that point. This emphasizes 
the fact that the user should take care of executing the measurements.  

Figure 21: Example output of hydraulic parameters 

In the case of the Enkare Narok river, some measurements didn’t go fully as planned. There were some 
measurements where the SD-card was already in the rover, so that the calibration process was also 
logged. This required some trimming of the dataset. Figure 22 visualises what part (blue part) was cut of 
the dataset to obtain a valid cross section. This shows how the “INDIVIDUAL_CROSS_SECTION.ipynb” can 
be useful in the data processing process.  

The “SLOPE_DETERMINATION.ipynb” notebook turns out to be quite useful in determining the local 
slopes. It requires some input, namely three water height measurements per cross section, as shown in 
figure 23. The output however, is really concise and consist only out of one table with the local slope for 
each cross section, see figure 24. These slopes were used for the evaluation of the Manning equation and 
the boundary condition for the HEC-RAS model.  

Figure 22: Application of the data trimming tool 

Figure 20: Example of velocity profile output Figure 19: Example of cross profile output 
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Figure 24 

Figure 23 

Figure 23: Input of the SLOPE_DETERMINATION.ipynb 

4.3 CONCLUSION 

In the case of the Enkare Narok river, a lot of measurements were done. It was a trial an error process, 
which eventually resulted in a streamlined measurement plan (explained in Chapter 3 and Appendix D of 
the manual) and data processing protocol. The data processing protocol is captured in the Data 
Processor package. This packages automates the process, once all the data is collected.  

A few lessons were taken from the data processing that could be helpful for users in the future. Firstly, it 
is advisable to thoroughly understand the GPS system that you’re using and its capabilities. This can be 
done by thoroughly testing the GPS system before using it in the field. Testing procedures are described 
in Chapter 3.4 and Appendix C of the manual. Secondly, one should check the first few measurements 
that are done for any peculiarities. In the case of Narok, it turned out that the elevation that the GPS 
system measured, were inconsistent over the days. This resulted in a change in the applied 
measurement plan. The inconsistent height is of course just an example of what can go wrong, so the 
user should be critical on his measurements. The checking of the measurements can be done with the 
“INDIVIDUAL_CROSS_SECTION.ipynb” notebook, included in the Data Processor package. Lastly, it is 
emphasized to keep a good administration and folder structure for the measurement data. With the 
advised measurement plan, a lot of files will be generated and without a good system, it is easy to lose 
track. A lack of clear structure can in the worst case result in having to redo (some of) the measurements.  

In conclusion, the RTK processing software and the Data Processor package are fully equipped to 
process the measurement data. However, the user should be aware of the pitfalls and work in an orderly 
manner.   

Figure 24: Output of the SLOPE_DETERMINATION.ipynb 
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5. BUILD MODEL 
This chapter focuses on building a one-dimensional hydraulic model of the Enkare-Narok river in Narok 
County. The objective is to find the critical discharge upstream of the river, that leads to flooding at the 
flood point, which is defined as the point where the drainage channels enter the Enkare-Narok river, and 
to find the corresponding warning time.  

First, an alternative method based on manual computations is discussed. In Paragraph 2, modelling of a 
flash flood, in the general sense, is discussed. Subsequently, the models that were created for this case 
study, are described. In Paragraph 4, conclusions based on the line model are given, which are followed 
by a sensitivity analysis of this model, in Paragraph 5. The chapter is concluded in Paragraph 6, stating the 
main findings of the models made for the case of Narok Town. 

5.1 ALTERNATIVE MANUAL COMPUTATIONS 

For data-scarce areas often simpler methods than models are recommended, in order to give an 
estimation of parameters that are to be determined. An example of a such a method, and the application 
of it in Narok Town, is discussed here.   

Discharges can be calculated based on Manning’s formula, which can be combined with a method by 
Leopold & Maddock. By combining these two methods, one should be able to calculate the discharge in a 
channel based on either a measured width, depth, or flow velocity. This can be used to convert a water 
level gauge upstream to a discharge. Similarly, based on a (high) discharge, a flow velocity can be 
determined. This methodology is described in the manual, in Appendix I. The results for these calculations 
in the river reach in the Enkare Narok river are given in Appendix B in this document. A Manning coefficient 
is determined based on the base flow, as was measured, and results in an average value of 𝑛𝑛 = 0.0708 
[s/m(1/3)]. It is noted that this value is higher than would be expected based on literature. This coefficient is 
used to calculate discharges per cross-section, for a bank full state of the river, simulating a flash flood. 
Similarly, the corresponding flow velocities are determined. These bank full state outcomes are used as 
input for the Leopold & Maddock method. Unfortunately, this resulted in non-conclusive relationships 
between geometry characteristics width, depth, and velocity and the discharge, per cross-sections. The 
relationship between depth and discharge gave the best result and did deliver calculated discharges in the 
same order of magnitude as the calculations based on Manning’s equation. It is recommended to also 
discover the relations based on a base flow state of the river, which was also done for this river reach. 
However, these results were also non-conclusive and therefore not added to this report. 

5.2 MODELLING A FLASH FLOOD 

The recommended approach for building a model that can simulate a flash flood consists of three steps:  

1. Creating the complete geometry of the part of the river that has to be modelled. 
2. Creating a steady flow model to calibrate Manning’s coefficient. 
3. Defining an unsteady model to simulate the flash flood. 

5.2.1 GEOMETRY 

Only a small part of the Enkare-Narok river will be modelled. The bottleneck of the river is the bridge in the 
centre of the town, therefore, this will be the downstream boundary of the model. The upstream boundary 
is the point where the sensor will be placed. For this model, a point 16.5 km upstream of the bridge is 
chosen, illustrated in Figure 18. This means that 16.5 km of the river will be modelled. The determination 
of these boundaries is further elaborated in Chapter 2 of this document. The river will be modelled as one 
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reach without any junctions. There will be accounted for tributaries, by adding or subtracting a discharge 
at the locations where they enter or exit. More information about the geometry and terminology used by 
HEC-RAS is given in Appendix G of the manual. 

The geometry of the model, width and elevation of the river, is based on field measurements. As explained 
in Chapter 4.1, ten cross-sections have been measured. Additionally, the data of three cross-sections was 
already available, retrieved by Dorius LePoole  (Poole, 2024). The geometry of the model is illustrated in 
Figure 26. 

Figure 26: Geometry of the model 

  

Figure 25: Upstream boundary 
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5.2.2 STEADY FLOW 

After completing the geometry, the steady flow data can be specified. The following input is required to run 
the steady flow model: 

 FLOW REGIME 

The flow regime during the validation measurements is used as input for the steady flow model to 
be able to calibrate Manning’s coefficient, as explained. The flow regime was assumed to be 
subcritical due to the low velocities observed when standing in the river. This had been verified by 
applying the average velocity and depth of the cross-sections, obtained in Chapter 4, to the Froude 
number formula. For each cross-section, Froude’s number was less than 1, meaning that the flow 
is subcritical.  

 BOUNDARY CONDITIONS 

Since the flow regime is subcritical, only a downstream boundary condition is necessary. The 
downstream boundary is located at the bridge. The boundary condition is defined as a normal 
depth, for which an energy slope has to be entered. Since no information is available on the energy 
slope, the bed slope is used as an approximation (US Army Corps of Engineers Hydrologic 
Engineering Center, 2016), which is equal to 0.00251 [m/m] 

 PEAK FLOW DATA 

The river is modelled as one reach. Therefore, HEC-RAS only requires one discharge as input. The 
discharge calculated with the validation data is used, and is equal to 1.85 [m3/s].  At cross-section 
9, a tributary enters the main river. The discharge downstream from the junction is 1.74 [m3/s]. At 
cross-section 3, the drainage channels enter the main river. The discharge of the drainage 
channels is approximately 0 [m3/s] , as they only carry water in case of heavy rainfall in the 
Esamburmbur and Kakia sub-catchments. During the validation measurements, this was not the 
case.  

As explained in the manual, determining a suitable Manning’s coefficient for the model is an iterative 
process. As a starting value, a value found in literature was used. Manning’s coefficient can range between 

0.01 and 0.07 [𝑠𝑠/𝑚𝑚
1
3]. For a river like the Enkare-Narok river, Manning’s coefficient will probably range 

between 0.03 and 0.05 [𝑠𝑠/𝑚𝑚
1
3]. A more detailed explanation is given in Appendix I of the manual. An average 

value of 0.04 [𝑠𝑠/𝑚𝑚
1
3] is used as the starting value. The iterative process resulted in a Manning’s coefficient 

of 0.1 [𝑠𝑠/𝑚𝑚
1
3], which does not fall within the range of possible Manning’s coefficients. Manning’s coefficient 

depends highly on the measured water level and velocity. Since these measurements were not very 
accurate, the determined Manning’s coefficient is not reliable.  

5.2.3 UNSTEADY FLOW 

Calculations with the unsteady flow model are executed twice. Once to validate the model and once to 
simulate the flash flood. Both the upstream and downstream boundary conditions need to be specified 
when simulating unsteady flow. The upstream boundary condition is defined as a flow hydrograph, while 
the downstream boundary condition is defined as the normal depth, which is equal to the normal depth 
used in the steady flow model.  
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 VALIDATION 

For validation of the unsteady flow model, the same validation data was used as for the steady 
flow model. The flow hydrograph will be defined using a constant discharge, the discharge based 
on the validation measurements at the most upstream cross-section, equal to 1.85 [m3/s]. A 
simulation time of one hour is employed. At cross-section 9, a flow hydrograph is defined to 
account for the tributary. This hydrograph is held constant at 1.74 [m3/s]. The discharge of the 
drainage channels is equal to 0 [m3/s], similarly as the steady state model.  

 FLASH FLOOD 

The discharge during a flash flood is a lot higher than during the validation measurements. The 
discharge is specified in the stage/flow hydrograph defined at the upstream boundary condition. 
In this case, the discharge does not remain constant. The stage/flow hydrograph starts at the 
discharge prior to the rapid rise in water level, and will continue to increase until the critical 
discharge is reached, which leads to a flood at the flood point. In an ideal situation, you would 
have measurements to define the stage/flow hydrograph. This is very challenging, as 
measurements in these conditions, a high water level and velocity, go hand in hand with 
dangerous situations. Therefore, the stage/flow hydrograph is based on the bank-full discharge, 
determined by the Manning method, at cross-section 13, as illustrated in Figure 26. This discharge 
is accompanied by a lot of uncertainties, since the bank-full level of the river is based on 
judgement by sight. The highly varying flow area of the cross-sections is an indication of this 
uncertainty. The simulation time, the step size of the discharge during the simulation and the initial 
value of the discharge remains very uncertain as well.  

Unfortunately, the unsteady flow model with the validation data as input, did not result in realistic output, 
as explained in the manual. To be able to find the root cause, a simplified model was taken as starting point 
and expanded step by step. The outcome of this analysis is provided in the following paragraph.  

5.3 MODELS 

It was suspected that the problem originated from the terrain data and the projection file uploaded in RAS 
Mapper. It appears that HEC-RAS either geo-references the cross-sections even when no coordinates are 
provided, or it still considers the elevation data from the Digital Elevation Model (DEM), despite this data 
being removed from the cross-sections. The disadvantage of RAS Mapper is that you must specify a 
projection file and add a terrain layer before you can include web imagery, even if you don’t want to geo-
reference your project or use a DEM. It seems that HEC-RAS is primarily designed for creating elevation 
data using a DEM rather than using field measurements.  

This is just a hypothesis. The problem could also originate from another aspect of the model. To rule this 
out, intermediate models were created, as explained. Per intermediate model, the following conclusions 
were drawn: 

 SIMPLIFIED LINE MODEL 

There are no issues with creating the geometry in HEC-RAS with rectangular cross-sections. 
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 EXPANDED LINE MODEL 

There are no issues with the distance between two subsequent cross-sections and more complex 
cross-sections. 

 COMPLETE LINE MODEL 

The malfunctioning of the full model is most likely related to either the representation of the actual 
course of the river, including incorporation of bends, or the underlaying terrain. Furthermore, the 
model aligns approximately with the validation data.  

 IMPORT FULL MODEL GEOMETRY 

The terrain data and projection file were indeed the root cause of the problem. Additionally, it can 
be concluded that representing the actual course of the river is not the problem and drawing the 
course of the river does not incorporate the effect of bends. Furthermore, the model aligns 
approximately with the validation data.  

It can be concluded that the complete line model provides realistic output. The disadvantage is that bends 
are not incorporated, therefore, the model is simplified more than was desired. 

5.4 CONSLUSION BASED ON COMPLETE LINE MODEL 

As explained, the difficulty of modelling with HEC-RAS lies in incorporating the bends of the river, which is 
yet to be understood. However, the critical discharge and corresponding warning time can still be 
concluded from a model without bends, namely the Complete line model. They will be a bit more 
conservative, since bends cause energy losses due to friction and turbulence. This will result in a lower 
average velocity of the water and thus, a longer travel time to the flood point.  

Computing an exact warning time is not possible with this manual, as there is no sufficient data for the 
boundary conditions in the unsteady state. Estimating a flow hydrograph based on the estimated bank-full 
discharges seemed to be too uncertain, as explained in 5.2.3. 

Setting the correct boundary conditions when modelling unsteady flow is crucial for getting a 
representative output. The following boundary conditions should be known to estimate the warning time: 

1. Stage/flow hydrograph at the upstream boundary 
2. Flow hydrograph for the lateral inflows where tributaries enter 
3. The bed slope, used for calculating the normal depth, at the downstream boundary 

After determining the critical discharge and the corresponding warning time, the sensitivity of the model 
can be determined. This is done by removing cross-sections one by one until the model’s output differs too 
much from the original model.  

5.4.1 THE CASE OF NAROK TOWN 

In the case of Narok Town, both the upstream stage/flow hydrograph and the lateral inflow hydrographs 
are unknown. Therefore, it is difficult to determine whether the outcome is representative for the actual 
flow of the river. However, this section will consider different flow hydrographs, to show how the results 
can be interpreted and what the effect of changing the hydrographs is on the model’s outcome.  

  



P a g e  | 34 
 

 
 

ADDING AN UPSTREAM STAGE/FLOW HYDROGRAPH 

The first step is to only add a stage/flow hydrograph at the upstream boundary, which increases from 1.85 

�𝑚𝑚
3
𝑠𝑠� � to 200 �𝑚𝑚

3
𝑠𝑠� � within two hours, the water elevation at this cross-section increases from 1900.85 

metres to 1904.23 metres, which is equivalent to the bank-full height. After two hours, the simulation was 

ran for two more hours at a discharge of 200 �𝑚𝑚
3
𝑠𝑠� �. The result of the simulation after two hours is shown 

in Figure 27.  The velocity in the channels varies between 2.5 [m/s]  and 3.1 [m/s], which corresponds to 
the values found for the wave celerity. The bank full capacity at the bottleneck, the most downstream 
location, is reached after 2 hours and 58 minutes.  

INCORPORATING TRIBUTARIES 

To add a tributary, a new river station has to be added and a lateral inflow hydrograph is added to this river 
station. The starting time of the hydrograph is not set to zero, as was done for the upstream boundary. If 
this would be the case, all flows would act separately, as is shown in Figure 28. 

Figure 28: Tributaries acting individually 

In this case, the upstream flow conditions would not be relevant anymore, as the lateral inflow will reach 
the bottleneck first. To solve this, the starting time of the lateral inflow hydrograph is adjusted to the time 
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Figure 27: Simulation for upstream boundary. The striped line is the Energy Gradient; The blue is the water level 
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when the upstream flow reaches the tributary. Flowing from station 13 to  station 9, takes 1 hour and 54 
minutes. At point 9, a lateral inflow hydrograph is created in which the discharge rises in an hour from 1.74 
[m3/s] to 70 [m3/s], this is according to the ratio as explained in Chapter 3.2.  The cumulative flows from 
point 13 and 6 together take 2 hours and 40 minutes to reach point 2, the hydrograph at that point goes 
from 0 [m3/s] to 200 [m3/s] within an hour. 

RESULT 

After the tributaries have been added, the unsteady flow model can be run. Running the model with the 
values mentioned above will result in 2 hours and 50 minutes before the capacity of the bottleneck is 
reached. Figure 29 shows the result. The corresponding discharge is 146.20  [m3/s]. However, this result 
cannot be interpreted as being a realistic warning time for a flash flood. In order to do so, the boundary 
conditions for the unsteady flow should be known. 

Figure 29 Outcome complete line model 

Adding the lateral inflows only resulted in a time difference of 10 minutes, when compared to only adding 
an upstream boundary condition.  

The model has also been ran for an upstream discharge of 300 [m3/s] , this did not result in a much shorter 
warning time. The time difference was 2 minutes shorter compared to the case of 200 [m3/s]. 

5.5 SENSITIVITY ANALYSIS 

To determine how many cross-sections are needed to model the river, a sensitivity analyses was 
conducted.  This analysis was conducted on the unsteady flow model as shown in figure 4. Although the 
outcome might not be a precise representation of the river, it was shown with the verification data that the 
results are consistent. Therefore the output of the model can still be used as a reference for the sensitivity 
analyses. The outcomes per analyses are compared to the result obtained out of the unsteady flow model, 
ran with only the upstream boundary condition as previously shown. The outcomes for each analyses will 
be compared to the earlier computed time, being 2 hours and 58 minutes. The  input discharge is set the 
same as for the case only simulating with an upstream boundary condition. 
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1. Deleting all cross-sections between 13 and 1 
Running the model with only two cross-sections leads to a significant reduced time in which the 
capacity at bottleneck is reached, 2 hours and 20 minutes. This is an error of 21% compared to the 
original situation. 

2. Deleting cross-sections 5-10 
Running the model with only 7 cross-sections leads to a less significant reduced time in which the 
capacity at bottleneck is reached, 2 hours and 49 minutes. Removing 6 cross-sections leads to an 
error of 10 minutes, which is a mistake of around 6%. 

3. Deleting 8 cross sections 
In this case the water takes 2 hours and 53 minutes to reach the bankfull capacity at the bottleneck. 
Only the cross-sections 1,5, 9, 11 and 13 remain. Therefore it can also be concluded that it matters 
which cross-sections are removed or not. Although more cross-sections have been removed, the error 
is less than for the second case. This is most probably because in this case the cross-sections have 
been removed more evenly. 

4. Case 3 and removing cross-section 5 
This leads to a time of 2 hours and 40 minutes before the water reaches the bottleneck, this is an error 
of 11%.  

It seems that removing 8 out of the 13 cross-sections is the maximum limit at which the error is acceptable. 
When removing an additional  cross-section the error goes up to 10% compared to the original case. 
Thereby the result is also depended on which cross-sections are removed, removing them evenly leads to 
better results. 

CONCLUSION 

The critical discharge based on the complete line model is equal to 146 [m3/s], and the corresponding 
warning time is equal to two hours and fifty minutes. Although a conclusion was drawn, it did not have 
the desired accuracy for several reasons: 

 The calibrated Manning’s coefficient did not fall within the range of possible values. This is 
probably caused by inaccurate measurements of the water level and flow velocity. Manning’s 
coefficient is changed until it corresponds to the water levels and velocities that are provided, 
therefore, it depends highly on these measurements.  

 The upstream boundary condition in case of a flash flood is defined as a stage/flow hydrograph. 
To be able to define this properly, continuous measurements are required, or measurements have 
to be conducted during these conditions, which is very dangerous. Therefore, the stage/flow 
hydrograph is based on the bank-full discharge calculated with the Manning method. This 
discharge is inaccurate as it is based on judgement by sight of the bank-full level of the river. The 
simulation time, the step size of the discharge during the simulation time, and the initial discharge 
remain very uncertain as well.  

 Bends are not incorporated into the model. When bends would be incorporated, it would result in 
a higher warning time. Bends lead to a deceleration of the water and an increase in water level.  
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 6. IMPLEMENTATION 
This manual is the result of a ten week project in Narok Kenya, of which it is important to note that a flood 
sensor has not been installed during the project. Nonetheless, information on the implementation was 
gathered. This chapter discusses the knowledge obtained and the means used to obtain the knowledge. 

6.1 PARTNERS INVOLVED 

No agreements have been made in terms of the partners involved in the actual functioning of a Flood Early 
Warning System in Narok Town. The local authorities, and the local community, are described in Chapter 
1. With these parties, discussions will need to be held to decide on role distributions and responsibilities. 

The Kenya Meteorological Department is traditionally responsible for weather forecast and alerts and 
warnings in Narok County. Therefore, they would be the best partner for TEMBO to maintain and upkeep 
an early warning system. Collaborations between TAHMO and the KMD have been maintained for a while 
already, and this will be an useful foundation for further collaboration. The local office of the KMD in Narok 
Town is also aware of possible responsible parties in the local community, and has a good reputation, of 
being trustworthy and knowledgeable.  

Funding possibilities for the implementation of a FEWS in Narok Town, have not been explored. 

6.2 FUNCTIONING OF THE SYSTEM 

Processing of the warning, and defining a communication method, have both not been concluded upon for 
the case study in Narok Town. First explorations on the topic are described here.  

6.2.1 PROCESSING THE WARNING 

Processing of the warning, given by the water level gauge, into an actual warning, is not explored 
extensively. Some brief talks with the KMD have concluded in a possible set-up as follows: The sensor 
should give an automated warning from the upstream location to the local KMD office. The office will check 
this warning, based on the delivered values, and on communication with someone close to the gauge 
location. The office will then be responsible for further communication of the warning to all intended 
recipients.  

6.2.2 COMMUNICATION OF THE WARNING 

Similar to the steps given in Paragraph 6.2.2 of the manual, a brainstorm session has been held with 
students of the Maasai Mara University, faculty of Natural Resources. Their answers are included in 
Appendix C. However, not much of it was written down. The main takeaways of this session are described 
here:  

 Sirens are considered the best way of communication. The message is clear, even for people who 
don’t understand the actual meaning of the warning. Furthermore, will a siren reach everybody 
present in the area, and will  it overcome struggles such as language barriers, illiteracy, and 
availability of phones and other media channels. 

 Another similar communication method is the use of speakers on a car, driving to the expected 
floodplain.  

 In terms of communication via cellular devices, it was noticed that not everyone has access to 
internet, therefore SMS alerts are recommended.  
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 Local media were mentioned multiple times as well. Especially for warnings with a longer warning 
time, for example a couple days, this would be a good communication medium. Local media 
would be able to reach many recipients, and also give the corresponding information that belongs 
to the warning. 

The issue of deciding on a suitable communication method is also discussed in a round of interviews in 
the floodplain of Narok Town. It was stated that suitable communication methods include clear sounds, 
like a siren, and methods via telecom, like SMS. It was also stated that neighbouring shop owners will warn  
each other, meaning that not everyone necessarily needs to be reached. 

6.3 SELECTING A SENSOR 

In the case of Narok Town, there was no conclusion drawn on which sensor is to be selected and no 
significant possibilities were explored.  

6.4 INSTALLATION OF THE SENSOR 

The installation of the actual sensor, which acts as the trigger of the warning system, is complex. In many 
African countries, equipment in the field such as sensors, often get stolen. It has proven to be difficult to 
find adequate measures. (TEMBO Africa, 2024) The location for the sensor, its installation, and the 
maintenance remain as always a challenge. 

6.4.1 LOCATION  

So far, using existing infrastructure has been found to be the best solution. An example is in suspending 
the sensor from a bridge. This leaves the sensor relatively unreachable for theft, and directly above the 
river of interest. The main downside of the approach is the maintainability of the system. 

Talks with Nick van de Giesen pointed towards the use of beehives to install and hide the sensors in. 
Beehives are common and often undisturbed structures along canals, providing the perfect opportunity to 
install and hide required sensors. An example was found at the Maasai Mara university, but has not yet 
found a real world application. 

Following from the interactive session with students of the Maasai Mara University, a lot of attention was 
pointed towards the security of the sensor itself. It should be constructed from rigid materials such as steel 
and concrete. Ideas like cages and tall concrete poles were suggested, as seen in Appendix C. Another 
solution was found in the installation of “temper sensors”, which track the location of the sensor. As soon 
as it moves, one is notified. The placement of guards was also seen as a possibility. 

The location will also highly depend on the possibility to include local community members or other 
parties. As is described in Paragraph 6.1 of the manual, involvement of local community members will ad 
to the safety and security of the sensor.  

In Narok Town, an example of a guarded location was found at the water inlet for the water supply for Narok 
town. During the execution of the measurements they directly noticed us and inquired about our 
intentions. Unfortunately, this water inlet was located only 6 kilometres from the bottleneck in Town and 
would thus result in a warning time that would be too short. 

Schools or other social institutions are also considered as relatively safe locations. These are often located 
in the midst of the local community and thus enjoy a lot of social control. 
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Especially in the case of Narok Town, the river is used along its full length by farmers and families. It thus 
enjoys a lot of (foot) traffic. Which in any way can (accidentally) tamper with the functioning of the sensor. 
It is therefore important to have it as robust as possible. 

6.4.2 INSTALLATION  

It is believed that the installation is location specific and following from the previous paragraph, even then 
there is a lot of disagreement on the best approach. A possible solution would be to check the way other 
sensors in the local context are installed. 

6.4.3 MAINTENANCE  

All people involved stressed the importance of a maintenance plan. More than often after the installation 
of a sensor the involved people move on, to other projects. Slowly over time the sensor loses its connection 
to the involved parties and eventually is forgotten. Or there is no one left who has the knowledge on how to 
act if the sensor fails. A good example is the previously installed flood early warning sensor that was 
installed in Narok Town, but got stolen. None of the involved institutions acted on this and therefore Narok 
Town has lost this predictive sensor.  
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APPENDIX A. STUDENT INPUT 
WARNING TIME 
SET CASE 

A question was opposed to a group of students at Maasai Mara University, Narok, Kenya. The question was 
described in a PowerPoint, of which two slides are attached here to show the casus as depicted, see the 
Figures 30 and 31 below.  

Figure 30: Casus slide 1 

Figure 31: Casus slide 2 

  



P a g e  | 43 
 

 
 

STUDENT RESPONSES 

All responses of students, or student groups, are collected in the tables. Due to time restrictions, not all 
boxes are filled out. The students have written down the answers themselves. 

Table 2: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 1 

  Resident Visitor Farmer Shop owner 

5 
minutes 

- 
Difficult to get away due 
to non-familiarity with the 
surrounding 

- - 

30 
minutes 

- 
A bit easier in escaping, 
but at times difficult in a 
larger group 

- - 

60 
minutes 

- 

Easier to evacuate, but 
difficult for one who is not 
conversant with the 
directives i.e. warning 
alarms 

- - 

120 
minutes 

- 
Better timeframe for a not 
so rushed evacuation of 
people’s belongings 

- - 

1 day - Perfect for evacuation - - 

Table 3: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 2 

  Resident Visitor Farmer Shop owner 

5 
minutes 

Pick essential items ie ID, 
wallet, phone, meditation 

- Contact local 
authority 

- Follow instruction 
from hotel 

- Leave for a safe 
location 

Turn off irrigation system Notify customers 

30 
minutes 

Essential documents ie 
cert 

- Check local 
emergency services 
to confirm impact of 
the situation 

- Avoid traveling back 

More livestock to higher 
ground, secure 
machinery 

More things to higher 
shelves 

60 
minutes 

Emergency kit (clothes, 
god, water) - Relocate remaining 

livestock - 

120 
minutes 

Relocate to dedicated 
evacuation centre, inform 
others 

- Plan for post flood 
recovery - 

1 day - -  - 
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Table 4: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 3 

  Resident Visitor Farmer Shop owner 

5 
minutes 

Take items e.g. 
ID/Certificate and run 
away (immediate 
evacuation) 

Run Run Run 

30 
minutes 

Take essential items (ID, 
certificates) 

Contact to inquire safe 
place 

- Evacuate animals to 
higher grounds 

- Take farm inputs 
Basic stock 

60 
minutes 

- Inform immediate 
neighbours 

- Clothes 

Contact to understand 
the impact (how intense) - - 

120 
minutes 

Alert - - - 

1 day - - - - 

Table 5: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 4 

  Resident Visitor Farmer Shop owner 

5 
minutes 

- - - - 

30 
minutes 

- - - - 

60 
minutes 

-  - - - 

120 
minutes 

- - - Only light stocks from the 
shop can be safe 

1 day - - - 

Can be sufficient to 
transport stock to the 
safe place from the 
flooded area 

Table 6: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 5 

  Resident Visitor Farmer Shop owner 

5 
minutes 

- Escape 
- Rescue others if 

possible 

Escape, look for a safe 
place Escape Escape to a safe place to 

safe your life 

30 
minutes 

 - - - 

60 
minutes 

Evacuate temporarily to 
safe places - Carry important things Escape with other things 

120 
minutes 

- - - - 

1 day Build temporary cottages 
in highlands - Evacuate with your 

livestock to safer places 
Evacuate woth your 
property to a safe place 

 

  



P a g e  | 45 
 

 
 

Table 7: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 6 

  Resident Visitor Farmer Shop owner 

5 
minutes 

I leave everything and run 
away escaping to a better 
place 

- - - 

30 
minutes 

I will signal or alert my 
neighbours and we 
escape to where no 
flooding 

- - - 

60 
minutes 

I will be able to save a 
little of my properties - - - 

120 
minutes 

Escaping and sign al to 
everyone - - - 

1 day 
I will plan a better plane 
to go leave with my 
everything and everyone 
near me, we go 

- - - 

Table 8: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 7 

  Resident Visitor Farmer Shop owner 

5 
minutes 

Just run away to a place 
which is a high region Are enough to run away Is not enough to harvest if 

ready One can only run away 

30 
minutes 

- - - - 

60 
minutes 

Call all the people you 
know if they are not aware - - - 

120 
minutes 

- - - 

Is the best, because one 
day is enough but some 
may think it’s a false 
warning 

1 day - Is enough to return home 
Is enough to evacuate 
animals and important 
things 

Can be enough to collect 
things from the shop 

Table 9: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 8 

  Resident Visitor Farmer Shop owner 

5 
minutes 

Run away to safety - - - 

30 
minutes 

Will be more secure 
because they can 
evacuate some of their 
items 

- - - 

60 
minutes 

-  - - - 

120 
minutes 

- - - 
Is the best time because 
it is more reliable as 
compared to 1 day 

1 day 

Will be more reliable 
because the residents 
can evacuate to more 
secure areas and can 
pass the information to as 
many people as possible 

- - 

Can secure their 
resources when given at 
least 1 day alert before 
floods occur 
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Table 10: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 9 

  Resident Visitor Farmer Shop owner 

5 
minutes 

- Know the 
whereabouts of 
nearest family  

- Family: hard to 
assemble the family 
and belongings 

- Individuals: easy to 
escape 

- - - 

30 
minutes 

Evacuate the family - - - 

60 
minutes 

- Identify the safest 
place of assembly 

- Maybe a school, 
hospital, … 

- - - 

120 
minutes 

- - - - 

1 day Acquire more belongiings 
from the house - - - 

Table 11: Actions of different stakeholders in case of a flood warning, for different warning times: respondent 10 

  Resident Visitor Farmer Shop owner 

5 
minutes 

- - Evacuate as an individual 
without farm belongings - 

30 
minutes 

- - Assemble animals in one 
safe place - 

60 
minutes 

-  - - - 

120 
minutes 

- - - - 

1 day - - 
Transport animals to a 
neighbourhood safe 
place 

- 
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APPENDIX B. RESULTS CALCULATIONS 
WITHOUT A HEC-RAS MODEL 
The calculations described above, are applied to the Enkare Narok river, for ten cross-sections in a river 
reach of 16.5 kilometres, going upstream from the bridge in town.  

MANNING’S ROUGHNESS COEFFICIENT 

The roughness coefficient 𝑛𝑛  is determined based on the measured water flow in ten different cross-
sections. The measurement methodology is described in Chapter 3. It should be noted that the water level 
measurements, determining the flow area, did not go as planned and therefore have added to the 
unreliability of the calculations. The calculated Manning coefficients are given in Table 3.  

The values for the cross-sections 1, 3, 6, and 8 are out of the normal range of the Manning’s roughness 
coefficient. This is probably due to measurement errors at those cross-sections. A mean value is 
determined for the other cross-sections, giving a 𝑛𝑛 of 0.0708 [s/m1/3].  

Literature states that for a natural channel like the Enkare Narok river, with a sandy riverbed also including 
rocks, the roughness coefficient should be between 0.03 and 0.05 [s/m1/3]. A higher coefficient indicates a 
rougher riverbed, leading to lower flow velocities.  

BANK FULL STATE DISCHARGES 

The determined Manning’s coefficient is used in the traditional equation, to determine a discharge per 
cross-section, in the case of bank full flow. The corresponding water levels are determined based on 
characteristics visible in the riverbed. These depths have proven to add large inaccuracies to the 

calculations. The discharges are determined based on: 𝑄𝑄 = �1
𝑛𝑛
� ∗ 𝐴𝐴 ∗ 𝑅𝑅

2
3 ∗ √𝑆𝑆 , and noted in the table 

below. For the determination of the discharges, the mean Manning coefficient is used, which is 𝑛𝑛 =
0.0708 [s/m1/3].  

Table 12: Calculated bank full discharges per cross-section, based on Manning's equation 

Cross-section Manning coefficient [s/m1/3] Discharge [m3/s] 

 1 0.292 105.1 

2 0.0380 73.87 

3 0.248 47.83 

4 0.0783 131.3 

5 0.0656 160.6 

6 0.274 109.9 

7 0.0404 36.01 

8 0.519 121.2 

9 0.0996 163.5 

10 0.103 192.6 
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It is noticed that the discharge values vary highly, although it would be expected that they are 
approximately equal, just slightly increasing in downstream direction, from 10 to 1. The average discharge 
is calculated to be 114.2 [m3/s]. 

Note that the discharge could also be determined based on Manning equation for the base flow conditions. 
These results could also be the input for the Leopold & Maddock method below.  

LEOPOLD & MADDOCK METHOD 

The Leopold & Maddock method is applied to the bank full states of the river reach, for the ten cross-
sections. No clear relation, in the form of the Leopold equations, is found. Plots of the three geometry 
characteristics and the corresponding discharges, are given in Figure 32.  

Figure 32: Plots of the Leopold & Maddock relations between discharge and certain geometry characteristics 

The fitted parameters are: 𝑎𝑎 = 17.494, 𝑏𝑏 = 0.081, 𝑐𝑐 = 0.225, 𝑓𝑓 = 0.479, 𝑘𝑘 = 0.745, = −0.173. The set of 
conditions is not met for these parameters, and gives a negative result for a tolerance of 20%. It can be 
seen in the plots, that especially the width and velocity parameters do not result in a good relation with the 
discharge. It can be concluded that these results are not useful.  

With the determined parameters, the discharge per cross-section for the bank full state of the river reach, 
can be determined for all three of the relations, as well as for the average of these three. The results are 
given below, in Table 4, together with the calculated discharges based on Manning’s equation. It is noted 
that the values vary highly and the result is unreliable, which is to be expected with the result of the 
parameters above. It is also noticed that the Leopold relation between velocity and discharge gives the 
best result, and is in the same order of magnitude as the discharges determined based on Manning. 
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Table 13: Calculated discharges per cross-section for the Leopold & Maddock method 

Cross-
section 

Manning 
discharge 
[m3/s] 

Leopold 
discharge, 
based on width 
[m3/s] 

Leopold 
discharge, 
based on 
depth [m3/s] 

Leopold 
discharge, 
based on 
velocity [m3/s] 

Leopold 
discharge, 
average [m3/s] 

1 105.1 260.78 104.87 3764.2 1376.6 

2 73.87 25.419 82.206 0.53426 36.053 

3 47.83 139.83 42.751 67.713 83.431 

4 131.3 3171.1 105.92 10.085 1095.7 

5 160.6 9954.3 93.671 12.777 3353.6 

6 109.9 25.280 138.77 1540.3 568.11 

7 36.01 39.917 34.660 21.159 31.912 

8 121.2 5.1119 152.44 113610 37923 

9 163.5 0.79271 238.88 36.765 92.147 

10 192.6 988.16 184.60 49.495 407.42 

AVERAGE 114.2 1461.1 117.88 11911 4496.8 
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APPENDIX C. STUDENT INPUT 
INSTALLATION AND FUNCTIONING OF 
THE FEWS 
SENSOR INSTALLATION 

RESPONDENT 3 

 Under the bridge, water resistant 
 Electric poles 
 Theft-proof design – tall structures (mounted) 
 Alarm system – integrate sensor alarm 
 Durability – cameras made of corrosion resistant materials 
 Power supply – solar panels 
 Choosing right sensor – ultrasonic (for flood detection) 
 Real time data transmission 

RESPONDENT 4 

In a river to monitor water pressure, in the river, height and velocity 

Theft proof: Build a permanent concrete structure or a station adjacent to the river and equip with security 
sensor 

RESPONDENT 6 

Housing and mounting: 

 Temper proof enclosure – place the sensor inside a reinforced, tamper-resistant enclosure made 
from materials like stainless steel or hardened plastic, prevent easy removal or tampering 

 Power supply: Battery backup in areas where the power supply might be interrupted, install a 
battery backup for main 

RESPONDENT 8 

How to install a sensor or camera 

 Next to residential, near a water body 
 Under a the bridge  
 Cage 
 Concrete pillar 

RESPONDENT 9 

 It should be installed close to a water body for effectiveness and certainty 
 It should also be installed close to a public institution for security purposes 
 Solar panels 
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COMMUNICATION OF THE WARNING 

Mentioned options:  

 Siren 
 Radio 
 Via text on a telecom 
 Whatsapp 
 Local media 
 Television 
 Large fonts on a billboard 
 SMS alert 
 Car with speaker 
 TikTok 

Of which siren was mentioned most, radio second.  
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